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all applications. While every precaution has been taken to ensure the accuracy and completeness of this
document, Vertiv assumes no responsibility and disclaims all liability for damages resulting from use of
this information or for any errors or omissions. Refer to other local practices or building codes as
applicable for the correct methods, tools, and materials to be used in performing procedures not specifically
described in this document.

The products covered by this instruction manual are manufactured and/or sold by Vertiv. This document is
the property of Vertiv and contains confidential and proprietary information owned by Vertiv. Any
copying, use or disclosure of it without the written permission of Vertiv is strictly prohibited.
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4. REGULATORY INFORMATION

Type of Service: The MPM Series and the BDS Series equipment is designed to be used on standard
device telephone lines. It connects to the telephone line by means of a standard jack called the USOC
RJ11C (or USOC FJ45S). Connection to telephone company provided coin service (central office
implemented systems) is prohibited. Connection to party line service is subject to state tariffs.

Telephone Company Procedures: The goal of the telephone company is to provide you with the best
service it can. To do this, it may occasionally be necessary for the company to make changes in its
equipment, operations or procedures. If these changes might affect your service or the operation of your
equipment, the telephone company will give you notice, in writing, to allow you to make any changes
necessary to maintain uninterrupted service.

In certain circumstances, it may be necessary for the telephone company to request information from you
concerning the equipment that you have connected to your telephone line. Upon request of the telephone
company, provide the FCC registration number and the ringer equivalence number (REN); both of these
items are listed on the equipment label. The sum of all the RENs on your telephone line should be less than
five in order to assure proper service from the telephone company. In some cases, a sum of five may not be
useable on a given line.

If Problems Arise: If any of your telephone equipment is not operating properly, you should immediately
remove it from your telephone line, as it may cause harm to the telephone network. If the telephone
company notes a problem, it may temporarily discontinue service. When practical, the company will notify
you in advance of the disconnection. If advance notice is not feasible, you will be notified as soon as
possible. When you are notified, you will be given the opportunity to correct the problem and informed of
your right to file a complaint with the FCC. Contact your telephone company if you have any questions
about your telephone line.
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Safety Information

. Safety Information

You must read and understand these safety precautions and those elsewhere in this manual
before installing, powering up or using the system.

Except as explained in this manual, do not attempt to service Vertiv Corporation equipment
yourself. Opening the equipment may expose you to dangerous voltages. Refer servicing
beyond that described in this manual to authorized personnel.

Do not allow liquids or moisture to get into the equipment. If liquid gets into the equipment,
unplug it immediately and contact an authorized service center or Vertiv Corporation.

The equipment must have adequate ventilation. Do not block equipment ventilation openings.
Do not exceed equipment voltage, power ratings or capabilities.

When grounding is required, make sure the equipment is properly grounded.

Do not let unauthorized persons operate the equipment.

Do not energize the cabinet or any component with 115VAC (or 230VAC if applicable) or
battery voltage until after the installation is complete.

Use of this product in a manner not specified could compromise the designed-in safety of this
product.

High voltage or current may be present inside the equipment and on the equipment terminals.
Only qualified personnel should perform the operations described in this manual. Calibration
must be performed only by technically qualified persons. Observe electrical safety
precautions when removing and installing equipment covers, when connecting leads, and
when making adjustments.

Proper installation and testing are essential to the correct functioning of your system. If you
have any questions, contact Vertiv Corporation.

This manual describes the general installation and use of the system. If your system has
features or accessories not described in this manual, contact Vertiv Corporation.

Drawings in this manual may be for reference only or superseded by later drawings. For the
latest information, refer to the drawings supplied with your system.

1.1.1f You Have Questions

If you have any questions about the installation or testing of your system, contact Vertiv
Corporation at (954) 377-7101 or fax (954) 377-7042. Request BMDM, MPM or BDS
assistance.
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2. System Requirements

These are the minimum requirements for the BMDM (Battery Monitor Data Manager) program.

Microsoft Windows™ XP, 2000, Windows 7, or 8.

Pentium4™ 1GHz or higher microprocessor.

128Mb of memory for Windows 2000. 256Mb for Windows XP.

150Mb of hard disk space for program installation. 1Gb of space for data storage.
CD drive.

A typical MPM system requires these manuals.

Battery Monitor Data Manager User’s Guide, 4200-004 (this book)

MPM-100 Installation Instructions, 4200-034

MPM-100, BDS-256 and BDS-40 Monitors Product Description Guide, 4200-039
MPM-100 Commissioning Procedure with Acceptance Test Report, 4200-036 (optional)
UPS (uninterruptible power supply) manufacturer's instruction manual (if a UPS is used)

A typical BDS system requires these manuals.

Battery Monitor Data Manager User’s Guide, 4200-004 (this book)

BDS-256 Battery Diagnostic System with BDS Controller Installation Instructions, 4200-028
or BDS-40 Battery Diagnostic System Installation Instructions, 4200-045

MPM-100, BDS-256 and BDS-40 Monitors Product Description Guide, 4200-039

BDS-256 Commissioning Procedure with Acceptance Test Report, 4200-009 (optional)
or BDS-40 Commissioning Procedure with Acceptance Test Report, 4200-057 (optional)

UPS (uninterruptible power supply) manufacturer's instruction manual (if a UPS is used with
the system)

BDS Quick Start Cards, 4200-026 (optional)
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String Status Screen Buttons

3. String Status Screen Buttons

This page describes buttons on the String Status screen, which appears when the BMDM (Battery
Monitor Data Manager) program starts. Each button name or function is listed in the index for
ready reference.

Set Up Communication
(Setup|Communication)
Define ports, modems,

Open /Close /
Back Up Database
(File|selection)

Open or close a file network timeout. Force Show All Alarm Events
or back up an Access direct connect.l Disable Display the Report Alarm
database auto polling Event dialog boxes

CelsggatLeoscal S?Lh’epriﬁtém Historical Events Extract All Data
or Service Setup|System) (View|Historical Events) Get data from all
computer List reported events and the strings in the

history of one or all strings system

2 ALEERCORP
3 ALEERCORP

Active

Active

|POI|ing Site |Cust0mer: | |L0cati0n: | |Batter\(: | |String: |

| Cormunicakion Status:/llﬁle | §6rt: |L0cati0n Marne |\f\¢10dem Skatus: |
Connection Summar Call All Modem
Connect to y Summary Report Strings

Displays status

the selected tor all strinas and Create a report for Poll all strings
string ng the entire system attached via modem
monitors
Hang Up
Disconnect This portion of the screen displays communication
the modem information, polling status, connection names, and
error status

String Status screen —String Status appears when the BMDM program starts. It lists the strings
in the database and their last known status.

String View screen —String View shows the cells in a string as a bar graph, table or both. It

appears after a string is selected on the String Status screen and computer to monitor
communication is established. You can view a string off-line by selecting View|Offline.
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Program Installation and Options

4. Program Installation and Options

When installing the BMDM, you will choose Install BMDM Manager. Other screen options
provide you with documentation, connection to the Alber Web site or contact information.

-

< ®install BMDM Manager =

&' View Documentation =

&S View Our Website =

Figure 1. BMDM Opening Screen

4.1.Sample Databases

BMDM sample databases provide strings and data you may use to test button actions, observe
screens, create graphs, and generate reports.

Sample Database for Access - When using Access, at BMDM start-up a message asks, "Do
you want to load a sample database?" Click Yes if you want to explore the BMDM. Clicking
Yes opens the AlberDemo.mdb Access database. If the "load a sample database” message
does not appear, you may enable it on Setup|Preferences. You may also open the sample file
by selecting File|Open|AlberDemo.mdb.

4.2.Installing the BMDM

Before installing the BMDM program, close all other programs. To install the program, insert
the CD into the computer and wait for autorun. If the CD does not run, select Start|Run from
the Windows desktop. At the Run box, type d:\1aunch (or other drive letter) and follow the
instructions.

4.3. Starting the Program

To start the Battery Monitor Data Manager, double-click the BMDM icon on the desktop.
The first time the program runs, "Do you want to load a sample database?" appears. Click No
if you want to use the Configure Station screens. Refer to Sample Databases and Using
Configure Station.
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4.4.Configuring BMDM to Run as a Windows Service

The BMDM can be run as a service so the application will continue to run in the background
even after the user logs off Windows. The following describes how to configure the BMDM
software as a service.

Note: the BMDM uses the "AlwaysUp" third party application to run the BMDM as a service.
It is automatically installed with the BMDM software package starting with versions 5.86
and SQL 6.33 or later.

To Setup the BMDM as a service using the “AlwaysUp” application, do the following:
1. Check if your operating system is 32 or 64 bit.
2. Click on the appropriate shortcut to install the BMDM Service
a. For 32-bit operating system, click on Start, All Programs, Alber, MPM Manager,
then click on the shortcut Install BMDM Service 32-Bit.
b. For 64-bit operating system, click on Start, All Programs, Alber, MPM Manager,
then click on the shortcut Install BMDM Service 64-Bit.
Note: Depending on your operation system, this message may appear. Click on This
program installed correctly to finish the installation.

x

This program might not have installed correctly

If this program didn't inskall correctly, try reinstalling using settings that are
campatible with this version of Windows,

s Program: AbwaysUpService
g '{;, Publisher: Core Technologies Consulking, LLC
Ay Location: C:\Program Files (x@a)\alber\MPM, . \InstalService. exe

| |%) Reinstall using recommended settings

=» This program installed correctly

Cancel |

.jﬁj- What settings are applied?

Figure 2. AlwaysUp Program Compatibility Assistant

3. Type Windows key + R and enter Services.msc and check for the BMDMService
(managed by AlwaysUpService) entry. Right click the entry and click Start to start
the service.
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'Q, Services (Local)

BMDMService (managed by Mame = | Descriptian | Status | Stattup Type | Log On As |
AluaysUpService) C Application Information Facilitates the running of interackive applications with add. ., Manual Local System
Statt the service S Application Layer Gateway Service Provides support For 3rd party protocol plug-ins For Inker, .. Manual Local Service
T Application Management Processes installation, remaval, and enumeration request. .. Manual Local System
Drescription: L Audio Service Manages audio jack configurations. Started Automatic Local System
This application is being managed by AlwaysUp % Backaround Inkeligent Transfer Service Transfers files in the background wsing idle network band. .. Manual Local System

(htep v coretechnalogies,com/productsiiha

ayslpfl, Please make changes with AlwaysUp, Base Filteting Engine The Base Filkering Engine (BFE) is a service that manages,..  Started Aukomatic Local Service
L, BitLocker Drive Encryption Service BDESWC hosts the BitLocker Drive Encryption service, BitL. .. Manual Local System
L. Block Level Backup Engine Service The WEENGIME service is used by Windows Backup to pe... Manual Local System
(:Bluetoath Service Handles installation and remaval of Blustaoth devices., Started Autamatic Lacal System
Bluetooth Support Service The Bluetooth service supports discovery and assodiation. .. Manual Local Service
L. BM Data Manager Service Disabled Local System
M (managed b =) This application is being managed by Al {http: . Automatic =11y
Bonjour Service Enables hardware devices and software services bo auta, ., Disabled Local System
L BranchCache This service caches network content from peers on the lo... Manual Metwork 5. ..
L. B Enterprise Watchdog Ensures the HAL Device drivers for Battery Explorer Ente. .. Automatic Local System
Criwindowssystem32\CBA pds.exe Intel PDS Started Autamatic Lacal System
L Certificate Propagation Copies uset certificates and root certificates from smart c...  Started Aukomatic Local System
L Cisco AnyConnect Secure Mobility Agent Cisco AnyConnect Secure Mobility Agent For Windows Started Automatic Local System
L4 CNG Key Isolation The CMG key isalation service is hosted in the LSA proces...  Starked Manual Local System
P T NI - . Su ke Suekrn Eoerk Bakifis obinm Caicn (EEMEY kis RS- o berntie 1 mnd S i

Figure 3. BMDM and AlwaysUp Running as a Service

4. Type Ctrl+Shift+Esc to open the task manager. Check for the BMDM.exe *32 under
the Processes tab. This confirms that the BMDM is running as a service.

=10l x|

File Cptions Yiew Help

.Applications Processes |Services| Performance I Metworking I Users I

I 5

Image Mame = | User Mame | CPL | ‘Working Set (Memory) | Memory (Pri... | Description :I
amkmon, exe *¥32 SYSTEM oo 10,452 K 3,354 K amkmon servin
ApMsgPwd.exe salokam32115 oo 5,160 K 2,016 K  ApMsgFwd
ApntEx.exe salokam3z2115 an 4,925 K 1,860 K  Alps Pointing-
Apoink,exe salokam32115 aa 3,696 K 2,632 K Alps Pointing-
AppleMobileDeviceService.exe *32 SYSTEM oo 9,536 K 2,648 K MobileDevices
audiodg.exe LOCAL SERYICE an 16,276 K 10,452 K Windows Aud
bhwdins.exe SYSTEM oo 6,120K 2,108 K Bluetooth Sup
coSvcHst.exe *32 SYSTEM ao 2,752 K 1,500k Symantec Ser
collector.exe *32 SYSTEM an 5,100 K 1,312 K collector Appli
conhost, exe SYSTEM aa 2,876 K 952 K Console Wind
conhaost.exe SYSTEM oo 3,160 K 1,004 K Console Wind
conhost,exe SYSTEM an 3,256 K 1,072 K Console Wind
conhost, exe salokam32115 aa 3,3000K 1,043 K  Console Wind
CSFS5, BXe SYSTEM ao 6,312 K 2,332 K Client Server
q | o
IV Show processes from all users End Process |
|Processes: 110 CPU Usage: 0% |Physica| Memaory: 52% | v

Figure 4. BMDM is Running as a Service

5. To launch the BMDM user interface, click Start, All Programs, Alber, MPM
Manager, then click on the shortcut Run BMDM Service in Session.

Note: When using the BMDM as a service, use only Run BMDM Service in Session
to launch BMDM. Attempting to run the BMDM using the regular icon shortcut will
cause issues such as having two instances of BMDM.exe running at the same time
or shared violation errors.
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6. Itis recommended to replace the regular BMDM shortcut on the desktop with the
Run BMDM Service in Session shortcut to prevent the user from launching the
BMDM incorrectly.

4 5. Database Notes

A BMDM database file contains cell and battery readings and setup data. The BMDM
program stores MPM and BDS data in an Access-based .MDB file.

Access initial database file - During installation, the BMDM places the empty Access
database file mpm-db3.mdb under Program Files\Alber\MPM Manager\Database or in
another folder selected at time of installation. This empty default database opens when you
have not previously opened another database.

Creating a new database - You may create a new Access database using File|New.

Deleting a database - You cannot delete an Access MDB database file from within the
BMDM program. To delete a database, use standard Windows procedures to delete the MDB
file from the folder where it is saved. The file is typically located at Program Files/Alber/
MPM Manager/Database.

Because databases may contain unrecoverable battery data, regularly back up MDB files to
another computer to help prevent data loss. Refer to Automatic and Manual Backup.

4 .6.Default Passwords

The BMDM program has one default password, alber, which accesses all areas of the
program and can be changed by the user. It is important to note that different passwords may
be selected for various program areas. New passwords may be alphanumeric and are not case
sensitive.

Additional passwords may be needed when using options. For example, when setting up an
email account for alarm notification, the password is determined externally and is not
changeable using the BMDM. Be certain to record new passwords for reference. If lost, they
cannot be retrieved, and you will have to contact Alber for an unlock code.

System Setup Password - A password for System Setup is stored in the BMDM database
and may be eight characters long. To change it, from the String Status screen, select
Setup|System|Password. Refer to System Setup: Password.

Battery Setup Password - A password for the Battery Setup, Calibration, Diagnostics, and
Check Settings Upload screens is stored in MPM or BDS firmware and must be five
characters. To change it, from String Status, select Setup|Battery|General. Refer to Battery
Setup: General (MPM or BDS).

The Battery Setup password is cleared from the MPM or BDS firmware when the

Alarm Reset switch clears existing names. Refer to the Clear Existing Names (On-site) text in
the Synchronizing Using Check Settings chapter.
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4.7.Computer Types

The first time the program runs, a question about computer type appears.

Select Computer Type

Select Computer Type

{~ Central Computer -
Define only ohe Central Computer for a given system or group of Battery
kanitors. |f more than one Central Computer is configured, maonitor data
will be divided within computers and data trending will not be pozzible.

{~ Local Computer :
Define a local computer when a computer iz connected to a Battery Manitor
at all timez. If no other Central Computer is used in the entire spstem, then
uze a Central Computer configuration.

{+ Service Computer :
Define a computer for gervice uge. Thiz computer iz rezponzible for getting up
new Battery Maonitors as well az servicing existing systems.

Figure 5. Select Computer Type

You select a computer type only once. Refer to Understanding Computer Types before
answering. The following text is on the Select Computer Type box:

Central Computer - Define only one Central computer for a given system or group of
battery monitors. If more than one Central computer is configured to extract data, the monitor
data could become corrupted.

Local Computer - Define a Local computer when a computer is connected to a battery
monitor at all times. If no other Central computer is used in the entire system, then use a
Central computer configuration.

Service Computer - Define a computer for Service use. This computer is responsible for
setting up new battery monitors as well as servicing existing systems.

On install, the database updates to the latest version. After setup, the String Status screen title
bar indicates the computer type: Central, Local or Service. To change the type, refer to
Changing Computer Type.
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4.8.Changing Computer Type

The Select Computer Type box appears only the first time you install the program. You
cannot change the computer type by re-installing; you must edit a text file. Close all
programs, including the BMDM, and open a text editor, such as Microsoft Notepad or
WordPad under Start|Programs|Accessories.

Open the file Config3.MPM under Program Files\Alber\MPM Manager. Using the text
editor, edit the number under the line labeled #2 Computer Type so the digit indicates the
computer type you want. Type 1 for Central, 2 for Local, or 3 for Service. For example, in the
following figure, the 2 under line #2 indicates a Local computer.

4] Config3.MPM - Notepad -0 x|
File Edit Format Help
#1: File Mame of Database Used in Last Time =l

CiProgram Files'AlherMPM Manageridatabaseispace command.mdhb
#2: Computer Type (1 Central, 2 Local, 3: Service)
2

#3: Pollingi&nswer Madem Initialization (0: Default; 1: Custom)
1]

#4: Initialization Command for Pollingé&nswer Madem

ATET QDT 1IN E-K 1AM

#5: Answer Modem Initialization (0: Default; 1: Custom)

1]

#8: Initialization Command for Answer Modem

ATET QDT 1INE-K 1M

#7: File Name of Wawve File

#3: Symbal to Show Sample Database Selection (00 Mot Show; 1 Show)

0

#3: Initialization Command for Alpha Pager Component

ALTO

#10: Options (D10 09, ..., 01. D10 Language; D1=0: LOGTRC disakle, =1: enahle)
nooooaooon

[

Figure 6. Config3.MPM File

Save the text file and close the editor. Run the BMDM program and confirm the title bar
indicates the correct computer type: Central, Local or Service. The Config3.MPM file shown
above is for illustration and not meant to be copied.
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4.9.File Types

The BMDM program uses several file extensions.

MDB.......... An Access™ database file that stores cell and battery readings and setup data. At
installation, the BMDM creates an empty database file. When the BMDM opens
a backup file, it extracts it from ZIP to MDB.

MPM......... The configuration file Config3.MPM under Program Files\Alber\MPM Manager
that you may edit to change computer type (Central, Local or Service).

PDF........... A file format that protects against unintended changes. The Web Report
Generator generates a report as a PDF file every 24 hours.

WAV......... A sound file used for alarm sounds.

ZIP ............ A compressed file for backup of an MDB database file. Saving the working

database as a backup saves the MDB file as a ZIP.

ZRF........... A compressed file for reports. The Report Generator displays and prints text and
graphs and saves customized reports in a ZRF format that protects against
changes. You may also view and print ZRF files using the Archive Reader.

4.10. Help Screens

The BMDM has built-in help, which you may activate three ways. Most screens have a
guestion mark in the upper right corner. Click the question mark, then click the ? cursor over
an item to open a help description. If a screen has no question mark, press the F1 function key
to display help for the entire screen.

Finally, you may click Help on the menu bar to open the text portion of the manual, through
which you may browse using the Table of Contents or Index. The on-screen manual does not
include tables and figures.
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5. Using Configure Station

The Configure Station dialog boxes for a Local, Central or Service computer facilitate setting
up communication and alarm reporting. The first time the BMDM runs, at the "Do you want
to load a sample database?" message, select No to display the boxes. You may later open
these boxes by selecting Setup|Configure Station.

String Status > Setup|Configure Station

To start Configure Station, select Setup|Configure Station. The Monitor Connection Type
dialog box appears. Because subsequent boxes depend on previous selections, each box is

described without reference to others. For more details on dialog box items, refer to the
sections mentioned.

Monitor Connection Type ll

Select Monitor ConnectionT ype

¥ Serial Part

The PC directly connects to the monitor via a zerial port or a USE to serial
port adaptar.

~ Modem

The PC connects to the monitor via a phone line.

™ Metwork

The PC connects to the monitor via local or wide area network [LAM AN,

Figure 7. Configure Station - Monitor Connection Type

Select the method by which the monitor is connected to the computer.

3% Select Serial Port 7l x|

Select Serial Part Mumber ICDM1 vl
W OK I X Cancel |

Figure 8. Configure Station - Select Serial Port
If communicating via serial port, select a COM port.
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= Select Number of Modems x|

Select Mumber of Modems Uzed

' PalingAtnswer Part Only
There iz only one modem and phone line connected to the PC

= PolingAnswer Port and Answer Part
There are twa modems and bwo phone lines connectad ta the PC.

XK Cancel |

Figure 9. Configure Station - Select Number of Modems

If communicating via modem, select the number of modems in use. For details, refer to
Setting Communications.

== Get Modem Port x|

Set Port Mumber of Modem

Polling/tngzwer CO Port Mumber IEDM 2 vl
Angwer COM Port Mumber ICDM 3 vl

/ oK X Cancel |

Figure 10. Configure Station - Set Modem Port

If communicating via modem, select the modem COM ports. For details, refer to Setting
Communications.

¥ Set Dial Prefix x|

Set Dial Prefiv

Palling#tnswer Paort I'I
Apzwer Port I

Enter any dialing prefix(es) required for an outside phone line.
eq. #9. [Commas add delay after the numbers are dialed)

x Cancel |

Figure 11. Configure Station - Set Dial Prefix

If communicating via modem, select the dialing prefix. For more details, refer to Setting
Communications.
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=% set station Phone Number llil

Set Station Phone Number

Statioh Phane Mumber ISSS-SSSS

Enter the phone number the monitor dials to connect to this PC.

W 0K X Cancel |

Figure 12. Configure Station - Set Station Phone Number

If communicating via modem, type the telephone number of the computer the MPM or BDS
monitor calls when a system goes into alarm or discharge.

= Remote Reporting ﬂ

Will thiz PC be uzed for remote reporting
[faxing, paging, printing and emailing) any alarm events?

= No

x Cancel |

Figure 13. Configure Station - Remote Reporting

To set up parameters for automatic alarm notification using fax, page, email or print,
click Yes.

== Remote Reporting 5[

—Select Al Remate Reporting Type

¥ Faxing / Paging

¥ Emailing

o 0K

Figure 14. Configure Station - Remote Reporting Types
Select the methods by which alarms will be reported.



= Email Setup

Enter the email account that this PC will use for remate reporting.

21x

Test |

Outgoing mail server [SMTP] Ismtp mail alber com

From Name IBatlery M anitar

Fram Email Address |name@alber.com

Fram Dromain Ialber.com

Ernail Authenticatiors

¥ My out going server requires authentication

Account Iaccount hame

Passwaord | ********

[~ Dizable Email

s |

x LCancel |

Using Configure Station

Figure 15. Configure Station - Email Setup
If sending alarms via e-mail, complete this dialog box. Refer to Setting Up an Email Account.

Select Printer

P,
Printer

x|

~ Pages I

Enter page numbers and/or page ranges
separated by commas. For example, 1.3.5-12

Hame: I@ HP Color 8550 PCLS: j Properties
Type: HF Color 8550 PCLS:
where:
—Page Rang: LCopi
Al Murnber of copies:
" Curent Page

(I
v Callate

rale

Frint IAII pages in range

Figure 16. Configure Station - Select Printer

If sending alarms to a printer, this dialog box appears, which is also under File|Printer Setup.

The key item to select is the default printer.

et Temperature Format

"T emperature Format

= - Centigrade

./DKl

Select how to display temperature

X Cancel |

Figure 17. Configure Station - Set Temperature

This box always appears. Select how temperatures will be displayed, either in degrees

Fahrenheit or Centigrade.
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‘Wauld vau like ko run the sekup wizard to collect all the infaormation ko start
monitaring wour batteries, IF wou seleck no, wou can reskart this wizard be right
clicking the mouse on the next screen and selecting “Fun Wizard®” from the menu

Figure 18. Configure Station - Information

If running the BMDM for the first time with an Access database, this box opens the hardware
setup wizard. You may start this wizard at any time by selecting Setup|Run Wizard.

5.1.BMDM Configuration Wizard

String Status > Setup|Run Wizard or Right-click mouse|Run Wizard

The BMDM Configuration Wizard sets up monitor hardware and battery strings. Using the
Wizard is the recommended method for setup, as it ensures that basic setup requirements are
completed. If you choose not to use the Wizard, you must use the various BMDM setup
dialog boxes.

To start the Wizard, select Setup|Run Wizard or right click on the String Status screen and
select Run Wizard. The self-guided Wizard dialog boxes are not described in this manual.

7 Battery Monitor Data Manager Configuration Wizard 1.0 Y [ |

Product Selection

Welcome ta the Battery Monitor Data Manager Wizard. This Wizard provides a quick start for
easy BWMDOM setup.

Click a button to selsct the monitor you want to set up now. After completing the Wizard, if you
need to set up additional monitors, start this pragram again by selecting BMOM Wizard under
Alber/Battery Monitor

© BDS-40

© BDS-256

~——
S -

Cancel o

Figure 19. BMDM Configuration Wizard Opening Screen
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6. Understanding Computer Types

When installing the BMDM program, select one of three computer types: Local, Central or
Service. This section explains the types of computers.

6.1.Central Computer

For managing many sites, use a Central computer. This can be a remote computer with one
modem, or two modems for more than 100 monitors. A computer continuously running the
BMDM can automatically poll the monitoring systems, test for normal status, answer calls
from alarming monitors, receive and store data in a central database, report problems to
personnel, and list conditions on the String Status screen.

If using only one site with a Central computer, you may connect the computer to a monitor
RS-232 rear port for continuous viewing of battery and monitor status. In this configuration,
no other Central computers may exist for the same site.

You may temporarily use a portable computer as the Central computer. To manually extract
data, connect the computer via modem or RS-232 Local port. This type of Central computer
is the least desirable because it cannot automatically poll units for status and automatically
extract data or receive calls from alarming monitors.

Only use one Central computer for all monitors. This is important because only a Central
computer removes data permanently from monitor memory.

Select Central Computer when you want to:
Connect a computer to manage one or more monitors and have the computer manage the
database. Only a Central computer updates the time when passing midnight.

A Central computer can do the following:
Set alarm parameters and test intervals.

Collect data manually or automatically, which permanently removes the data from monitor
memory.

Report string and monitor status automatically.

Upon an alarm occurrence, page personnel, fax or email a report, and sound an alarm.
Control more than 1000 monitors from a remote location (not on-site).

Assign location, battery, and string names when setting up a new system.

Calibrate a monitor when the Central computer is on-site.

Note: You may set up an on-site, remote (off-site) or notebook computer as Central, but there
must be only one Central computer polling a monitor. A serial multiplexer is required when
using more than one monitor with an on-site computer.

6-1



Practical Theory: Understanding Computer Types

6.2.Local Computer

For continuous, on-site display of battery information, use a Local computer. You can use a
Local computer with a Central computer. A Local computer performs most Central computer
functions, except that only a Central computer can permanently remove data from monitor
memory.

MPM CAUTION: The MPM front panel Local Port switch enables the front RS-232 port or
optional rear RS-232 port, fiber optic port or LAN port. The front port is for servicing only.
When the switch is lit, the front port is selected. Use the rear port for connecting to a
permanent Local computer, Service computer or on-site Central computer. Use the front port
for using a computer for servicing. For example, if the MPM is not near the Local computer,
you may need an on-site connection for calibration or troubleshooting.

BDS CAUTION: A BDS front panel switch can disable the rear RS-232 Local port or the
fiber optic port. Select the Local position to use the front Local port. When the switch is lit,
the front Local port is selected. Be sure to select the rear Local port after use to re-establish
connection to the Local computer.

The BMDM program on a Local and Central computer is the same, except it is set for Local
rather than Central to implement special data handling when connected to a monitor.

Select Local Computer when you want to:
Connect a computer to a monitor to continuously view monitor and battery status on-site.

A Local computer can do the following:
Set alarm parameters and test intervals.

Calibrate a monitor.

Collect data manually and automatically without permanently removing the data from
monitor memory.

Report string and monitor status automatically.
Upon an alarm occurrence, page personnel, fax or email a report, and sound an alarm.

Note: When no network is available, a serial multiplexer is required when using more than
one monitor.
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6.3.Service Computer

The Service computer can be a desktop or notebook computer temporarily connected to a
monitor on-site to view battery information. The BMDM software on the Service computer is
the same as that on a Central or Local computer, except it is set for Service during setup. A
Service computer lets personnel call a site from a remote location and observe a situation
without removing any data the Central computer might be waiting to extract.

Select Service Computer when you want to:
Connect a computer on-site or from a remote location to view battery data real time or when
you want to set up new monitors.

A Service computer can do the following:

Set up a new monitor, including alarm parameters and test intervals.
Calibrate a monitor.

Collect data manually without permanently removing the data from memory.

6.4.Facility Monitor

You can connect the monitor to a facility monitor or any device that communicates using
MODBUS ASCII protocol. Third-party vendors can view all information available to the
Data Manager. Vertiv Corporation can supply the register map and application notes for this
implementation. A facility monitor can connect to a BDS or MPM system via RS-232 or
network. Dry closure contacts are available for monitoring alarm status. Refer to MPM
MODBUS Application Notes at www.vertivco.com for more details.
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7. Understanding Polling, Extraction and Backup

This chapter explains how polling, extraction, and backup are implemented in Central, Local,
and Service computers running Access. A table summarizes the functions. The terms status
and data are used in this chapter as follows:

Status defined - A report of the normal and error conditions and alarm events for the strings
being monitored.

Data defined - Data (or string data, battery data) are the voltage float values, resistance
values, and discharge values acquired through testing.

The Extract function never deletes status from the monitor. Depending on computer type,
Extract may delete data from the monitor.

7.1.Types of Polling

Polling can be automatic or manual for computers using an Access database.

Polling defined - The process of having the BMDM program connect to the BDS or MPM
monitor and request present battery and monitor status. Polling may be done automatically.

Auto Polling via RS-232 or LAN (Continuous Polling) - The computer automatically
connects to one or more monitors and then continually polls each string in the database
sequentially. This continuous autopolling is done via network or RS-232 direct connection,
not via modem. The polling interval is adjustable.

Auto Polling via Modem - Autopolling via modem occurs one time per day. Each string is
polled, then autopolling ceases until the next day. This prevents having the telephone line
continuously in use.

Disable Auto Polling / Auto Answering - To allow auto polling or auto answering, do not
select this box on Communication Setup.

7.2.Extraction of Data

Extraction can be automatic or manual for computers using an Access database. Status is
never deleted using Extract.

Extraction defined - Extraction is the process of having the BMDM program connect to a
BDS or MPM monitor and transferring float, resistance, discharge, and alarm data from
monitor memory to the BMDM database. Depending on computer type, extraction may copy
or copy then remove the data from the monitor. Refer to the table in this chapter.

Manual Extraction - After BMDM to MPM or BDS connection, you may initiate manual
extraction by clicking of any of these buttons: View Resistance, View Intercell, View Current
Historical Alarms, View Discharge, Extract All, and History. You may also start manual
extraction by clicking the Extract All Data button or the Extract Data pop-up menu item
when enabled.

Auto Extraction - Enabled by checking the Auto Extract Data box on Communication Setup.
With auto extraction, data transfers from the monitor to the BMDM database one time a day,
at 10PM for a Local computer or at 12 midnight for a Central computer.

7-1



Practical Theory: Understanding Polling, Extraction and Backup

7.3.Polling and Extraction Notes

Auto Polling via Modem with a Central Computer - Central computer autopolling via modem
is available once a day at midnight. Select Modem on Setup|System|Link, set Polling to
Enable on Setup|System|Link, and do not check the Disable Auto Polling / Auto Answering
box on Setup|Communication. Modem connection does not permit continuous autopolling.

Continuous Auto Polling - A Central, Local or Service computer connected to the monitor via
RS-232 or network can perform continuous autopolling. Set Polling to Enable on
Setup|System|Link, and do not check the Disable Auto Polling / Auto Answering box on
Setup|Communication. Using a Service computer for continuous polling is not recommended.

Pause Auto Polling - On String Status, you may select Setup|Pause Auto Polling to
temporarily suspend continuous polling. This is convenient if you are selecting other strings
in the list. Selecting Pause Auto Polling does not change settings on the Communication
Setup or Link dialog boxes.

Extracting Data via Modem with a Central Computer - A Central computer connected via
modem can extract data. Select Auto Extract Data on Setup|/Communication. The Central
computer polls monitor status at midnight, copies monitor data to the Central computer
database, and deletes the data from the monitor.

Extracting Data with a Central or Local Computer via RS-232 or Network - A Central or
Local computer connected via RS-232 or network can extract data. A Service computer
cannot extract data. Select Auto Extract Data on Setup|Communication. During autopoll at
10PM, a Local computer copies monitor data to the Local computer database, but does not
delete the data from the monitor. At midnight, the Central computer autopolls monitor status,
copies the monitor data to the Central computer database, and deletes the data from the
monitor.

7.4.Automatic and Manual Backup

Within this section, a backup is defined as a file that is generated by the BMDM program
automatically or upon user request.

The BMDM program stores data from the MPM or BDS in a Microsoft Access compatible
file. As defined in File Types, an MDB file is a database file that stores cell and battery
readings and setup data. A WinZip® ZIP file is a compressed file for backup of an MDB
database file.

The working database is automatically saved as a ZIP file at midnight. The number 1 is
appended to the file name and the extension becomes ZIP. Backups are made for three days,
appended with 1, 2 or 3. On the fourth day, the oldest backup is overwritten. On the first of
the month, another backup is created, with the month and year appended to the file name. On
subsequent first days of each month, another file is created, again with the month and year
appended.

At any time, to save a database as an MDB database file, select File|Save As. To save the
MDB file as a ZIP backup file, select File|Backup Database. To open a backup file, select
File|Open Backup. When the BMDM opens a backup file, it converts it from a ZIP to an
MDB database file.
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The following table summarizes polling, extraction and backup for Central, Local, and
Service computer types.

Computer | Connected Backup Auto Polling Auto Extraction?
Type'! and Via
Database
Central Modem Midnight Midnight Copies the status; copies then deletes data.
Access (12:00AM) (12:00AM) Concurrent with autopoll.
Central RS-232 Midnight Continuous Copies the status; copies then deletes data.
Access (12:00AM) Concurrent with first autopoll after 12AM.
Central LAN Midnight Continuous Copies the status; copies then deletes data.
Access (12:00AM) Concurrent with first autopoll after 12AM.
Local Modem Midnight 10:00PM Copies the status; copies data. Concurrent
Access (12:00AM) with autopoll.
Local RS-232 Midnight Continuous Copies the status; copies data. Concurrent
Access (12:00AM) with first autopoll after 10PM.
Local LAN Midnight Continuous Copies the status; copies data. Concurrent
Access (12:00AM) with first autopoll after 10PM.
Service Modem Midnight Autopolling Auto extraction not available.
Access (12:00AM) not available (Manual only)
(See Note 1) (Manual only)
Service RS-232 Midnight Continuous Auto extraction not available.
Access (12:00AM) (Manual only)
(See Note 1)
Service LAN Midnight Continuous Auto extraction not available.
Access (12:00AM) (Manual only)
(See Note 1)

Note 1: End-user use of a computer set as Service type is not recommended.
Note 2: Status and data copy and delete functions are the same for manual extraction.

Figure 20. Computer Types: Backup, Polling and Extraction Table
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8. Understanding System Installation

This section describes how to set up the BMDM program and put the MPM or BDS monitor into
operation. To install the MPM or BDS, refer to the Installation Instructions manual, then read this
section before placing the system into service.

You should initially configure monitor settings on-site through the front or rear panel RS-232
Local port during installation. You may change programmable settings later.

New monitors have location, battery, and string names blank and auto call-out and alarms
disabled. This prevents nuisance alarms and unintentional communication during setup. The
location, battery, and string names must be unique for each system, known to the user, and
correspond between the monitor and calling computer for a connection to occur.

The MPM monitor loses communication with a locally-connected computer during modem
handshaking when a monitor calls out. After connection, normal operation resumes.

8.1.Connecting Using a Local Computer

The following describes how to set up an MPM or BDS monitor for use with a Local
computer when a Central computer is being used off-site.

To set up the system . .. If you need more help, refer to

1. Install the Data Manager as a Local computer. Installing the Data Manager (BMDM) Software.

2. Set communication parameters for a direct connect. = Communication Port Settings.

3. Set up for a new system. Setting Up a New MPM or BDS System.

4. Direct connect the monitor to the computer. Local Port Connection for MPM or BDS.

5. Establish communication between the monitor and Connecting via the RS-232 Local Port.
the computer.

6. Perform battery setup and set alarm thresholds, test = Programming Battery Setup for the MPM or BDS.
intervals, and options.

7. Synchronize the monitor to the Central computer. Synchronizing Using the Check Settings.

The Local computer and monitor are now ready to operate.
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8.2.Connecting Using a Central Computer

The following describes how to set up an MPM or BDS for use with a Central computer. You
may set up an on-site or notebook computer as a Central computer, but there must be only

one Central computer polling a monitor.

« If the Central computer is an on-site computer:

To set up the system. ..

If you need more help, refer to

1. Install the Data Manager as a Central computer.

Installing the Data Manager (BMDM) Software.

2. Set communication parameters.

Communication Port Settings.

3. Set up for a new system.

Setting Up a New MPM or BDS System.

4. Direct connect the monitor to the computer.

Local Port Connection for MPM or BDS.

5. Establish communication between the monitor and
the computer.

Connecting via the RS-232 Local Port.

6. Synchronize the monitor to the computer. (MPM
only)

Synchronizing Using the Check Settings.

7. Perform battery setup, and set alarm thresholds, test
intervals, and options.

Programming Battery Setup for the MPM or BDS.

8. Synchronize the monitor to the computer. (BDS only)

Synchronizing Using the Check Settings.

The Central computer and monitor are now ready to operate.

« If the Central computer is a remote (off-site) computer:

To set up the system . ..

If you need more help, refer to

1. Set up the monitor.

Service Computer or Local Computer.

2. Install the Data Manager as a Central computer.

Installing the Data Manager (BMDM) Software.

3. Set communication parameters.

Communication Port Settings.

4. Connect the computer modem to the telephone line.

5. Set up for a new system.

Setting Up a New MPM or BDS System.

6. Establish communication between the monitor and
computer.

Connecting via a Modem.

7. Synchronize the monitor to the computer.

Synchronizing Using the Check Settings.

The Central computer and monitor are now ready to operate.
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8.3.Connecting Using a Service Computer

The following describes how to set up a computer as a Service computer.

. If the Service computer is a direct connection (on-site) computer for setting up a new

MPM or BDS monitor:

(Use this option only if a Local computer is not available.)

To set up the system. ..

If you need more help, refer to

1. Install the Data Manager as a Service computer on a
notebook (portable) computer.

Installing the Data Manager (BMDM) Software.

2. Set communication parameters.

Communication Port Settings.

3. Set up for a new system.

Setting Up a New MPM or BDS System.

4. Direct connect the monitor to the computer.

Local Port Connection for MPM or BDS.

5. Establish communication between the monitor and
computer.

Connecting via the RS-232 Local Port.

6. Perform battery setup, and set alarm thresholds, test
intervals, and options.

Programming Battery Setup for the MPM or BDS.

7. Synchronize the monitor to the computer.

Synchronizing Using the Check Settings.

The Service computer and monitor are now ready to operate.

. If the Service computer is a direct connection (on-site) computer for viewing battery data,
and a copy of the Central computer database is available:

To set up the system . ..

If you need more help, refer to

1. Install the Data Manager as a Service computer on a
notebook (portable) computer.

Installing the Data Manager (BMDM) Software.

2. Copy the database from the Central computer to the
Service computer.

Data Manager Database for file names.

3. Set communication parameters.

Communication Port Settings.

4. Direct connect the monitor to the computer.

Local Port Connection for MPM or BDS.

5. Establish communication via the site selected from
the String Status.

Connecting via the RS-232 Local Port.

To view battery data, refer to Viewing Battery and Monitor Status.
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. If the Service computer is a remote connection (off-site) computer for viewing battery
data via telephone line, and a copy of the Central computer database is available:

To set up the system. ..

If you need more help, refer to

1. Install the Data Manager as a Service computer.

Installing the Data Manager (BMDM) Software.

2. Copy the database from the Central computer to the
Service computer.

Data Manager Database for file names.

3. Set communication parameters.

Communication Port Settings.

4. Connect the computer modem to the telephone line.

5. Establish communication via the site selected from
the String Status.

Connecting via a Modem.

To view battery data, refer to Viewing Battery and Monitor Status.

. If the Service computer is a remote connection (off-site) computer for viewing battery
data via telephone line, and a copy of the central database is not available:

To set up the system. ..

If you need more help, refer to

1. Install the Data Manager as a Service computer.

Installing the Data Manager (BMDM) Software.

3. Set communication parameters.

Communication Port Settings.

2. Connect the computer modem to the telephone line.

4. Set the telephone number and the MUX ID number if
required. (MPM only)

Setting Up a New MPM or BDS System.

5. Set the telephone number, the MUX ID number if
required, the string number and the configuration to
the BDS. (BDS only)

Setting Up a New MPM or BDS System.

6. Establish communication via the Service location.

Connecting via a Modem

7. Synchronize the monitor to the computer.

Synchronizing Using the Check Settings

To view battery data, refer to Viewing Battery and Monitor Status.
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9. Understanding How Data is Stored

This section describes how the BMDM processes data and how the MPM or BDS stores the data.
For details about how the BMDM creates and backs up database files, refer to Understanding
Polling, Extraction and Backup.

9.1.Data Storage in the MPM

Data in the MPM is stored in nonvolatile E2 memory, which retains about a year's worth of
typical data. Collected data is stored until transferred to the Central or Local computer. This
same memory stores setup and calibration data, which is backed up to the Central or Local
computer during initial setup; this process is called synchronizing. Flash nonvolatile memory
stores uploads of new MPM firmware. You can upgrade the firmware on-site or remotely.

The MPM stores these kinds of data:

Alarms - 100 records that show when a parameter went into alarm and left alarm, and
maximum alarm level. Older records in memory are overwritten with more recent events.
(Older records uploaded to a computer are not overwritten.)

Discharge - 20.5kb of nonvolatile memory are allocated for discharge data. Memory size and
the number of cells monitored limit the data stored: many short or a few full discharges.

Each data point requires ten bytes of memory. If the discharge storage threshold is 10mv, and
a typical discharge for 24 cells was to discharge 1.875 volts per cell, and the cell voltage was
to drop to 1.96 volts with load applied, you would calculate the memory required as:

20,500 bytes / ( ( ((1.96-1.875) / 0.010 volts) x 10 bytes) x 24 cells) = 10 discharges
This worst case assumes all cells discharge to 1.875 volts. Increasing the discharge storage
threshold can raise the number of discharges the monitor can store. Time stamped data allow
a full analysis of battery performance during the event.

Resistance - 1.6kb of nonvolatile memory are allocated for resistance data. Memory limits
the number of resistance tests stored. To calculate the number of resistance records available,
use the formula:

1600 bytes / ( (Number of cells x 2) + 10)
For a string of 24 cells, there is enough memory for 27 records.
Historical Data - With 1.65kb of nonvolatile memory available, historical readings of cell
voltage, temperature, overall voltage, and current are taken at intervals set under Battery
Setup. To calculate the number of historical records available, use the formula:

1650 bytes / ( (Number of cells x 2) + 18)

For a string of 24 cells, there is enough memory for 25 records.
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9.2.Data Storage in the BDS

Data in the BDS is stored in nonvolatile SRAM memory, which retains about nine month's
worth of typical data. Collected data is stored until transferred to the Central or Local
computer. This same memory stores setup and calibration data, which is backed up to the
Central or Local computer during initial setup; this process is called synchronizing. Flash
nonvolatile memory stores uploads of new BDS firmware. You can upgrade the firmware
on-site or remotely.

The BDS stores these kinds of data:
Alarms - 100 records that show when a parameter went into alarm and left alarm, and
maximum alarm level. Older records in memory are overwritten with more recent events.

(Older records uploaded to a computer are not overwritten.)

Discharge - 160kb of nonvolatile memory are allocated for discharge data. Memory size and
the number of cells monitored limit the data stored: many short or a few full discharges.

Each data point requires ten bytes of memory. The discharge storage threshold is 10mv. If a

typical discharge for 192 cells was to discharge 1.65 volts per cell, and the cell voltage was to

drop to 1.96 volts when load was applied, you would calculate the memory required as:
160,000 bytes / ( (( (1.96-1.65) / 0.010 volts) x 10 bytes) x 192 cells) = 2.7 discharges

This worst case assumes all cells reach end voltage. Time stamped data allow a full analysis
of battery performance during the event.

Resistance - 10.6kb of nonvolatile memory are allocated for resistance data. Memory limits
the number of resistance tests stored. To calculate the number of resistance records available,
use the formula:

10,600 bytes / ( (Number of cells x 4) + 30)
For a string of 192 cells, there is enough memory for 12 records.
Historical Data - With 32kb of nonvolatile memory available, historical readings of cell
voltage, temperature, overall voltage, and current are taken at intervals set under Battery
Setup. To calculate the number of historical records available, use the formula:

32,000 bytes / ( (Number of cells x 2) + 38)

For a string of 192 cells, there is enough memory for 75 records.
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Practical Theory

10. Understanding the Time to Go Algorithm

The battery Amp-hour (Ah) rating indicates the current (Amps) the battery can deliver over time
(hours). For example, if a battery can deliver 5 Amps for 20 hours, it has a 100Ah rating.
However, because discharge rate, temperature, and age affect battery capacity, Amp-hour rating
can vary. A 100Ah battery that discharges over two hours might deliver only 56Ah. To
compensate for this nonlinearity, you can use Peukert's Equation to estimate the Amp-hours
remaining (or time to go) in a lead-acid battery based on discharge rate. If capacity testing is not
an option, you can get the numbers for the equation from the discharge curves on manufacturers'
data sheets, but the result will be less accurate than that obtained by using values gotten from
actual capacity testing.

Peukert's Equation demonstrates how the Amp-hour capacity of a lead-acid battery varies
according to rate of discharge. Rather than Ah =1 x T, the Peukert Equation reads:

C=1"

where constant C = the theoretical capacity of the battery, | = the discharge current in Amps,

t = the time of discharge, and the exponent n = the Peukert number, a constant for the given
battery. The exponent value can vary from greater than 1 to about 2. Values closer to 1 indicate a
well performing battery; higher numbers indicate more capacity diminishes when the battery is
discharged at higher rates.

Calculate the Peukert number by determining the capacity obtained at any two discharge rates:

_ (log t2—log t1)
" (log 11 — logly)

where t; is the hours of discharge at current Iy and t2 is the hours of discharge at current I2.

To determine the Peukert number, discharge the same, fully charged battery twice at convenient
discharge rates.

First, discharge the battery below the normal discharge rate. When the battery reaches discharge
level, as determined from manufacturers' spec sheets, note the Ah consumed and the time the
discharge took. Calculate the average Amps by dividing the Ah consumed by the length of time.
For example, if the Ah consumed was 300 and the discharge took 50 hours, the average Amps
equals 6. Use this value for |1 in the above formula and use the time the discharge took for T.

Charge the battery and repeat the process for a discharge rate higher than normal. Use the
resulting values for I, and T in the formula. Calculate the value for n to obtain an exponent
accurate for your normal rate. Use this exponent n in the Peukert Equation to estimate time
remaining during a normal discharge.

Performing two capacity tests to obtain the variables for Peukert's Formula can yield accuracy as
good as 0.5% to 1%.
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Although the Time to Go calculation may offer a close estimate, many other battery parameters
affect run time as a battery ages. These aging phenomena show up as different failure modes and
influence the accuracy of the Time to Go calculation. Vertiv Corporation recommends that you
not rely solely on the Time to Go data for battery run time and that you only consider the

Time to Go as an estimate.

To activate the Peukert's Equation algorithm in the BMDM program, open the
Setup|Battery|Discharge dialog box and assign values in the Time to Go area.
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11. Selecting Preferences

String Status > Setup|Preferences
At any time, you may open the Preferences dialog box to change program appearance or activate

options.

Preferences 7l x|

v Dizplay request for zample database at programm start

Temperature Farmat
’75' F - Fahrenheit {~ C-Centigrade
r Sting Statuz Display ——— [~ String Yiew Metwork Grouping—
[+ Display String 1D & IP Address
) £ Customer
[W Dizplay Custorner i
] ] = Location
v Dizplay Location Mame  Battery
[# Display Battery Name ™ Maodem telephone number
rDefault Statuz View
{* Sting " Battery " Laocation i Customer

[v Dizable Alarm Reporting [ Faxing,Paging, Printing,Email)
W Hide &larm Reporting Window

[~ Detail Executive Report Enable

[~ Show Status Screen On Waiting Login

W Show String Status Color Alarm threshold count I_E
Status Color Mormal e [ -
Status Color Alarm IHed _j

I Disable Sound Select Sound | Apply |

Status Flush Buffer Interval |15:00 [Mk:55]

Alternate Field Title IEustomer
o 0K I X Cancel |

Figure 21. Preferences

Selecting Preferences

Display Sample Database - To display the message, "Do you want to load a sample database?"
at BMDM program start, select this box.

Temperature Format - Select a temperature format. Do not change format after setting up the
system. Stored temperatures will not convert between F (Fahrenheit) and C (Centigrade or

Celsius).

String Status Display area - Selecting Display String ID, Display Customer, Display Location
Name or Display Battery Name displays these columns on the String Status screen.
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String View Network Grouping area - When connected to a string, a drop-down list at the top of
the screen shows the name of the string being displayed. On Preferences, clicking IP Address,
Customer, Location, Battery or Modem telephone number filters the list by these parameters.
The default filter is IP Address. These filters are active for network connection only.

Default Status View area - Select an option button to have the default String Status screen
display Battery Status, Location Status or Customer Status at program start.

Disable Alarm Reporting - Select to globally disable all alarm report functions. This selection
overrides alarm settings on Setup|System|Reporting, which apply to specific strings.

Hide Alarm Reporting Window - Select to stop the report alarm box from popping up.

Detail Executive Report Enable - Only appears on a Central computer. Select to automatically
generate daily executive reports, which are saved in PDF format at Program Files\Alber\

MPM Manager\Web \String Summary or System Summary. These reports are viewed when
connecting via the Web interface.

Show Status Screen on Waiting Login - Check to keep the String Status screen displaying when
no user is logged in.

Show String Status Color - To have color indicate status on the String Status screen, select this
box, an alarm threshold count, and a color.

Alarm Threshold Count - This is the number of alarms required on a string to make the Normal
color change to the Alarm color.

Status Color Normal - A good status, with no alarms, displays in the color selected from
this Status Color Normal drop-down box.

Status Color Alarm - A string in alarm with the number of alarms selected in the Alarm
Threshold Count box displays in the color selected in this Status Color Alarm drop-down box.

Disable Sound - Select to globally disable alarm sounds. Not selecting enables a sound upon an
alarm. You must also check Sound Alarm on Setup|System|Reporting, which applies to specific
strings. Refer to Setting Up a New MPM or BDS System. To select an alarm sound,

click Select Sound on Preferences and choose a sound. Click Open then Apply to hear the sound.
Note: When in Battery setup and remote reporting is disabled, the alarm threshold must be set to
one. The string status is set to have an alarm and the string status color is automatically applied.

Status Flush Buffer Interval - Select an interval in minutes and seconds to have the polling
status saved to the database. The default interval is 15 minutes.

Alternate Field Title - Type a name in this field to assign the Customer field title another name,

such as Region or Subdivision. The new name will appear in various program areas where the
word Customer appeared.
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12. Setting Communications

String Status > Setup communication gl or Setup|Communication
Select this dialog box to define communication settings.

Communication Setup @
Modem Connection
Polling/funswer Fort Amnzwer Port
[COM 2] - MatSelected
Dial Prefix Dial Prefix

Direct Connection
ComPart |COM 1 v

MNetwork Connection
Time-out [zec.] ’—2 [Mote: minimum time-out iz 2 seconds)
Other Options
[v Dizable AutoPolling / Auto Answering Continuous Palling Interval [sec.] 0
I~ Auto Extract Data
[™ Estract Latest Resistance Readings
-

[~ Force All Strings to Direct Connection

Timeout/Bad Data Retry Count ’_3 [minirum 2 tries)

W« OK | X Cancel |

Figure 22. Communication Setup

Polling/Answer Port and Answer Port - Using the drop-down lists, define one or two modem
COM ports for monitor communication. If you define two COM ports, one port calls and polls the
monitors, and the other answers calls from the monitors. If you define only one port, it both polls
and answers. Define one port from the Polling/Answer Port list and choose Not Selected under
Answer Port. For larger systems, use two modems to allow simultaneous polling and remote
reporting.

Dial Prefix - This is the number, usually a 9, that accesses an outside phone line. Type at least
two commas after the number for a time delay. Leave this box blank if the computer directly
connects to an outside line.

Direct Connection - Com Port - If you selected the Direct button on System Setup|Link, select a
COM port. If any strings are configured as Direct Connect, then select the Com Port number.

Network Connection - Time Out - This sets the time allowed for connecting to the network,
typically 2 seconds.
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Disable Auto Polling / Auto Answering - For computer—monitor connection via RS-232 or
network, not selecting this box enables continuous polling. With continuous polling, the BMDM
polls monitor string status at the time interval set in the Continuous Polling Interval box. Refer to
Understanding Polling, Extraction and Backup for definitions of status and data.

Extract Latest Resistance Readings — enabling this option, allows you to view the latest
resistance readings when resistance history has previously been extracted by a central computer.
This allows you to view the latest resistance readings without the central computer database.

Continuous Polling Interval (seconds) - If Disable Auto Polling / Auto Answering is not
selected, set the time interval that polling occurs. The BMDM continually polls monitor string
status at this interval, typically 15 seconds.

Auto Extract Data - Automatic data extraction removes (Central computer) or copies (Local
computer) data from monitor memory when polling each monitor. Normally, select Auto Extract
Data for a Central computer; otherwise, you will have to manually call each site and extract data.
Refer to Understanding Polling, Extraction and Backup for polling details.

Extract Data by Set Time - To extract data at a time other than midnight, select Auto Extract
Data, then select this box and type a time in the Extract Time field on System Setup Link for each
string.

Force All Strings to Direct Connection - Use with a Local or Service computer using a database
that has modem or network connections. Select this box to connect to an MPM or BDS using the
USB or RS-232 port. This feature saves having to modify the database Link connections and is
useful when temporarily using a Local or Service computer.

Timeout / Bad Data Retry Count - This is the number of times the program attempts to poll
data from a monitor if previously unsuccessful.

12.1. Determining the USB COM Port

If your MPM or BDS system has USB capability, you must determine which COM port the
computer selects for the USB driver and then set the COM port in the BMDM program.

Note: Items on your version of Microsoft Windows may have different names from those
described in the following text.

First, connect the MPM or BDS system to the USB port on the computer and power up the
computer and the system.

From the Windows desktop, click Start|Settings|Control Panel|System. On the System dialog
box, click the Hardware tab, then click the Device Manager button.

Expand the Ports folder, then find the listing for the USB. A typical listing might read: USB
Serial Port (COM 4). Write down the COM port number for later use, then close the Device
Manager dialog box and exit back to the Windows desktop.

On the Communication Setup dialog box in the BMDM program, select the previously noted
COM port on the Direct Connection drop-down list. Click OK.
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13. Setting Up an Email Account

String Status > Setup|Email Setup

Use Email Setup to set up the account under which the BMDM sends emails. This dialog box
contains the global Email Disable selection.

= Email Setup x|

Cutgoing mail server (SMTPY Ismtp.mail.alber.com

From MName |E|anery Monitar

From Email Address Iname@amer_cum

Fram Darmain Ialber_com

Ernail Authentication

¥ My out going server requires authentication

Accaount |acc0un1 name

Password Im

[~ Disable Email

« 0K | x Cancel |

Figure 23. Email Setup

Outgoing Mail Server (SMTP) - Specify the mail server for outgoing messages. Obtain this
from your Internet service provider or network administrator.

From Name - Type the name that will appear in the recipient's email From field.
From Email Address - Type the email address the BMDM will use as a sender.
From Domain - Type the mail server domain name of the outgoing mail server.

My outgoing server requires authentication - Select this box if your email requires ESMTP.
This specifies that you must log on to your outgoing mail server.

Account - Type the mail server account user name or number.
Password - Type the password for the account.

Disable Email - This selection globally disables all BMDM email settings. To not send any alarm
or other BMDM emails, check this box.

Test - To send an email to test the setup, click the Test button. The Test Email dialog box
appears.
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13.1. Testing Email

String Status > Setup|Email Setup|Test
The Test Email box tests the settings on the Email Setup dialog box.

= Test Email _ Ol x|

To Name Iiack

To Email Address Iname@name.com

/ 0K | x Cancel |

Figure 24. Test Email

At To Name and To Email Address, type the recipient's name and email address. Click OK
to send the email and close the box. Confirm the email is received at the location to which it
was sent.
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14. Setting Up a New MPM or BDS System

String Status > Setup system or Setup|System

BMDM setup involves defining what systems exist. Each system setup must identify customer,
location, contacts, battery and string information, and other data. All System Setup dialog boxes
except String are identical for both the MPM and BDS.

14.1. System Setup: General Notes

System Setup is password protected. After selecting Setup|System, type the password and
click OK. The password times out after five minutes or you may click the top left Password
Active to disable it. If the password is incorrect, the System Setup boxes appear, but New,
Save and Delete are inactive. You can have different Battery Setup and System Setup
passwords. Refer to Default Passwords.

The first time the String Status screen appears, no status information exists. As you add new
systems, they are listed with Unknown status. To set up a new system, select Setup|System,
click New on the Customer dialog box, and complete the System Setup boxes. Systems
previously set up are listed on String Status. When you click Setup|System, the name
highlighted in the list appears in the Customer dialog box. Click New to add a new system
(new customer).

CAUTION: If you fail to click the New button, you will overwrite the previously saved
customer information.

The New button on the Location, Battery, and String boxes adds a new location under an
existing customer, a new battery under an existing location, or a new string under an existing
battery.

To change names or information for an existing system, use the Setup|System dialog boxes. If
BMDM and monitor location, battery or string names do not match, connection fails and an
error message appears. Blank spaces or hyphens can affect a name.

During system setup, if you close before completing and saving the Customer, Location,
Battery and String details, the names will not appear on String Status. To resume editing,
click Setup|System, select the Customer, Location, Battery or String box, and choose the
name from the Name drop-down list.

To display the String 1D, Customer Name, Location Name and Battery Name columns on the
String Status screen, select the boxes on Setup|Preferences.

Depending on which System Setup box is displayed, clicking Delete removes all information

for the displayed customer, location, battery or string. All associated set up data will be
permanently lost.
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14.2. System Setup: Customer
String Status > Setup|System|Customer
Use the Customer dialog box to add new customer details.

The Customer tab and Customer field names may be changed to another name, such as
Region, by selecting Setup|Preferences, then typing a new name at Alternate Field Title.

2l
Customner |I:0c:ati0n| Eattewl Sting I Link I Beportingl Contact Listl Easswordl
Customer IAlber j [ New |
Customer Address 5 Delets |

Street Address |31 03 North Andreves Ave. Ext

B
3, Save |

City IF‘ompano Beach

State  [FL ZIP [33084

Customer Contact

Mame I

Department I

Phone Number  |954-523-6650 Est.

Féix Number |354-623-6671

Email &ddress Ialber@alber.com

Figure 25. System Setup - Customer
CAUTION: Clicking the Delete button deletes all information for the displayed customer. All
locations, batteries, and strings set up for the customer will be lost.

Customer Name (required) - To add new customer details, click New and type the customer
name. If monitoring only one customer, you may identify a region, division, etc. Complete
the Customer Address details.

Note: You cannot have two identical customer names. Selecting different customers changes
the available locations on the Location dialog box.

Customer Contact - Type the name and contact information of the person at the customer
location responsible for the battery system. This hame may be used for reports faxed using
Setup|System|Reporting.

When finished, click Save to save to the database or click the Location tab to continue setup.
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14.3. System Setup: Location

String Status > Setup|System|Location

Before completing the Location dialog box, confirm the correct customer is selected on the
Customer box.

System Setup 3 2] x|
Customer  Location |Eattew| String I Link I Beportingl Contact Listl Easswordl

Location Mame IPDmpano Beach, FL j [ Mew |
Location Address 5 Delete |
Street Address |31 03 Morth Andrewves Ave. Ext.
Eé Save |
City IPompano Beach
State  [FL 2P |33064
Location Contact
Mame I
Department I
Phone Number  |954-523-6660 Ext.

Féix Number  |954-623-6671

Email Address Ialber@alber.com
Custorner IAIber j

Figure 26. System Setup - Location

CAUTION: Clicking the Delete button deletes all information for the displayed location. All
batteries and strings set up for the location will be lost.

Location Name (required) - Type the name and address where the monitor is installed.
Location, battery, and string names are used with each other to identify the strings and
hardware to which the monitor is connected.

Note: To change the location name after monitor setup, use these Setup|System dialog boxes.
If database names do not match names in the monitor, connection fails. Blank spaces or
hyphens can affect a name.

Note: You cannot have two identical location names under the same customer name.
Selecting different locations changes the available batteries on the Battery dialog box. This
location name must match the location name in the database of the connecting computer.

Location Contact - Type the name and contact information of the person at the monitor
location responsible for the battery system. This name may be used for reports faxed using
Setup|System|Reporting.

Customer (or alternate field name) - Normally, this field is not changed. To move the
location name and related battery and string setup data to a different customer, select a name
from the drop-down list. This is useful where many locations are under a few customers. By
adding customer names (or regions, etc.), the data becomes more manageable.

When finished, click Save or click the next (Battery) tab.

14-3



Setting Up a New MPM or BDS System

14.4. System Setup: Battery

String Status > Setup|System|Battery

The Battery dialog box assigns a battery name, cell and string parameters, and cell numbering
on the String View screen. Before completing this dialog box, confirm the correct customer
and location are selected on the Customer and Location boxes.

System Setup 2=
Wwork station Eustomerl Location  Battery |§tring I Link, I Eeportingl Contact ListI Easswordl

Battery Name  |30KVA LIPS =] [y Mew |
Battery Capacity  |100 Ah 5 Delete |
Installation Diate ~ [2/1/2008 < Mol M save |

Mumber OF Strings

—
 —

Meazure points £ string 0

Cell # Label Start Fram | & Most Positive Cell " Most Negative Cell

Figure 27. System Setup - Battery

CAUTION: Clicking the Delete button deletes all information for the displayed battery name.
All strings set up for the battery will be lost.

Battery Name (required) - Assign a unique name to the battery. Location, battery, and string
names identify the strings and hardware to which the monitor is connected.

Note: To change the battery name after monitor setup, use these Setup|System dialog boxes.
If database names do not match names in the monitor, an error message appears.

Note: You cannot have two identical battery names under the same location name. Selecting
different batteries changes the available strings on the String dialog box. This battery name
must match the battery name in the database of the connecting computer.

Battery Capacity - Type the combined capacity of all parallel strings in the battery (in
amp-hours). This is the Amp-hour rating of the battery at the eight hour rate.

Installation Date - Type the battery installation date or select from the drop-down calendar.
If desired, change the computer date format under Windows as follows.

1. Click Start|Settings|Control Panel, then click Regional Settings.

2. Click the Date tab, then select the date format from the Short Date Style drop-down menu.
3. Click OK and exit the Regional Settings dialog box.

Number of Strings (required) - Type the number of parallel strings within the battery.

Measure points / String (required) - Type the number of cells or modules per string.
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Cell # Label Start From - This allows the reverse numbering of cells. Select Most Negative
Cell when the cells are numbered such that Cell 1 is the most negative.

When finished, click Save or click the next (String) tab.
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14.5. System Setup: String

String Status > Setup|System|String

The String dialog box assigns a string name, configuration, model and manufacturer names,
capacity, and MPM string names. Before completing this dialog box, confirm the correct
customer, location, and battery are selected on the Customer, Location, and Battery boxes.
The Start Cell # box for MPM changes to string # when BDS is selected. See below.

System Setup ﬂll
Qustomerl I:oc:ationl Battery  String | Link I Beportingl Contact ListI Easswordl

String Mame IString1 j [ Mew |

Manitor Configuration IMPM Tu2duy 'I 1': Delete |
I B |
Start Cell # 1 2, Save

CellModel  [DD-85-23

Cell Manufacturer IAT SF

String Capacity 935 Ak

Skring Mama OF MPR
Sking 1 IString 1

Shing 2 IString 2

Sting 3 IString 3

Sting 4 IString 4

Figure 28. System Setup - String (MPM shown)

CAUTION: Clicking the Delete button deletes all information for the displayed string name.
The string name and string data will be lost.

String Name (required) - Type a name for each MPM or names for each string for a BDS.
Location, battery, and string names identify the strings and hardware to which the monitor is
connected.

Note: To change the string name after monitor setup, use these Setup|System dialog boxes. If
database names do not match names in the monitor, an error message appears.

Note: You cannot have two identical string names under the same battery name. Selecting
different strings changes selections on the Link and Reporting dialog boxes. This string name
must match the string name in the database of the connecting computer.

Monitor Configuration (required) - Select a configuration from the drop-down list. To

determine MPM hardware configuration, refer to the model number in the chart in MPM
Configuration Options.
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Start Cell # (MPM) (required) - Type the first cell number for the first string in the battery
being monitored by the MPM.

String # (BDS) (required) - Up to 16 DCM units can be assigned the same string number,
and the BDS can control up to eight strings. Type the string number of the DCM units to
which the information being entered applies.

Cell Model and Cell Manufacturer - Type the cell model number and manufacturer.
String Capacity - Type the capacity of the individual string (in amp-hours).

String Name of MPM (MPM only) - Assign individual string names within the MPM. The
fields available depend upon the monitor configuration selected. If the MPM has two or more
strings, such as a 2 x 24, you may type names for each string. These names appear in reports
where string names are used. The default names are String 1, 2, 3 and 4. Disabled for BDS.

When finished, click Save or click the next (Link) tab.

14.6. System Setup: Link

String Status > Setup|System|Link

The Link dialog box enables polling and sets computer to monitor connection. Before
completing this dialog box, confirm the correct customer, location, battery and string are
selected on the Customer, Location, Battery, and String boxes.

System Setup 21x]
workstationl Customner I:oc:ationl ﬁattewl String  Link |ﬂep0rting Contact ListI Easswordl

 Direct

" Modem
Phane Murber |1-954-s23-ssso B3, Save |

& MNetwark

IF Address |1 22.00.000.00

Metwork Part 502

Metmask |255.255.255.D
Gateway |1 265511

Polliry
& Enable " Disable

Extract Time:  |12:00 Ak [hhcrm arndpri)

ML 1D ID

Figure 29. System Setup - Link
You must select either Direct or Modem or Network.

Direct - Select if the monitor directly connects to a computer serial port. On the
Setup|Communication box, define the COM Port at Direct Connection.

Modem - Select if the monitor connects to the computer via modem. In Phone Number, type
the phone number of the monitor that the Central computer calls (the number to which the
monitor is connected). On Setup|Communication, define the COM Port at Modem
Connection.
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Network - Select if the monitor connects to the computer via network. Complete IP Address,
Network Port, Netmask and Gateway (below).

IP Address - Type the IP address of the monitor. The IP Address is specific to the
monitor (MPM or BDS Controller); it is not the IP address of the computer running the
BMDM program.

Network Port - In this box, type 502. The TCP/IP address is used when you click Send
Network Configuration on the Setup|Battery|General dialog box.

Netmask and Gateway - Type the monitor subnetmask number. Type the default
gateway number used by the monitor. If using a local LAN, the gateway number can be
left blank.

To transfer the IP, netmask, and gateway addresses to the MPM or BDS, click
Send Network Configuration on Setup|Battery|General. This button is active and
addresses can only be transferred when connected via RS-232 or modem, not network.

Polling Enable or Disable - These buttons allow polling on a per string basis, to avoid
receiving error messages when a system is off-line. Select Enable to request monitor and
battery status every 24 hours. During polling, if Auto Extract Data is selected on
Communication Setup, data is copied to the Central computer database and deleted from
monitor memory. Refer to Understanding Polling, Extraction and Backup.

Extract Time: If Extract Data by Set Time is selected on Communication Setup, type the
data extraction start time in this field.

MUX ID (required) - Possible entries are 0 to 16. A zero indicates the MPM or BDS is not
connected to a multiplexer. Device 1 to 16 corresponds to the multiplexer rear panel
connection ports. Refer to the Serial Port Multiplexer User’s Guide.

When finished, click Save or click the next (Reporting) tab.
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14.7. System Setup: Reporting

String Status > Setup|System|Reporting

The Reporting dialog box selects the devices the Central or Local computer contacts when
the monitor reports during continuous polling or calls in an event. Before completing this
dialog box, confirm the correct customer, location, battery, and string are selected on the
Customer, Location, Battery, and String boxes. A Service computer cannot open the
Reporting box.

2]

Qustomerl I__ocationl ﬁatteryl Shing | Link  Beporting |l:gntac:t List Easswordl

¥ Page On Alam: Accesz Telephone Number |'| -BE1-997-2293

¢ Numeric Pager PIN Number I

Delay [Seconds) ID il B
R, Save |

[V FaX AlamEvent:  Send FA¥to [ Customer Contact
I~ Location Contact

i Alpha

[~ Email Alarm Event: Send Emailta [~ Customer Contact
¥ Location Contact

[ Frint &larmn Event ¥ Sound Alarm

[~ Contact | j

[V Contact List | j
Contact List Mode
Al i+ Sequential /Ack  Include: [ WwWamings
™ First Available wiait Time: IDD:15 ¥ Memory Full
Al Available [HH:MM ) [~ Inactive

Figure 30. System Setup - Reporting

Page On Alarm - Select to display the Page Report Alarm Event box on error and send alarm
notification to a pager. Click a button for the kind of pager being used: numeric or
alphanumeric.

With a numeric pager, a six digit code is sent:
Digit 1: Report Type
1 = Discharge
2 = Alarm
3 = Warning
Digits 2 to 6: String ID
For example, to report an alarm in String ID 1, the pager would display 200001.

An alphanumeric pager displays the location, battery, and string names and alarm detail.

Access Telephone Number - Type the pager phone number if numeric or the modem ID
number if alphanumeric. If using an alphanumeric pager, use an access number that has a
TAPI interface that communicates using a modem instead of voice. For example, SkyPage's
access number is (800) 759-6366. This can also be the TAPI phone number for cellular
phones if the cell phone supports text messaging.

Pager PIN Number - Type the pager private ID (PIN) number if needed or the cell phone
number if using text messaging.
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Delay (Seconds) - If using a numeric pager, type the delay in seconds before the numeric
message is sent.

Fax Alarm Event - Select to display the Fax Report Alarm Event box on error and send
alarm notification to a fax machine. Check a box to direct the report to the Customer
Contact or Location Contact. The system dials the fax telephone number on the Customer
or Location dialog box.

Email Alarm Event - Select to display the Email Alarm Event box on error and send alarm
notification via email. Check a box to direct the report to the Customer Contact

or Location Contact. The system sends to the email address on the Customer or Location
dialog box. Confirm global Disable Email is not checked on the Email Setup dialog box.

Print Alarm Event - Select to display the Print Report Alarm Event box on error and send
alarm notification to a printer. To select a default printer, at the String Status screen, click
File|Printer Setup. If alarms do not print when received, change the Spool Data Format
setting. On Windows, click Start|Settings|Printers. Right click the icon for your printer, then
click Properties|Details|Spool Settings. At Spool Data Format, select EMF or RAW.

Sound Alarm - Select to enable an audible alarm for this string when an alarm event occurs.
Select the alarm sound by clicking Select Sound under Setup|Preferences. To enable alarm
reporting and alarm sounds, confirm global Disable Alarm Reporting and Disable Sound are
not selected on the Preferences dialog box.

Contact - To contact a person from any contact list, select the check box and choose a name
from the drop-down list. This name is in addition to names in a group contact list.

Contact List - To contact a group of people from a contact list, select the check box and
choose a group contact name from the drop-down list. Members of the group will be
contacted based on the Contact List Mode.

The Contact List Mode area has the following selections.
All - Upon an alarm event, contact all names in the contact list, whether on-duty or off.

First Available - Upon an event, contact the first name on-duty in the contact list. No further
action is taken.

All Available - Upon an event, contact all names on-duty in the contact list. No further action
is taken.

Sequential / Ack - Upon an event, contact the first name on-duty in the contact list and wait a
preset time for acknowledgement. If none is received, contact the next available person in the
list and wait for acknowledge. Continue and repeat the sequence until acknowledgement is
received or until the list is gone through one time.

Note: You must select Acknowledge in the Alarm Button area on Setup|Battery|General.

Wait Time - Click the box and type a time (in hours and minutes) that the program waits
before calling the next person when Sequential/Ack is selected.
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Include Warnings, Memory Full and Inactive - Select these check boxes to contact and
require acknowledgement when these events occur and Sequential/Ack is selected. If not
selected, event notice is sent only once and no acknowledgement is required.

When finished, click Save or click the next (Contact List) tab.

14.7.1. Using a Cell Phone for Text Messaging

You may use a cell phone to receive text messages. Type your provider's TAP telephone
number in the Access Telephone Number field and type your cell phone number in the Pager
PIN Number field. You can find cell phone provider TAP telephone numbers at
www.notepager.com/tap-phone-numbers.htm. Not all cell phone providers offer this text
messaging service. The Email or Pager fields can also send text messages to a cell phone.

14.8. System Setup: Contact List

String Status > Setup|System|Contact List

The Contact List dialog box selects persons to be contacted during an alarm reporting event,
in addition to those listed on the Customer and Location dialog boxes.

System Setup llﬁl
Eustomarl I__ocatlonl Ealtaryl Shring | Link I Heporting  Centact List IEasswordl

—Contact List rContact

|F|rstChD|ce 'I Newl Dielete

3 |Raphael

Femove Enntacll Hew Delete

Figure 31. System Setup - Contact List

Contact List - Each Contact List (group) name contains a group of persons to contact. To
create a new Contact List name, click New in the left Contact List panel. The Contact List
Name dialog box appears. At List Name, type a name, then click OK.

Delete (left panel) - To remove a contact list (group) name from the list, click a name from
the drop-down Contact List and click Delete. This permanently deletes the contact list.

Delete (right panel) - To remove a person's name from the list of potential contacts, click a
name on the right Contacts list and click Delete. This permanently deletes the contact.

Remove Contact - To remove a person's name from the group Contact List, click the
person's name to highlight it, then click Remove Contact.

Sort Names - To move a person's name up or down the list to change call priority, click and
drag the number before the name up or down the list onto another number.
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Contacts - To type persons' names to add to a list of potential contacts, click New on the
right panel on the Contact List dialog box to open the Contact Information box.

= Contact Information x|
Marne | W Active [~ Ahways Contact

¥ PageOndlam ¢ Numeric & Apha &l

Access Telephone Mumber I

Pager PIN Munber I

Delay [Seconds] Iﬂ_ﬂ

¥ Fai Alammn Event : Fax Mumber I

I~ Email &larmn Evert:  Email Address I

Schedule
[~ 247
Doay On24H0urs|Day0ﬁ |StartTime Time On
Sun = i 112:00 &M 100:00 :
------------ e e e Rk
Mon | [ il 1200 &M 100:00 :
------------ | e e Rk |
Tue (Il | 112:00 &M 10000 :
------------ | e e Rk |
wed [0 | 12:00 AM 100:00 :
------------ [ e e R R R |
Thr (Il = 112:00 &M 100:00 ;
------------ bl stk b SRR bbbt
Fri (Il = 12:00 &M 100:00 :
------------ | R LR R R ]
cat (] A 112:00 AM 0000

Figure 32. System Setup - Contact Information

String Status > Setup|System|Contact List|New (on right panel)
Use the Contact Information dialog box to add names to the list of potential contacts.

Name - Type the contact person's name.
Active - Do not select if the person is unavailable. For example, the person is on vacation.

Always Contact - Select to always contact the person, regardless of settings elsewhere. The
Active check box must be selected.
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Page On Alarm - Select to display the Page Report Alarm Event box on error and send alarm
notification to a pager. Click a button for the kind of pager being used: numeric or
alphanumeric.

With a numeric pager, a six digit code is sent:
Digit 1: Report Type
1 = Discharge
2 = Alarm
3 = Warning
Digits 2 to 6: String ID
For example, to report an alarm in String ID 1, the pager would display 200001.

An alphanumeric pager displays the location, battery, and string names and alarm detail.

Access Telephone Number - Type the pager phone number if numeric or the modem 1D
number if alphanumeric. If using an alphanumeric pager, use an access number that has a
TAPI interface that communicates using a modem instead of voice. For example, SkyPage's
access number is (800) 759-6366.

Pager PIN Number - Type the pager private ID (PIN) number if needed.

Delay (Seconds) - If using a numeric pager, type the delay in seconds before the numeric
message is sent.

Fax Alarm Event - Select to send alarm notification to a fax machine. At Fax Number, type
the fax machine phone number the system will dial.

Email Alarm Event - Select to send alarm notification to the person via email. Type an
address in the Email Address box. Confirm Disable Email is not checked on the Email Setup
dialog box.

Use the Schedule area to build the time on / off for the person.

24/7 - Select if the person is on call 24 hours a day, 7 days a week or, in the Sunday through
Saturday grid, you may select the following:

On 24 Hours - Select if the person is on call the entire day.
Day Off - Select if the person is not available that day.

Start Time - If the person is available part of the day, click the Start Time field and type
the time availability starts. You may press Enter to step to the Time On field.

Time On - Click this field and type the number of hours the person is available. You may
press Enter to step to the next Start Time field.

When finished, click Save to return to the Contact Lists dialog box. To edit information after
saving, double-click the name in the right side Contacts list.
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Add Names to Contact List - To add people to a Contact List, first select a group name from

the drop-down Contact List. Next, click a person's name in the Contacts list on the right, then
either click the red arrow or right click the name and select Add to List. The name appears in
the list on the left.

If you want to add new names to the Contact or Contact List boxes on the Reporting dialog
box, click the Reporting tab. If not and you are finished, click Save and close the dialog box.
If you want to change the password, click the Password tab.

14.9. System Setup: Password

String Status > Setup|System|Password
Use the Password dialog box to change the System Setup password. If the password is

incorrect, you can view protected screens but cannot change parameters. The Password tab
appears only if the correct password is entered when Setup|System is selected.

System Setup ﬂll
Qustomerl Locationl ﬁatteryl String | Link. | Eeportingl Cortact List  Password I

MNew Password I [ Change |
Fe-type Paszword I"’“‘"

Figure 33. System Setup - Password

New Password - To change the System Setup password, type the new password in
the New Password and Re-type Password boxes. The password may be up to eight
alphanumeric characters long. Click Change. The new password is now in effect.

Record the new password for reference. If the password is lost, you must contact Vertiv
Corporation.

14-14



Synchronizing Using Check Settings

15. Synchronizing Using Check Settings

The location, battery, and string names are key for letting a computer connect to a monitor; all
names must match or connection fails. Typically, a Central computer assigns names into the
monitor, and Check Settings uploads to the computer any test times, alarm thresholds, and data
settings put into the monitor during commissioning. Synchronizing is the process of uploading
using Check Settings and must be done using a Central computer connected to the monitor via
RS-232, modem or network. An upload for a BDS must be done twice. After a system is
synchronized, it can be placed into service. Refer to Check Settings Screens for screen shots.

Note: If a system fails to synchronize, complete the Battery Setup dialog boxes.

Before synchronizing, you should understand the Upload, Close, Recheck, and Send Time
buttons on the Check Settings dialog boxes. The Battery Setup password enables Send Time and
Upload.

Upload Button - To transfer settings between the computer and monitor, click Upload. The
data transferred depends on computer type. A Central computer sends the location, battery,
and string names, string 1D, current date and time to the monitor, and the monitor sends all
other settings to the computer database. Using a Local or Service computer, the monitor
transfers setup to the computer, but names, date and time are not sent to the monitor. You
need to click Upload on only one Check Settings box, usually Check Settings|General. If you
are uploading a BDS, repeat the Upload a second time.

Close Button - After transferring settings using Upload, to close Check Settings, click Close.

Recheck - Clicking Recheck is the same as clicking Setup|Check Settings. Recheck reloads
settings from the database and monitor into the Check Settings boxes.

Send Time - This button sends the date and time from the computer to the monitor without
affecting other settings.

=l
String Status > Connection

Complete the Preferences, Communication Setup, and System Setup dialog boxes then, on the
String Status screen, highlight the location name you want to synchronize and click Connection.

System Connects Normally - If connection is established, the names match, and no error
messages appear, click Setup|Check Settings|General. After setup data appears in the In Database
and In Monitor columns, click Upload to transfer from monitor to computer database. After
upload, click Close. All data is transferred, and the site is ready to go into service.

""String needs to be set up' Message - If the system connects, but "This string needs to be set
up" appears, the location, battery or string names do not match. You must upload the monitor
settings. Click OK at the message, select Setup|Check Settings|General, then click Upload as
described in the preceding System Connects Normally paragraph.
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Note on Network Settings - Network parameters do not upload using Check Settings|General.
To change the IP Address, Netmask or Gateway, use Setup|System|Link. To send the existing or
changed IP, Netmask or Gateway address to the MPM or BDS, click Send Network
Configuration on Setup|Battery|General. This button is active and the addresses can be sent only
when the computer is connected to the BDS or MPM via RS-232 or modem, not via network.

Note on using a Local or Service computer - With a Local or Service computer, the monitor
transfers setup to the computer, but names, date and time are not sent to the monitor. "This string
needs to be set up" will continue to appear until you synchronize with a Central computer.

System Does Not Connect (Error 102) - When connecting, the "Location hame, battery name
and string name do not match™ message may appear.

Errar 102

Location name, battery name and string name do not match,
actual location name is Boca Raton Lab,

actual battery name is Enersys,

actual skring name is Skring 1.

Ignore |

Figure 34. Connection Error Message

Extra or missing spaces and hyphens affect names. Click OK to return to String Status or click
Ignore to display Check Settings. If names have been assigned in the monitor, either:

1. Use Setup|System to change the names in the computer database to match the names in
the error message box, or

2. If on-site with the equipment, clear the existing names in the monitor and enter new
names as described below.

3. After correcting the problem, attempt to connect, then upload using Check Settings.

Clear Existing Names (On-site)

MPM - To clear names in an MPM, press the MPM Alarm Reset switch while cycling power
off then on. Release the switch after the MPM front panel LEDs sequence from left to right.
This reset also disables the alarms and auto call-out function, resets the MPM hardware
password to the default, and clears all data in the monitor, including active alarms.

BDS - To clear names in a BDS, press the BDS Controller Alarm Reset switch while cycling
power off then on. Release the switch after the BDS front panel Status LED flashes rapidly.
This reset also disables the alarms and auto call-out function and resets the BDS hardware
password to the default. Optionally, instead of pressing the reset switch, you can clear the
names on the Diagnostics|Memory screen.
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15.1. Connecting With a Service Computer

This section describes how to connect to a monitor when site details are not known.

Connecting a Service Computer via Modem - Using a Service computer, type the site
telephone number and MUX ID (if a multiplexer is used) under Setup|System|Link. If using a
BDS, also type the String ID number and the BDS monitor configuration under
Setup|System|String. Click Connection. Check Settings|General appears. Click Upload to
synchronize settings between the monitor and Service computer database, then click Close.
String View displays all real time data.

Connecting a Service Computer via Network - Using a Service computer, type an IP
address under Setup|System|Link. If using a BDS, also type the String ID number and the
BDS monitor configuration under Setup|System|String. Click Connection.

Check Settings|General appears. Click Upload to synchronize settings between the monitor
and Service computer database, then click Close. String View displays all real time data.

Connecting a Service Computer via RS-232 - Using a Service computer, click Connection.

Check Settings|General appears. Click Upload to synchronize settings between the monitor
and Service computer database, then click Close. String View displays all real time data.
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16. Check Settings Screens

=]
Active check: String Status > Connection then Setup|Check Settings|dialog box
Offline: String Status > View|Offline|Setup|Check Settings|dialog box

The Check Settings dialog boxes display settings in the BMDM database and MPM or BDS
nonvolatile memory. Use Check Settings to synchronize a battery location. On a Local, Central or
Service computer, when String View displays an active connection, you may click

Setup|Check Settings to view Check Settings setup, send the time and date, and upload settings.
You cannot change settings using these boxes. Offline you can view the settings, but the Send
Time, Recheck and Upload buttons are not active.

Open the Check Settings dialog boxes. When MPM and BDS boxes are similar, only one figure is
shown below. For item definitions, refer to Synchronizing Using Check Settings and
Programming Battery Setup for the BDS or MPM.

The Check Settings|General dialog box for MPM and BDS is shown below. Network parameters
do not transfer from Check Settings. To change the IP Address, Netmask or Gateway, refer to
Synchronizing Using Check Settings.

 Check Settings 21xl
ﬁEﬂEfa‘lEarameters Test Parameters | Float Alarms | Discharge | Digital Input | Digital Qutput | Calbration | LGS Setup

ITEMS

Location Mame

Batten Mame

String Mame

Current Date

Current Time

Station Phone Mumber

Total Cell Number

Shunt Yalue

Femate Reporting

Configuration #

Telco MU

IN DATABASE

30KNA UPS
BDS-256 x40 2
E/4/2008

12:68:26

40
1
Enable
166

Dizable

IM MOMITOR

Lacation 1
Battery 1
String 1
12/30/18939
00:00:00

40

1
Disable
160
Dizable

IP Address 126.55.1.46 126.55.1.46
Metmask 255.255.255.0 255.255.255.0
Gateway 1265511
Float Current Multiplier 1 1
Alarm Acknowledge Reset Reset
Charger Ripple Freq B0 hz B0 hz

Send Time | + Recheck | Upload |

Shring Status: |F\Iarm

Communication Status: [Poling System Status

Passward: \Unchecked

Figure 35. Check Settings - General (MPM / BDS)

Note: When you click Upload on Check Settings, the Location Name, Battery Name, and

String Name in the monitor do not overwrite the names in the computer database. However, when
a Central computer is used to download to the monitor, these three names are overwritten in the
monitor when Send is clicked on Battery Setup.
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The Check Settings|Parameters dialog boxes for the MPM and BDS are shown below.

== Check Settings

21x

General Parameters |Iest Parameters EIoatAIarmsI Q\schargel DCrigital lnputl Ca\iprationl

ITEMS

IN DATABASE

Digcharge Current 1 Option

Discharge Current 2 Dption

Mot Selected

Digcharge Current 3 Option

Mot Selected

Discharge Current 4 Dption

Mot Selected

Float Current 1 Option

Selected

Float Current 2 Option

Mot Selected

Float Current 3 Option

Mot Selected

Float Current 4 Option

Mot Selected

# of Temperature

1

Intertier B 1 Option

String 1, Cell 12

Intertier B 2 Option

Mot Selected

Intertier B 3 Option

Mot Selected

Intertier B 4 Option

Hot Selected

Intertier B & Option

Mot Selected

Intertier B B Option

Mot Selected

Intertier B 7 Option

Mot Selected

Intertier B 8 Option

Mot Selected

IN MOMITOR
Selected
Mot Selected
Mot Selected
Mot Selected
Selected
Mot Selected
Mot Selected
Mot Selected
1
Sting 1, Cell 12
Mot Selected
Mot Selected
Nat Selected
Mot Selected
Mot Selected
Mot Selected
Mot Selected

Send Time |

" Recheck |

% Upload |

String Status: [alarm

Communication Status: |Pn||ing OY Load & Temps

Password: [Unchecked

Figure 36. Check Settings - Parameters (MPM)

Geraes Eaomelors | Test Paameters | Float Al | Dicchargs | Digital frpit | Digial Qutput | Cawation | LGS Setup |
IN DATABASE 1N MDNITOR "";Tv"" [ 1““""
DM |Cels [Ls/mfRAs|RLLS|sS #] 11 12 |[cets [LsmfRas|rus]ss & T1] 12| oc 1
1 5 6 B 1 ¥ % [m s & B 1 ® | X 3 |] 1
2 | s & B & % W5 & B B X I:"""‘*‘ :::; :::;
: ] —
] Intertier 8 | Database | Mot [~
5 1 i
— 2
&
- 3
17| i
8 5
q 6
IFac=t T
10
— 8
n 5
12 10
12 11
— 4 o
14
? Prassnabes D stabeate Mordor
— Enusble Erable
16 MIT.I 1 1
Charge T +2 |2 2
ChagelT1__ |1 1
ChargeIT -2 |2 2
B SendTime | o Rcheck | uooed | i Cose |
Shring Status: Good Communication Status: Poling O Load & Temps Password: Unchecked

Figure 37. Check Settings - Parameters (BDS)
For BDS setup, the system shows information based on string one only.
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The Check Settings|Test Parameters dialog box for the MPM and BDS is shown below.

el

ﬁenerall Parameters  Iest Parameters IEIoat Alarmsl Dischargel Digital Input Ealilgrationl LGS Setupl

ITEMS IN DATABASE IN MONITOR
Historical Log Ability Enable
Historical Log Period [day] 15 158
Fiesistance Test Ability Enable Enable
Resistance Test Period [day] 1 1
Load Test Ability Dizable Digable
Load Test Period [days) 1] 1]
Load Test Length [minutes) 1] 1]
Historical Log Period [time] M M
Resistance Test Period [time] Mia Mia,
Resistance Test Mode Standard Standard
Estended Intertier Avg Test Mih Mid,

Send Time | « Fecheck | 92 Upload

String Status: [Alarm Communication Status: [Response OK Password: [Unchecked

Figure 38. Check Settings - Test Parameters (MPM / BDS)
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The Check Settings|Float Alarms dialog boxes for the MPM and BDS are shown below.

7 Check Settings ] 21x|
General Earamatersl Test Parameters  Eloat Alarms |Qischarge Digital Input | Digital Qutputl Calbration | LGS Setup
IN DATABASE IN MONITOR
ITEMS IN DATABASE [IN MONITOR Remote Remcte
Float Alarms Enable Latch Repaort Latch  Repart
High Cell Voltage 2,400 2.400 ~ F F F
Low Cell Yoltage 2.000 2.000 Ird Ird Ird I3
High Overal Voltage 55.0 5RO Ird Ird Ird 2
Low Overall Voltage 51.0 5.0 2 I3 I3 I3
High Temperature a0 a0 I Ird I3 2
Low Temperature 5] [=52] Ird Ird Ird I3
Cell Resistance 22000 22000 Ird Ird I F
Intertier Resistance 500 500 =3 F Ird F
Float Current 1000 1000 Ird Ird Ird I3
Intercell Resistance N M4 - r r r
High Dizcharge Current 783 783 ~ r r r
High Cell Volkage \Warning | 2.310 2310
Percentage for'waming 39 9
Send Time | " Recheck | up\oad | l-'LEIose |
String Stakus: |Alarm Communication Stakus: |Request DM Settings Password: |Unchecked

Figure 39. Check Settings - Float Alarms (MPM)

Check Settings i 17 x|
General Earametersl Test Parameters  Eloat Alamns IQ\schargeI Digital Input | Digital Dutput | Calibration | LGS Setupl
oM #: 4 1' LI IN DATABASE IN MONITOR
ITEMS IN DATABASE [IN MONITOR: Fiemale Femate
Flaat Alarms Enahble Latch Feport Critical  kaint Latch Report Critical — Maint
High CellVohage 14,500 2.300 F F I F F I r F
Law Cell Valtage 13,200 2.000 ~ I r Ird ~ r I Ird
High Owerall Voltage B53.0 150.0 ~ I I I 2 r I I
Law Overall Valtage B3E.E 1200 ~ I I I 2 r I I
High Temperature az 621 ~ W = I I I | N
Low Temperature 70 621 ~ W = rd I I | N
Cell Resistance 3001 See below I F r rd I r I Ird
Intertier Resistance See below See below I F r rd r r I I
Flaat Current 500 1] I F r rd r r 0 0
Intercell Resistance 400 1] I r r rd r r 0 0
High Discharge Current |0 7 r r r 0 r r 0 0
High Cell Valtage ' arning | 14.400 3.000 Cell Resistance Alarm Levels
Percentage for Warning |99 99 ITEMS IM DATABASE | IN MOMITOR ﬂ
Intertier Resistance Alarm Level of BDS E:::; 0 ::::
ITEMS M DATABASE | IN MOMNITOR o
Intertier 1 a :I el o 5
Intettier 2 450 Lelld o 409
W 200 Cell5 1} 403
Intertier 4 460 ;I Lol 0 0 ;I
Send Time | " Recheck | ﬁupload | i-'| Cloge
String Status: [Alarm Commurication Status: [Response OK Password: [Unchecked

Figure 40. Check Settings - Float Alarms (BDS)
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Check Settings x|
ﬁenelall Parameters | Test Parameters  Eloat Alarms |Qischarge| Digital [nput Digilalgulpull Calibration | LGS Setup
oowe: 1 4| IN DATARASE 1N MONITOR
ITEMS IN DATABASE (IM MOMITOR Bemate Bl

Float &larms Enable Latch Report Ciitical  Maint. Latch Feport Critical  Maint.
High Cell Valiage 14500 2300 F F I F F r r F
Low Cell Voltage 13.200 2.000 Ird 2 r I3 I3 r r I
High Overal Yoltage BE3.0 160.0 e F I r I r r I
Low Overall Voltage B3EE 1200 e F I r I r r I
High Temperature g2 E21 I3 2 r 2 r r r —
Loww Temnperature 70 B2 I3 2 r I r r r ~
Cell Resistance 3001 See below Ird Ird r 2 2 r r I
Intertier Resistance See below See below Ird Ird r 2 r r r =
Float Current 500 1] Ird 2 r I3 r r r =
Intercell Resistance 400 1] e r r I r r r I
High Discharge Current |0 27 I r r r r r r -
High Cell Voltage “Warning | 14.400 3.000 Cell Resistance Alarm Levels
Percentage for warning |99 99 ITEMS IN DATABASE | INMONITOR ﬂ

Intertier Resistance Alarm Level of BDS Ez::; 0 :12

ITEMS IM DATABASE | IN MOMITOR - P E—

Inketier 2 450 L4 I 40

W =m0 Cell& 0 403

Intertier 4 450 ﬂ Lol 0 0 ;I
Send Time | " Recheck | %upload | : i'| Cloze I

String Status: |Alarm Communication Status: |Rasponsa 0K Password: |Unchecked

Figure 41. Check Settings - Float Alarms (BDS)
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The Check Settings|Discharge dialog box for the MPM and BDS is shown below.

= Check Settings

General | Parameters | Test ParamelalsIEluatA\arms QiSChafgalD\QilaljnDul Calibraliunl

21X

ITEMS IN DATABASE INMONITOR ITEMS IN DATABASE |IN MOMITOR

Discharge Latch Selected AP Hours 1
Femote Reporting Enable Enable Peukert Mumber 1 0.000 0.000
Critic:al Alarmn MNAA MNAA
Maintenance Alam MNAA MNAA
Prirt M M
Dizcharge Mode Current Mode Current Mode
Discharge Level E0 E0
Fieport Option Report Problem Only | Report Al
Log Cell Yoltage 10 10
Log Overall Vaoltage 1 1
Log Current 1 1
Laow Cel Voltage 1.750 1.750
Laow Overall Voltage 420 420
Mazimum Dizcharge Time 1) 1)

Send Time | " Recheck | Upload | ! Cloze I

Skring Status: [Alarm

Communication Skatus: |Rasponse OK

Password: [Unchecked

Figure 42. Check Settings - Discharge (MPM / BDS)
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The Check Settings|Digital Input dialog boxes for the MPM and BDS-256 are shown below. The
BDS Digital Input tab and dialog box are available only for String 1 on a BDS. The tab
disappears if a string other than 1 is selected. Not available for the BDS-40.

= Check Settings 2 x|
Qenelall Earametersl Test F‘alametarsl Eloat Alarmsl Discharge  Digital Input I Calibration
IN DATABASE IN MONITOR
Input Mame M/C M/D0  Repart Defined N/C N/D  Report
Input 1 [ F [ | (T F (T
Input 2 O = O | I 7 I
Input 3 I F I (O] I ~ I
Input 4. [ F [ | (T F (T
Input & O = O | I 7 I
Iriput & | F | r r ~ r
Irput 7 O V¥ O O O ¥ O
Iriput & | ~ | r r ¥ r
Iriput 3 | F | r r ~ r
Irput 10 O V¥ O O O ¥ O
Input 11: | = | r r ¥ r
Input 12: [ F [ r r ¥ r
Irput 13 O V¥ O O O ¥ O
Irput 14: | = | r r ¥ r
Irput 15 [ F [ r r ¥ r
Input 16; I 17 I I I 7 (0
Send Time | +f Recheck | %upload | i-'l Cloze
String Status: |A\arm Communication Skatus: |Po\||ng System Status Password: |Unchecked

Figure 43. Check Settings - Digital Input (MPM)

== Check Settings 2x
General Earametersl Test Parametersl Float Alarmsl Discharge  Digital Input Dig\talgutputl Callbration
IN DATABASE IN MONITOR
Input Mame M/C N/O  Report Critical  Maint, Defined M/C M/O  Report Critical  Maint.
Input 1 ;F 0O =@ O ©E & &
Input 2 F r r O @ O & @»© &
Input 3 Vo O & O O [@©b @&
Input 4 F 0O = O ©E @& &
Input 5 ;F 0O =@ O © @©& &
Input 6 o 0o = Hd © @©b &
Input 7 Vo O = O O [@©b @&
Input & F 0O =& O ©E @& &
Input 3 F r r O @ O & @»© &
Input 10: ~ I O 0 I r I r r r r
Irput 11: ~ I [ 0 I r I r r r r
Input 12: ;F 0O =@ O © @©& &
Input 13: ~ I O I I r I r r r r
Input 14: I I O 0 I r I r r r r
Irput 15: ~ I [ 0 I r I r r r r
Input 16: F r r r r 0O =@ O & » @&
Send Time | " Recheck | QD\Uad |
String Status: [Alarm Communication Status: [Response OK Password: [Unchecked

Figure 44. Check Settings - Digital Input (BDS)
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Check Settings Screens

The Check Settings|Digital Output dialog boxes for the MPM and BDS-256 are shown below.
The Digital Output tab and dialog box disappear if a BDS-40 is selected.

= Check Settings 1 2 x|
ﬁenelall Parameters | Test Parameters | Float A\armsl Qischargel Digital [nput  Diigital Dutput I Calibration | LGS Setup
IN DATABASE IN MONITOR

Trigger Mame Enable Latch Trigger Mame Enable Latch

Output 1: (o (o I (o (o
Output 2: (= (= I (= (=
Output 3: (= (= I (= (=

Send Time | « Recheck | %upload |

String Skatus: \Discharging Communication Status: |Po|ling Skabus Password: |Unchecked

Figure 45. Check Settings - Digital Output (MPM)

T Check Settings ed 1)

General Ealamatersl Test F‘arametarsl Float &larms | Discharge | Digital lnput - Digital Qutput |Cah|_:ratinn

IN DATABASE IN HONITOR

Trigger Mame

Qutput 1: I—
Output 2: I—
Qutput 3: I—
Output 4: I—
Output 5: I—
Output B: I—
Output 7: I—
Output 8: I—

w
E3

[}
E=

Enable Latch Trigger Mame Sting#f  Enable Latch

T I |— = O

O & o o @ & &l
0 & o o & o &l

1111111

1T 11111

Send Time | + Recheck | Qpload | l-'LQIose |

String Status: |F\Iarm Communication Status: ‘Responsa Ok Passwaord: |Unchecked

Figure 46. Check Settings - Digital Output (BDS/256)

For BDS setup, the system shows information based on string one only.

16-8



Check Settings Screens

The Check Settings|Calibration dialog boxes for the MPM and BDS are shown below. The BDS
Calibration dialog box reports the Intercell Calibration Factor in addition to the other factors. The
arrow buttons let you upload other DCM's.

= Check Settings B
General I Parameters | Test Parameters | Float Alarms I Discharge | Digital [nput  Callbration
ITEMS IN DATABASE IM MONITOR
Cell Woltage Calibration Factar 0.00113922
Overall%oltage Calibration Factor 002111816 002111816
Test Current Calibration Factor 001436963 (0.01486369
Dizcharge Current Calibration Factor {0.11434064 0.11434064
Intertier Calibration Factor 0.14084625 014084625
Temperature 1 Calibration Factar 0.22435760 0.22435760
Temperature 2 Calibration Factor 0.00095367 0.00095367
Temperature 3 Calibration Factor 0.00000000 0.00000000
Temperature 4 Calibration Factar 0.00000000 0.00000000
Temperature 5 Calibration Factor 0.00000000 0.00000000
Temperature B Calibration Factor 0.00000000 0.00000000
Temperature 7 Calibration Factar 0.00000000 0.00000000
Temperature 8 Calibration Factor 0.00000000 0.00000000
Float Current Calibration Factor 0.10203934 010203334
Send Time | " Recheck | Upload | ﬂ“‘;lnsé. )
String Status: [Alarm Communication Status: [Response 0K Password: [Unchecked

Figure 47. Check Settings - Calibration (MPM)

Check Settings 2x|
General | Parameters I Test Parameters I Float Alarmz | Discharge I Diigital Input | Digital Qutput ~ Calibration
DOME: 1 - | Fl
ITEMS IN DATABASE IN MONITOR
Cellaltage Calibration Factar 0.00383275 0.00383276
Overal Yoltage Calibration Factor 0.204531355 0.20451355
Test Curent Calibration Factor 0.01016235 0.01016235
Dizcharge Current Calibration Factor |0.11325073 0.11325073
Intertier Calibration Factor 010416734 010416734
Temperature 1 Calibration Factor 0.09575705 0.095748705
Temperature 2 Calibration Factor 0.00059509 0.00059509
Float Current Calibration Factor 0.00000000 0.00000000
Intercell Calibration Factor 0.00000000 0.00000000
Send Time | " Recheck | ﬁ Upload | l-'l_ Cloze |
String Status: [Alarm Commurication Status: [Folling Cell Volkages 1 Password: [Unchecked

Figure 48. Check Settings - Calibration (BDS)
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Check Settings Screens

The Check Settings|LGS dialog box for the MPM and BDS is shown below.

= Check Settings 2lx|

ﬁenarall Earametersl Test Paramatarsl Float Alarmsl Qischargel Digital lnpull Calibration LGS Setup I

ITEMS IN DATABASE IN MOMITOR

Syatem Type
Site 1D

Manitar D evice Humber

Phone Number
Call Time 00:00:00 00:00:00

Send Time | ~ Hecheckl Qpload | |-'| Cloze

String Status: [Alarm Communication Status: [Response OK Password: [Unchecked

Figure 49. Check Settings - LGS (MPM / BDS)
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16.1. Check Settings Screens in Controller

Check Settings Screens

=]
BDS Only: String Status > Connection then <CTRL>Setup|Check Settings|dialog box

A second series of Check Settings boxes for diagnostics is available for the BDS. These
Check Settings in Controller boxes retrieve data from the BDS Controller instead of the
DCM. To open Check Settings in Controller, at String View, hold down the CTRL key while

selecting Setup|Check Settings.

A typical dialog box, Check Settings in Controller|Calibration for the BDS, is shown below.

= cCheck Settings in Controller

General | Parameters | Test Parameters | Eloat Alams Qischargel Digitallnpull Digital Dutput Ealilgratinnl

A »

x|

DCM #: 1
ITEMS IN DATABASE IN MOMITOR
CellYaltage Calibration Factor 0.00383276
OverallValtage Calibration Factar 0.20451355 0.20451355
Test Current Calibration Factor 001016235 0.01016235
Digcharge Current Calibration Factor |0.11325073 011328073
Intertier Calibration Factor 010416734 010416734
Temperature 1 Calibration Factor 0.09578705 0.09578705
Temperature 2 Calibration Factor 0.00059509 0.000559509
Float Current Calibration Factor 0.00000000 0.00000000
Intercell Calibration Factor 0.00000000 0.00000000
Send Time | « Recheck | Upload | ﬂ Elosa
String Status: [alarm Cammunication Status: [Palling OV Load & Temps Passward: [Unchecked

Figure 50. Check Settings in Controller - Typical Screen (BDS)
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Programming Battery Setup for the MPM

17. Programming Battery Setup for the MPM

=]
From String Status, click Connection to display the String View screen.

String View > Setup|Battery|dialog box

After completing Preferences, Communication Setup, and System Setup, complete the Battery
Setup dialog boxes. To open Battery Setup, on the String Status screen, highlight the location
name, then click Connection. After computer to monitor communication is established, the String
View screen appears. To perform battery setup, select Setup|Battery to display the dialog boxes.

Password - If the Battery Setup boxes are protected, type the Battery Setup password and click
OK. This password closes when communication ends. If the password is incorrect, the
Battery Setup boxes appear, but the Send button is inactive.

To change the location, battery or string names after the monitor is set up and communicating,
use the Setup|System dialog boxes.

Send Button and Close Button - On the Battery Setup boxes, the Send button transfers settings
to the monitor. On Battery Setup|Test Parameters, the Historical Log, Resistance Test, and

Load Test settings are sent only if changed. You may complete all dialog boxes before clicking
Send. Clicking Send on any box transfers settings from all boxes. Changes are not saved or sent if
you only click Close.
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Programming Battery Setup for the MPM

17.1. Battery Setup: General (MPM)

String View > Setup|Battery|General
The following appear on the General dialog box.

. Battery Setup @
| Parameters | Test Parameters | Float Alarms | Discharge | Diigital [nput | LGS |
Location Mame |F‘Dmpanc- Beach, FL Station Phane Mumber |
Battery Mame |MFH System 1 MeaswePaints | 48 i‘
Sting Mame [MPH-100 22427 ShuntVabe lampsimy) [ 5 5
Diate |?a"| T4 Float Cument tultiplisr l—'li‘
Time |2:D1 P Remate Reportting | & Enable ¢ Disable
Telco MUX | ("
Metwark Setup Password |
IP &ddress: 10.203.123.45 Fle-type Password |
Wetmaszk:  255.265.0.0 ™ Auto Send Time
Eellanes Time Difference [Hours] I_Ui‘
= Send ‘ j-'L Lloze |
String Status: |Good Communication Status: |Response OK Password: |[OK

Figure 51. Battery Setup - General (MPM)

Location Name, Battery Name, String Name - Location, battery, and string names identify
the strings and hardware to which the monitor is connected. Make sure databases have the
same names to ensure proper connection. Location, battery, and string names can only be
changed under Setup|System.

Date, Time - The date and time of the computer. When you send a new configuration to the
monitor, it sends this date and time.

Station Phone Number - Type the telephone number of the Central computer the MPM
monitor calls when a system goes into alarm or discharge.

Measure Points - This is defined by Monitor Configuration on Setup|System|String.
Normally, do not change the Measure Points number; however, you may change it for custom
configurations (BDS only) not listed on System Setup|String.

Note: Do not change the Measure Points number for multi-string configurations. If you enter
a lower cell number for a configuration of 2x24, for example, only the total cell count for the
second string changes.

Shunt Value - Type the shunt rating in amps per millivolt. For example, for a shunt of
600 amps/100mV, type 6. (600 amps/100mv = 6 amps/1mv.) This value must be an integer.
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Programming Battery Setup for the MPM

Float Current Multiplier - When a series of batteries is connected with more than one cable,
it may not be possible to get the float current sensor around all the cables. In this case, you
may connect the sensor around one of the cables and set the Float Current Multiplier for the
total number of cables. The connecting cables must be of equal length.

Remote Reporting Enable and Disable - Globally enables or disables the monitor remote
reporting function. For a parameter to report on alarm, do not select the global Disable Alarm
Reporting on Setup|Preferences, and select Remote Reporting on Setup|Battery|Float Alarms
or Setup|Battery|Discharge.

Telco MUX - Not available for the MPM.

Password - To change the battery setup password, type the new password in the Password
and Re-type Password boxes. The password may be up to five alphanumeric characters long.

IP Address, Netmask and Gateway - Displays the IP address, netmask, and gateway typed
on Setup|System|Link.

Send Network Configuration - Click this button to send the IP address, netmask, and
gateway to the MPM. The MPM must have the internal network option installed. This button
transfers addresses only when MPMs are connected via RS-232 or modem, not network.

Auto Send Time - Check this box to have the time of day sent from the computer to the
hardware during autopolling and data extraction.

Time Difference (Hours) - This spin box lets you compensate for any plus or minus time
difference between the computer and hardware installation locations. When the computer
sends the time of day to the hardware, either during autopolling or Check Settings upload, the
time is automatically adjusted.

Alarm Button - If Sequential/Ack is selected on the System Setup Reporting dialog box,
select Acknowledge so the monitor notifies the computer that acknowledgement was sent
and received. This stops sequential calling but does not reset the alarm. Select Reset if
Sequential is not selected.
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Programming Battery Setup for the MPM

17.2. Battery Setup: Parameters (MPM)

String View > Setup|Battery|Parameters
On Parameters, select the hardware and parameters that will be polled and displayed.

Battery Setup T | 2
General Parameters | Test Parameters | Eloat Alarms | Dizcharge | Digital lnput | LGS |
Dizcharge Current Intertier Resistance
Iv Currert 1 Iv Intertier Resistance 1: Sting # 1 i‘ Cell#t | 12 il
[ Currert 2 [ Intertier Registance 2 Sting # 0 i‘ Cell # i} il
[~ Curert 3 I~ 0 j‘ Cellt| 0O il
™ Currert 4 r 04 casf 02
- 0 cas[ 0
Float Current ' 0 i‘ Cell| 0O il
[~ Currert 1 r 0 i‘ Cell#t| 0O il
[~ Curert 2 I~ 0 i‘ Cell#t| 0O il
[ Currert 3
[ Currert 4
MHumber of Temperatures: 1 i‘
=1 Send | I-'L Cloge |
String Status: |Good Communication Status: |Response OK Password: |OK

Figure 52. Battery Setup - Parameters (MPM)

Discharge Current - You can define up to four discharge current channels, but only one
current channel per string is allowed. If the configuration is one string, then only one current
channel may be used. Only Current 1 can trigger the recording of a discharge if Current Mode
is selected on Setup|Battery|Discharge.

Intertier Resistance - The MPM can monitor up to four strings. If selecting an Intertier
Resistance option, at String #, type the number of the string that contains the intertier. At
Cell #, type the number of the cell that is before the intertier. The intertier resistance must be
selected in numerical order.

Number of Temperatures - You may select up to eight probes to monitor ambient or
electrolyte temperature.

Float Current - The MPM can monitor up to four float current values, displayed on the
Cell Voltage screen. Set the value in the High Float Current field on Setup|Battery]|

Float Alarms. Actual current that exceeds set value appears in red on the Cell VVoltage screen
and causes an alarm. The float charging current probe (FCCP) may take 25 minutes to
stabilize after a power change. Refer to the Multitel, Inc. Float Charging Current Probe
User's Manual.
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Programming Battery Setup for the MPM

17.3. Battery Setup: Test Parameters (MPM)

String View > Setup|Battery|Test Parameters
The following appear on the Test Parameters dialog box.

Battery Setup 7 2

General | Parameters  Test Parameters |Elc-at #larms | Discharge | Digital Input | LGS |

Hizstorical Log Resistance Test Load Test
{* Enable " Dizable {*" Enable " Dizable " Enable {» Dizable
Period  [daysz) 2 il Period [daysz] 1 il Period [daysz] 0 i‘

Length [minutes) 0 il

f+ Standard ™ Average

=3 Send ‘ fLQIc-se ‘

String Status: |Good Communication Status: |[Response OK Password: |OK

Figure 53. Battery Setup - Test Parameters (MPM)

Logging / R-Test Time Mode area - Click the Absolute Date and Time option button to
specify the exact day of the month, from 1 to 28 (29, 30 and 31 are not used), and time the
historical log is updated and the resistance test is performed. Click the Day Interval button to
specify how often (in days) the historical log is updated and the resistance test is performed.

Historical Log area - Click Enable to activate, then complete Period (days) and
Period (time) described below. Specify how often in days or the date and time the voltages,
currents, and temperatures are recorded in the history log.

Period (days) and Period (time) - Either select how often the historical log is updated, or
select the day of the month and time the log is updated.

Resistance Test area - Click Enable to activate, then complete Period (days) and

Period (time) described below. Specify the resistance test interval in days or date and time. If
set to 30 days, resistance is tested every 30 days starting at 12:00 A.M. (midnight). If you
program the Load Test for the same interval as the Resistance Test, the Resistance Test is
delayed three days.

Period (days) and Period (time) - Either select how often the resistance test is performed, or
select the day of the month and time the test is performed.
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Programming Battery Setup for the MPM

Standard or Average - Normally select Standard. If the charger employs digital control of
battery voltage, which causes voltage fluctuation, select Average.

Load Test - Specify load test interval in days and length of the load test in minutes. Load test
activates a relay that shuts down the charger, if connected, and enables tracking of the
discharge. If set to 30, load test is done every 30 days starting at 12:00 A.M. See Resistance
Test (above).

17.4.Battery Setup: Float Alarms (MPM)

String View > Setup|Battery|Float Alarms
The following appear on the Float Alarms dialog box.

Battery Setup % || =
General | Parameters | Test Parameters  Float Alams .Qischarge | Digital Input | LGS |
Remate
Float Alams Latch  Reparting
& Bl  Disable High Cell Valtage fvohs) [ 2330 2] W v
Lows Cell Voltage [walts) ’W i‘ v v
High Owverall Yaltage [waolts) ,w i‘ v v
Low Overall Voltage [wiolts] IW i‘ v v
High Temperature F |—92 i‘ v v
Low Temperature iFl ’—53 i‘ v v
Cell Resistance [microhnig) IWE‘ v v
Intertier Resistance  (microhmz) ,—Ui‘ I I
High Float Current [marmps] I—D i‘ I I
Intercell Resistance  [microhms] ’—i‘ I I
High String Current [amps) ,Wi‘ r I
High Cell oltage ‘wWaming [voltz) ’W i‘
Resistance % for Waming ’—EIEI i‘
=1 Send | fL LClosze |
String Status: |Good Communication Status: |Response OK Password: |OK

Figure 54. Battery Setup - Float Alarms (MPM)

Float Alarms Enable or Disable - Global control of all float alarms for local alarm status
and alarm contact activation. Select Enable for the call-out of float alarms and digital input
alarms. When Disable is selected, the MPM Alarm Disable LED is lit, and the String Status
column on the String Status screen indicates Alarms Disabled.

Cell Resistance Threshold - Global applies the alarm level in the Cell Resistance

(microhms) field to all cells. Individual and Input Level sets alarm levels on a cell basis
using the Cell Resistance Alarm Levels box.
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Programming Battery Setup for the MPM

= Cell Resistance Alarm Levels

Cell Resistance
Apply o

& Percentage Above

i

" Absolute Above miciochms
Cell 100

1

IT 2!

€ 2/6/2006 01:17:23 5 -
C214/2006 113306 5

AAAAAAAAAAAAAAAA
mmmmmmmmmmmmmmmmmmmmmmm

“
Baseline Date 2/6/2006 01:17:23

Figure 55. Cell Resistance Alarm Levels Setup (MPM)

Cell Resistance Alarm Levels box - To set Alarm Levels on a cell basis, click Individual and
Input Level and select options on this box.

Percentage Above - Sets the cell alarm level a percentage above the selected dataset
levels. Type a value (1 to 99) in the Percentage Above field.

Absolute Above (Microhms) - Sets the cell alarm level a numeric value above the
selected dataset levels. Type a value (1 to 99) in microhms in the Absolute Above field.

Date area check boxes - Click one dataset date in this area on which to base alarm
levels. The system stores the date of the baseline data and displays it on the lower right
after the Apply button is clicked.

Apply - Click apply to apply selected levels to the cells. The values appear in the
Threshold column. If you do not want to edit individual cell levels (see below), click OK.

Cell, Intertier and Threshold columns - To edit individual cell or intertier alarm levels
in the Threshold column, click the value and type a new value. After editing, click OK.

Note: Values are not saved until Save or Send is clicked on the Float Alarms or another
Battery Setup box.

Alarm Thresholds - For high and low cell voltage, overall voltage, temperature, resistance,
and current, select violation threshold values that activate an alarm during a float condition.
These thresholds are deactivated for 30 minutes following a resistance test. If a discharge
occurs, the alarms are disabled until the overall voltage recovers to a value above the low
threshold.

High Cell Voltage Warning (volts) - Type a value between the Low Cell Voltage and High
Cell Voltage levels. This setting affects the bar graph colors on the Cell Voltage String View
screen. During normal float condition, the bar colors change as follows:

High Violation ................... Red
Bar Colors for all Warning ......oevevveeeeenennnnne Blue
Normal and Normal......ccccevevviicininnnnnn. Green
Violation Types Low Violation.................... Yellow

Out of Range Values........ Maroon

Negative Cell Voltage....... Black
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Programming Battery Setup for the MPM

Percentage for Warning - Determines the violation threshold that causes a Warning battery
status. The value entered is a percentage of the internal resistance alarm. For example, if the
internal resistance alarm is set to 200 microhms and the percentage for warning is 75%, the
system issues a warning when the internal resistance is between 75 and 100 microhms. When
the value exceeds 100 microhms, the system issues an alarm. Warning status is displayed
only on the String Status and Historical Events screens, not on the Alarms screen.

Latch - When selected, the alarm contact stays energized until manually reset. If not selected,
the alarm contact de-energizes when the alarm condition clears.

Remote Reporting - When selected, causes the monitor to report the alarm. When not
selected, call-out is disabled for that parameter. You must select this option and Remote
Reporting Enable under Setup|Battery|General to enable the call out function and to display
Alarm Detail on the Historical Events screen during polling.

17-8



17.5. Battery Setup: Discharge (MPM)

String View > Setup|Battery|Discharge

The following appear on the Discharge dialog box.

Battery Setup

General | Parameters | Test Parameters | Float &larmsz  Discharge |Digital Input | LGS |

Discharge Selections Deviation Starage Threshaolds
| Eieis Log Threshald for CellVoltage
v Latch "
- Log Threshold for 0% [100": mew] 5 z‘
r Log Threshold far Current
Prablem Dizcharge Thresholds
Digcharge Detection Method
Low Cell Valtage

" “oltage Mode &+ Current Mode

Level [amps] 280 i‘

Laow Owveral Voltage

Report Option
(" FRepart all dizcharges

" Report problem discharge only

¢ Disable

[mv] 15 i‘
[amps] 1 i‘

[vos) [ 1.750 -3
[waltz) 420 i‘
M aximum Discharge Time [rrirutez) an i‘

Programming Battery Setup for the MPM

=1 Send |

String Status: |Good Comrmunication Status: |Response OK

Password: |OK

Figure 56. Battery Setup - Discharge (MPM)

Discharge Selections Area:

Enable - Select to let the monitor capture and store discharge data. If not selected, the

MPM does not log discharges.

Latch - When selected, the alarm contact stays energized until manually reset. If not
selected, the alarm contact de-energizes when the discharge condition clears.

The Critical Alarm and Maintenance Alarm options do not apply to the MPM.

Discharge Detection Method Area:

Select Voltage Mode or Current Mode, then set the threshold Level in volts or amps to
activate data logging during a discharge. When the voltage goes below the set level or the
current exceeds the set level, the monitor begins recording cell voltages, discharge
current, and overall voltage, based on the Deviation Storage Thresholds (described later).
Only one temperature sample is stored at the beginning of the discharge.

17-9



Programming Battery Setup for the MPM

Voltage mode allows data recording during recharge, since data logging does not stop
until the voltage goes above the threshold. If measuring discharge current, use
Discharge Current Mode as a reliable source of trigger.

In current mode, the monitor triggers only on Current Channel 1 selected on
Setup|Battery|Parameters. To enable this mode, you must define the Current Channel on
the Setup|Battery|Parameters dialog box.

Report All Discharges - If selected, the monitor reports all discharges to the Central
computer. You must enable Remote Reporting on Setup|Battery|General.

Report Problem Discharge Only - If selected, the monitor reports only discharges that
exceed voltage or time values set in Problem Discharge Thresholds (described later) to the
Central computer.

Disable - If selected, stops the MPM from reporting a discharge.

Deviation Storage Thresholds Area - Log Threshold for Cell Voltage, Log Threshold for
OV (Overall Voltage), and Log Threshold for Current - When the voltage or current
changes by the amounts in these boxes, the event is recorded. For most applications, use
10mv for cell voltage, 100mv for overall voltage, and 1 amp for discharge current. Smaller
values could cause monitor memory problems. Do not set these values to 0. If set to 0, no
data will be logged during discharge. Refer to Data Storage in the MPM.

Problem Discharge Thresholds Area:

Low Cell Voltage, Low Overall Voltage, and Maximum Discharge Time - Select the
voltage or time levels that trigger discharge reporting. To enable these values,

select Report Problem Discharge Only on this screen. This setting also affects the bar
graph colors on the Cell VVoltage String View screen. During a discharge, the bars change
color:

NOrMal CONAITION .......ueeiiiiiiiiiie e Green
Problem Discharge Thresholds or Low Cell Voltage.................... Yellow

Time to Go Area:
The String View screen can display a Time to Go (TTG) number. When an MPM
discharge starts, the TTG box on String View indicates the estimated remaining time that

the battery can deliver power. To disable this feature, leave the Amp Hours and Peukert
Number boxes at zero.

IMPORTANT NOTE: The TTG Time to Go number is only an estimate.

Amp Hours - Type the amp hours of the battery at the 8 hour rating. To disable the
estimated time feature, set to 0.

Peukert Number - Type the Peukert number derived by using Peukert's equation. Refer

to Understanding the Time to Go Algorithm. To disable the estimated time feature, set
to 0.
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17.6. Battery Setup: Digital Input (MPM)

String View > Setup|Battery|Digital Input

The MPM has 16 digital inputs that may be connected to external dry contacts. You may set
up these inputs on the Digital Input dialog box to report an alarm when the external contacts
are activated.

Battery Setup 7 || 2
Gereral | Parameters | Test Parameters | Eloat Alarms | Discharge  Digital Input | LGS |
Input Hame M/C MN/0 Feport
Input 1: N v ™
Input 2: N v ™
Input 3: B v [
Input 4: n i~ ™
Input 5: n i~ ™
Input B: n v ™
Input 7: n v ™
Input & N v I
Input 9: N v I
Input 10; N v ™
Input 11 N v ™
Input 12: N v ™
Input 13 B v [
Input 14; B v I
Input 15 n i~ ™
Input 16: n v ™
=3 Serd | I-'L Cloze ‘
String Status: |Good Comrmunication Status: |Polling System Status Password: |OK

Figure 57. Battery Setup - Digital Input (MPM)

Input Name - Assign a name to the input connected to the external contacts and indicate if
the contacts are normally open or normally closed. To disable an input, clear the input name.

N/C or N/O - Select the N/C box if the external contacts are normally closed. Select the N/O
box if the external contacts are normally open.

Report - Selecting this check box lets the monitor report a digital input alarm. When not
selected, reporting is disabled for that input.
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17.7.Battery Setup: Digital Output (MPM)

String View > Setup|Battery|Digital Output

The MPM has three optional relay contact control outputs you can define to trigger on an
alarm event.

i

Qeneral]Ealametels Test Parameters | Float Alarms | Discharge | Digital [nput Digita|QUlDUllLGS ]

7]x]

Output Marme Trigger Mame String # Enable Latch
Output 1: |High Discharge |High Discharge Curent ﬂ 1 - v v
Output 2 |High Cell Volage High Cell Valtage ~ o= W r
Output 2 |Low cell Valtage |Low Cell Voltage ~ = d r
Dutput 4: |High Overal Woltage |High Overal Waolage j 1 - v v
Dutput 5 [High Cell Valtage [High Cell Voltage = 1 = W r
Dutput 6 [High Cell Valtage |High Cell Voltage ~ - W r
Output 7: |High Cell Valtage |High Cell Valtage ﬂ 4 hd ~3 I
DOutput & |High Cell Valtage |High Cell Vaoltage ﬂ 5 h ~3 I
=1 Send ‘ j-'|_ Close ‘
String Skatus: |Good Communication Status: Palling System Status Password: (O

Figure 58. Battery Setup - Digital Output (MPM)

After defining an Output Name and Trigger Name, the associated digital output can change
state on an alarm to control a user-selected device. If you select Latch, the output latches. The
relay is a Form C contact that de-energizes upon alarm condition reset.

Output Name - Type a name that describes the external device being controlled.

Trigger Name - From the drop-down list, select a parameter that energizes the
Control Output relay contact.

Enable - Select Enable to energize a rear panel Control Output contact on a trigger event.

Latch - When selected, the Control Output contact energizes until manually reset. If not
selected, the Control Output de-energizes when the trigger event clears.
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Battery Setup: LGS (MPM)

String View > Setup|Battery|LGS

Leibert Global Services (LGS) offers a service in which its Customer Response Center (CRC)
remotely monitors your Alber BDS or MPM equipment and other facility devices around the
clock. The CRC evaluates alarms and provides immediate telephone and e-mail assistance
using a customer-defined response and escalation plan. For details about subscribing to the
service, phone (800) 748-3666 or (800) SITEMON or e-mail LGS.monitoring@vertivco.com.

If you have subscribed to an LGS monitoring plan, complete the Battery Setup|LGS dialog
box as follows.

LE

ﬁenelall Earametersl Test Parameters | EIDatAIarmsI Thermal Runaway -Qischarge LGS

Systern Type {000 [

Site 1D o000 (00000 - 99395)

Monitor Device Mumber [0000000 (0000000 - 3359333)

LGS Phone Mumber I

LGS Repart Time IDD:DD HH: kb4

[~ Enabled
=4 Save | IL Close |
String Status: |Unknown ‘Communication Status: |Unknown Password: |Unchecked

Figure 59. Battery Setup - LGS (MPM)

System Type - Type three characters to identify the device being monitored.
For MPM-100, type MPM; for BDS-256, type 256; for BDS-40, type 040.

Site ID - Type the five character ID for customer site identification.
Monitor Device Number - Type the seven digit number used for customer device tracking.

LGS Phone Number - Type the telephone number that connects to the LGS remote
monitoring service. This number is used for a daily communication test and alarm reporting.

LGS Report Time - Type the time the monitor calls in each day to confirm communication.
Use the 24 hour clock; e.g., 13:45.

Enabled - Check this box to enable remote monitoring by LGS. Monitoring is enabled only
after a monitoring plan has been purchased from LGS.

17-13



Programming Battery Setup for the BDS

18. Programming Battery Setup for the BDS

=]
From String Status, click Connection to display the String View screen.

String View > Setup|Battery|dialog box

After completing Preferences, Communication Setup, and System Setup, complete the Battery
Setup dialog boxes. To open Battery Setup, on the String Status screen, highlight the location
name, then click Connection. After computer to monitor communication is established, the String
View screen appears. To perform battery setup, select Setup|Battery to display the dialog boxes.

Password - If the Battery Setup boxes are protected, type the Battery Setup password and click
OK. This password closes when communication ends. If the password is incorrect, the
Battery Setup boxes appear, but the Send button is inactive.

To change the location, battery or string names after the monitor is set up and communicating,
use the Setup|System dialog boxes.

Send Button and Close Button - On the Battery Setup boxes, the Send button transfers settings
to the monitor. On Battery Setup|Test Parameters, the Historical Log, Resistance Test, and
Load Test settings are sent only if changed. You may complete all dialog boxes before clicking
Send. Clicking Send on any box transfers settings on all boxes. Changes are not saved or sent if
you only click Close.
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18.1. Battery Setup: General (BDS)

String View > Setup|Battery|General
The following appear on the General dialog box.

Battery S.etup @

G | Parameters | Test Parameters | Eloat.-’-‘n.lalmsl S_l,lstem] Discharge | Digital Input | Digital Output | LGS |
Location Mame |Fompano Beach, FL Station Phone Mumber |
Battery Mame |3DK\-"¢’-‘« UPS Meazure Points l—fiﬂil
String Mame |EDS-2551X4E¢<12V Shunt % alue [amps/my) l—'lil
Date [7/17/2014 Float Curent Mulipier | 1 -3
Time [310FM Femate Reporting | & Enable ¢ Disabls
Charger Ripple Freq | ~ sg0pz & B0 ke TelcoMUx | & Enable % Disable
Mebwork Setup Pazsword |
IP Addrezs: 10.203123.45 Fe-type Password |
Metmazk:  2585.255.000 W Auto Send Time
Gateway: Time Difference (Haurs] ,—Di‘ Set BDS Default Values
Alarm Button | ' Acknowledge (¢ Reset

= Send ‘ j-'LQUse |

String Status: |Good Communication Status: Response OK Password: |OK

Figure 60. Battery Setup - General (BDS)

Location Name, Battery Name, String Name - Location, battery, and string names identify
the strings and hardware to which the monitor is connected. Make sure databases have the
same names to ensure proper connection. Location, battery, and string names can only be
changed under Setup|System.

Date/Time - The date and time of the computer. When you send a new configuration to the
monitor, it sends this date and time.

Charger Ripple Freq - Select to set the system to the charger ripple frequency of
either 50Hz or 60Hz.

Station Phone Number - Type the telephone number of the Central computer the BDS
monitor calls when a system goes into alarm or discharge.

Measure Points - This is defined by Monitor Configuration on Setup|System|String.
Normally, do not change the Measure Points number; however, you may change it for custom
configurations not listed on System Setup|String. The Measure Points number defines the
total number of cells.

Shunt Value - Type the shunt rating in amps per millivolt. For example, for a shunt of
600 amps/100mV, type 6. (600 amps/100mv = 6 amps/1mv.) This value must be an integer.
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Float Current Multiplier - When a series of batteries is connected with more than one cable,
it may not be possible to get the float current sensor around all the cables. In this case, you
may connect the sensor around one of the cables and set the Float Current Multiplier for the
total number of cables. The connecting cables must be of equal length.

Remote Reporting Enable and Disable - Globally enables or disables the monitor remote
reporting function. For a parameter to report on alarm, do not select the global Disable Alarm
Reporting on Setup|Preferences, and select Remote Reporting on Setup|Battery|Float Alarms
or Setup|Battery|Discharge.

Telco MUX Enable and Disable - Select Enable when using a Telco multiplexer. This can
only be set when the BDS Controller is connected to String 1.

Password - To change the battery setup password, type the new password in the Password
and Re-type Password boxes. The password may be up to five alphanumeric characters long.

IP Address, Netmask and Gateway - Displays the IP address, netmask, and gateway typed
on Setup|System|Link.

Send Network Configuration - Click this button to send the IP address, netmask, and
gateway to the BDS. The BDS must have the internal network option installed. This button
transfers address only when BDSs are connected via RS-232 or modem, not network.

Set BDS Default Values - Click to transfer parameters for the Monitor Configuration
selected under System Setup|String to the Battery Setup|Parameters and
Battery Setup|Float Alarms dialog boxes and to the Measure Points field.

Auto Send Time - Check this box to have the time of day sent from the computer to the
hardware during autopolling and data extraction.

Time Difference (Hours) - This spin box lets you compensate for any plus or minus time
difference between the computer and hardware installation locations. When the computer
sends the time of day to the hardware, either during autopolling or Check Settings upload, the
time is automatically adjusted.

Alarm Button - If Sequential/Ack is selected on the System Setup Reporting dialog box,
select Acknowledge so the monitor notifies the computer that acknowledgement was sent
and received. This stops sequential calling but does not reset the alarm. Select Reset if
Sequential is not selected.
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18.2. Battery Setup: Parameters (BDS)

String View > Setup|Battery|Parameters

The following appear on the Parameters dialog box. For the BDS-40, the OV Enable,
Cell Voltage selection, and Intercell Enabled boxes are not available.

| Test Parameters | Float .f-\larms] System] Dizcharge | Diigital Input | Drigital Output | LGS |
DCM | Cell: | LS/D | RALS | RLLS | S5 8| T1 T2 Parameter Enabled Intertier # Cell #
2 = | = oC x| 2 10
3 (. FC x| 3 15
: |- Cellvaol 12 Wl 4 A0
ellYoltage : altz hi

5 | ? 5 25
B | [~ Intercell Enabled B 10
7 Charger IT

W . ™ Enabled ! *
: | o Cable +1 @
] m | | P = ]
10 | Cable +2 | J 10
11 == Cable -1 | J 1
12 RN Cable 2 | =] 12
13 /| = 13
14 = LS/D : Load steps per DCM 14

R/LS : Reads per load step
15 = | = RLLS : Reads on last load step 15
16 = SS#:  Starting step number
=1 Send ‘ j-'L LCloze ‘
String Status: |Good Communication Status: |[Response OK Password: |OK

Figure 61. Battery Setup - Parameters (BDS-256)

DCM - For all DCM units 1 to 16 in use, configure these items according to the configuration
chart on the following pages.

Cells - Total number of cells monitored by the DCM.

LS/D - Load Steps per DCM.

R/LS - Reads per Load Step.

RLLS - Reads on Last Load Step.

SS# - Starting Step Number.

T1 and T2 columns - Temperature 1 and 2. Each DCM can monitor up to two
temperatures. No more than ten temperatures may be monitored for the entire string.
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Config DCM Cells LS/D RILS RLLS SS#

1x198x1V 1 44 2 22 22 1
2 44 2 22 22 3

3 44 2 22 22 5

4 44 2 22 22 7

5 22 1 22 22 9

1x8x2V 1 8 - - - -
1x31x2V 1 31 3 10 11 6
1x62x2V 1 30 2 15 15 5
2 32 2 15 17 7

1x65x2V 1 32 2 16 16 5
2 33 2 16 17 7

1x108x2V 1 36 2 18 18 1
2 36 2 18 18 3

3 36 2 18 18 5

1x122x2V 1 48 4 12 12 1
2 48 4 12 12 5

3 26 4 12 14 9

1x180x2V 1 46 2 23 23 1
2 46 2 23 23 3

3 46 2 23 23 5

4 42 2 23 19 7

1x182x2V 1 46 2 23 23 1
2 46 2 23 23 3

3 46 2 23 23 5

4 44 2 23 21 7

1x188x2V 1 48 2 24 24 1
2 48 2 24 24 3

3 48 2 24 24 5

4 44 2 24 20 7

1x192x2V 1 48 2 24 24 1
2 48 2 24 24 3

3 48 2 24 24 5

4 48 2 24 24 7

1x193x2V 1 44 2 22 22 1
2 44 2 22 22 3

3 44 2 22 22 5

4 44 2 22 22 7

5 17 1 17 17 9

1x203x2V 1 40 2 20 20 1
2 40 2 20 20 3

3 40 2 20 20 5

4 40 2 20 20 7

5 45 2 20 10 9

1x205x2V 1 40 2 20 20 1
2 40 2 20 20 3

3 40 2 20 20 5

4 40 2 20 20 7

5 45 2 20 25 9

1x210x2V 1 48 2 24 24 1
2 48 2 24 24 3

3 48 2 24 24 5

4 48 2 24 24 7

5 18 1 18 18 9

1x216x2V 1 48 2 24 24 1
2 48 2 24 24 3

3 48 2 24 24 5

4 48 2 24 24 7

5 24 1 24 24 9

1x232x2V 1 46 2 23 23 1
2 46 2 23 23 3

3 46 2 23 23 5

4 46 2 23 23 7

5 48 2 23 25 9

1x234x2V 1 48 2 24 24 1
2 48 2 24 24 3

3 48 2 24 24 5

4 48 2 24 24 7
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Config DCM Cells LS/D RILS RLLS SS#
1x198x1V 1 44 2 22 22 1
2 44 2 22 22 3
3 44 2 22 22 5
4 44 2 22 22 7
5 22 1 22 22 9
5 42 2 24 18 9
1x238x2V 1 48 2 24 24 1
2 48 2 24 24 3
3 48 2 24 24 5
4 48 2 24 24 7
5 46 2 23 22 9
1x239x2V 1 48 2 24 24 1
2 48 2 24 24 3
3 48 2 24 24 5
4 48 2 24 24 7
5 47 2 24 23 9
1x240x2V 1 48 2 24 24 1
2 48 2 24 24 3
3 48 2 24 24 5
4 48 2 24 24 7
5 48 2 24 24 9
1x241x2V 1 48 2 24 24 1
2 48 2 24 24 3
3 48 2 24 24 5
4 48 2 24 24 7
5 24 1 24 24 9
6 25 1 25 25 10

Figure 62. BDS Configuration Data for Setup Files

18-6



Programming Battery Setup for the BDS

Config DCM Cells LS/D RILS RLLS SS#

1x244x2V 1 48 2 24 24 1
2 48 2 24 24 3

3 48 2 24 24 5

4 48 2 24 24 7

5 24 1 24 24 9

6 28 1 28 28 10

1x246x2V 1 48 2 24 24 1
2 48 2 24 24 3

3 48 2 24 24 5

4 48 2 24 24 7

5 24 1 24 24 9

6 36 1 30 30 10

1x252x2V 1 48 2 24 24 1
2 48 2 24 24 3

3 48 2 24 24 5

4 48 2 24 24 7

5 24 1 24 24 9

6 36 1 36 36 10

1x6x4V 1 6 1 6 6 1
1x90x4V 1 45 5 9 9 1
2 45 5 9 9 6

1x120x4V 1 48 4 12 12 1
2 48 4 12 12 5

3 24 2 12 12 9

1x121x4V 1 48 4 12 12 1
2 48 4 12 12 5

3 25 2 12 13 9

1x122x4V 1 48 4 12 12 1
2 48 4 12 12 5

3 26 2 12 14 9

1x123x4V 1 48 4 12 12 1
2 48 4 12 12 5

3 27 2 12 15 9

1x60x6V 1 30 5 6 6 1
2 30 5 6 6 6

1x62x6V 1 30 5 6 6 1
2 32 5 6 8 6

1x65x6V 1 32 4 8 8 1
2 33 4 8 9 5

1x78x6V 1 40 5 8 8 1
2 38 5 8 6 6

1x80x6V 1 40 5 8 8 1
2 40 5 8 8 6

1x81x6V 1 40 5 8 8 1
2 41 5 8 9 6

1x60x8V 1 30 5 6 6 1
2 30 5 6 6 6

1x61x8V 1 30 5 6 6 1
2 31 5 6 7 6

1x30x12V 1 30 10 3 3 1
1x31x12V 1 31 10 3 4 1
1x32x12V 1 32 8 4 4 1
1x33x12V 1 33 10 3 6 1
1x36x12V 1 36 9 4 4 1
1x40x12V 1 40 10 4 4 1

Figure 63. BDS Configuration Data for Setup Files (continued)
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Parameter / Enabled - The OV, DC and FC parameters are assigned to DCM #1. Select
Enabled to view the parameter in String View and enable the hardware.

OV - Overall Volts. Not available for BDS-40.
DC - Discharge Current.
FC - Float Current.

Cell Voltage - From the drop-down list, select the nominal voltage of the cell or jar being
measured.

Intercell Enabled - Select this box if making separate measurements for intercells. Not
available for BDS-40.

Charger IT - Select the enabled check box if using the Charger IT option. This area allows
you to select and assign a cable to a DCM and intertier channel. The Cable+1 is the first
DCM and the Cable -1 is the last DCM.

Note: When intercells are enabled, they are defaulted to discrete. Each cable will have up to
four intertier channels, for example:

e <DCM1><IT 1>

e <DCM 1><IT 2>

e <DCM 1><IT 3>

e <DCM 1><IT 4>
Note: On combined reading board, the intertier channel number will always start the first
available channel past the cells.

Intertier #/ Cell # - For intertiers 1 to 15 in use, assign a cell number that relates to each
intertier.

Note: When cell 1 is most negative, when assigning an intertier to a cell, use the cell number
after the intertier.

The cell number is the lower of the two cell numbers across which the intertier is connected.

For example, typing 16 assigns the intertier between cells 16 and 17. Each DCM can monitor
up to ten intertiers. No more than 15 intertiers can be monitored for the entire string.
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18.3. Battery Setup: Test Parameters (BDS)

String View > Setup|Battery|Test Parameters
The following appear on the Test Parameters dialog box.

Battery Setup @

General | Parameters ;]

| Eloat.&larms] System] Dizcharge | Diigital Input | Digital Qutput | LGS |

Historical Log Resistance Test
(* Enable " Dizable {*" Enable " Dizable
Period [daps] 17 i‘ Period [daps] 17 i‘

{* Standard (" Average

[~ Extended intertier awg test

String Status: |Good Communication Status: |[Response OK Password: |OK

=1 Send ‘ ﬁglose |

Figure 64. Battery Setup - Test Parameters (BDS)

Logging / R-Test Time Mode area - Click the Absolute Date and Time option button to
specify the exact day of the month, from 1 to 28 (29, 30 and 31 are not used), and time the
historical log is updated and the resistance test is performed. Click the Day Interval button to
specify how often (in days) the historical log is updated and the resistance test is performed.

Historical Log area - Click Enable to activate, then complete Period (days) and
Period (time) described below. Specify how often in days or the date and time the voltages,
currents, and temperatures are recorded in the history log.

Period (days) and Period (time) - Either select how often the historical log is updated, or
select the day of the month and time the log is updated.

Resistance Test area - Click Enable to activate, then complete Period (days) and

Period (time) described below. Specify the resistance test interval in days or date and time. If
set to 30 days, resistance is tested every 30 days starting at 12:00 A.M. (midnight). When the
monitor performs a resistance test, it creates a historical log entry. For this reason, you may
want to select a resistance test 14 days away from a historical log entry.

Period (days) and Period (time) - Either select how often the resistance test is performed, or
select the day of the month and time the test is performed.
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Standard or Average - Normally select Standard. If the charger employs digital control of
battery voltage, which causes voltage fluctuation, select Average.

Extended Intertier Avg Test - If this box is checked, when a resistance test is performed,
the intertier resistance is sampled a greater number of times and the result is averaged. This
feature is useful when testing in high noise environments.

Average Cell Resistance - This field displays the average value of the last resistance test run.

Resistance offset adjustment +/- This field allows you to adjust your resistance
measurements by percentage with a plus or minus offset adjustment. This function only
applies to future resistance tests that are rerun. You may enable or disable this function at
anytime during the process by clicking on the Enabled checkbox.

18.4. Battery Setup: Float Alarms (BDS)

String View > Setup|Battery|Float Alarms
The following appear on the Float Alarms dialog box.

Battery Setup @

General | Parameters | Test Parameters |

| System] Dizcharge | Digital Input | Digital Output | LGS |

Remate
Flaat Alams Latch  Reporting  Crtical  Maintenance
o Eichl i Do High Cell Voltage vois) [ 14500 2 W v r v
Law Cell Yalkage [walts) ’W j‘ v v r v
High Owerall Voltage [walts) ’m i‘ v v v I
Low Overall Valtage [walts) ’m i‘ v v [ n
High Temperature iF) ’—82 i‘ v v N v
Cell Resistance Threshold Low Temperature IF] 9 i‘ ~ v r ]
' Global " Individual Cell Resiztance [microhms) ,—D'Ii‘ ~ ~ I [v
Intertier Resistance  [microhms]  Input Level v v I v
High Float Current [mampz) ’w i‘ v v ™ 4
Intercell Resistance  [microhms) IWE‘ ~ - I v
High Sting Current [armps] ’Wi‘ - I I I
High Cell % oltage ' arming [valtz) ’W j‘
Resistance % for Waming ’—99 i‘
=1 Send ‘ j"L Close ‘
String Status: |Good Communication Status: |Polling System Status Password: |OK

Figure 65. Battery Setup - Float Alarms (BDS)

Float Alarms Enable or Disable - Global control of all float alarms for local alarm status
and alarm contact activation. Select Enable for the call-out of float alarms and digital input
alarms. When Disable is selected, the String Status column on the String Status screen
indicates Alarms Disabled.
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Cell Resistance Threshold - Global applies the alarm level in the Cell Resistance
(microhms) field to all cells. Individual and Input Level sets alarm levels on a cell basis
using the Cell Resistance Alarm Levels box.

= Cell Resistance Alarm Levels

Apply Cell Resistance
& Percentage Above 0
25
 absolute Abowe micioohms
Cell 100

T 25

12/30/1899 12:00:00 2
5/3/2006 04:20:00
7 5/5/2006 02:41:40 p
53727 36:26 p
1 7/27/2006 04:41:11 p
] 7/27/2006 045757 p

10 i
Baseline Date 42772006 03:36:26 p

Figure 66. Cell Resistance Alarm Levels Setup (BDS)

Cell Resistance Alarm Levels box - To set Alarm Levels on a cell basis, click Individual and
Input Level and select options on this box.

Percentage Above - Sets the cell alarm level a percentage above the selected dataset
levels. Type a value (1 to 99) in the Percentage Above field.

Absolute Above (Microhms) - Sets the cell alarm level a numeric value above the
selected dataset levels. Type a value in microhms in the Absolute Above field.

Date area check boxes - Click one dataset date in this area on which to base alarm
levels. The system stores the date of the baseline data and displays it on the lower right
after the Apply button is clicked.

Apply - Click apply to apply selected levels to the cells. The values appear in the
Threshold column. If you do not want to edit individual cell levels (see below), click OK.

Cell, Intertier and Threshold columns - To edit individual cell or intertier alarm levels
in the Threshold column, click the value and type a new value. After editing, click OK.

Note: Values are not saved until Save or Send is clicked on the Float Alarms or another
Battery Setup box.

Alarm Thresholds - For high and low cell voltage, overall voltage, temperature, and
resistance, select violation threshold values that activate an alarm during a float condition.
These thresholds are deactivated for 30 minutes following a resistance test. If a discharge
occurs, the alarms are disabled until the overall voltage recovers to a value above the low
threshold.
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High Cell Voltage Warning (volts) - Type a value between the Low Cell Voltage and High
Cell VVoltage levels. This setting affects the bar graph colors on the Cell Voltage String View
screen. During normal float condition, the bar colors change as follows:

High Violation ................... Red
Bar Colors for all Warning .......cooecevvveeeeeennnns Blue
Normal and E:\:vm\zlc;iét.i.c.).ﬁ ..................... $(raﬁ§\r/]v
ViOlation T ES ....................
yp Out of Range Values........ Maroon

Negative Cell Voltage....... Black

String View > Setup|Battery|Float Alarms|Iinput Level then Save or Cancel

Intertier Resistance Input Level - Click Input Level to display the Input Alarm Level box.
Type the resistance alarm level threshold (in microhms) for each intertier. The cell numbers
in this box are the lower of the two cell numbers across which the intertier is connected.
(These cell numbers are selected under Battery Setup|Parameters.)

Note: The charger cable is only used for BDS and is intended to only be used for individual
thresholds.

Input Alarm Level x|
Intertier Resistance Alarm Level
#1 0
#2 0
#3 0
#4 0
#5 0
HE 0
#7 0
#8 0
#3 0
#10 0
#11 0
#12 0
#13 0
#14 0
#15 0

o Save | x LCancel |

Figure 67. Input Alarm Level
(Intertier Resistance Alarm Level)

Percentage for Warning - Determines the violation threshold that causes a Warning battery
status. The value entered is a percentage of the internal resistance alarm. For example, if the
internal resistance alarm is set to 100 microhms and the percentage for warning is 75%, the
system issues a warning when the internal resistance is between 75 and 100 microhms. When
the value exceeds 100 microhms, the system issues an alarm. Warning status is displayed
only on the String Status and Historical Events screens, not on the Alarms screen.

Latch - When selected, the alarm contact stays energized until manually reset. If not selected,
the alarm contact de-energizes when the alarm condition clears.
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Remote Reporting - When selected, causes the monitor to report the alarm. When not
selected, reporting is disabled for that parameter. You must select this option and Remote
Reporting Enable under Setup|Battery|General to enable the call out function and to display
Alarm Detail on the Historical Events screen during polling.

Critical and Maintenance - Two alarm contacts are available. Select Critical or Maintenance
to define which contacts energize upon alarm. If neither is selected, the Remote Reporting
check box clears and alarm reporting is disabled for that parameter. These settings do not
affect bar graph colors.
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18.5. Battery Setup: System (BDS)

String View > Setup|Battery|System
The Thermal Runaway and Hardware parameters are used to trigger system events.

Thermal runaway can be a very destructive and serious condition on standby batteries if not
identified in the beginning of the development stages. If thermal runaway is ignored, severe
damage to the battery as well as surrounding equipment can occur resulting in costly repairs
or worse, injury to personnel. In all cases, thermal runaway can lead to abrupt system failure
and disruption of service if not detected. A proactive method of some form must be instituted
to deal with a thermal runaway condition. Furthermore, as described in the International Fire
Code (IFC), VRLA battery systems shall be provided with a listed device or other approved
method to preclude, detect and control thermal runaway (IFC 608.3)™.

Battery Setup @

General | Parameters | Test Parameters | Float Alarms 5 Discharge | Digital Input | Digital O utput | LGS |

Thermal Runaway

Latch  Reporting  Critical — Maintenance

High Float Current [mamnps] 0 i‘
Temperature Delta 0 i‘

Battery Temperature DCM/Probe |DCM -1 Probe - 1 ﬂ

I I M M

Ambient Temperature DCM/Probe |DCM -1 Prabe - 1 ﬂ

Hardware
Latch Reporting  Critical — Maintenance
Hardware Fault r B I I
=1 5end ‘ j-'L Close |
String Status: |Good Communication Status: Response OK Password: |OK

Figure 68. Battery Setup - Thermal Runaway (BDS)

High Float Current (in mamps) A float current threshold, which is independent of the Float
Alarms - Float Current threshold, can be set. Entering a value of 0 will disable this parameter
from the analysis for thermal runaway. Otherwise, a value from 1-5000ma can be entered.
Seeing an abnormal rise in float current can be an indication of a thermal runaway condition.
However, normal conditions like charging after a discharge can and will show elevated float
currents for a period of time. The length of time and the amount of this elevated float current
is difficult to predict as the depth of discharge and type of battery will affect this. Due to this,
this parameter will be temporary disabled for making thermal analysis for 72 hours following
a discharge.

L1CC, 2012 ICC International Fire Code® (IFC)
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Temperature Delta A temperature delta can be set to identify the difference in temperature
between two temperature probes. The desired location of these probes would be one
measuring ambient temperature in the vicinity of the battery and the other placed directly
onto the battery. Entering a O will disable this parameter for the analysis for thermal runaway.
Otherwise, a value from 1-99F or 1-38C can be entered.

Note: To apply the Thermal Runaway feature, you must select a High Float Current
mamps value and/or a Temperature Delta value. If both methods are used then both
conditions must be met.

Although only one parameter can be used, it is advised to use both as the float current can be
automatically disabled for a period of time following a discharge event. In the event a thermal
runaway condition occurs during the recharge following a discharge, the temperature delta
will rise indicating a thermal runaway condition. The BDS will now log high float current
and/or temperature.

Latch - When selected, the high float current and temperature Delta alarm stays on until
manually reset. If not selected, the alarm will go off when the high float current or
temperature condition clears.

Reporting - When selected, the alarm will be reported and an alert will be displayed in the
system. If not selected, the alarm will not be reported when a high float current or
temperature alarm occurs on the system.

Critical Alarm and Maintenance Alarm - Two alarm are available for thermal runaway.
Select Critical or Maintenance Alarm to define which alarm will report and appear in the
system. If neither alarms are selected, alarm reporting is disabled for discharge.

Battery Temperature and Ambient Temperature DCM/Probe — These are selections to
define where the probes are physically attached to the monitoring hardware. The system will
know what DCM’s are available but the individual setting the system up will need to know
which probes to use and therefore properly assign them.

There is only one set of Latch/Reporting/Critical/Maintenance settings because either
parameter will cause a thermal runaway event to be created in the alarm logging.

Optional Relay Module - If the system is configured with the optional relay module, each
contact can be configured to a thermal runaway event as shown below. Each contact can be
defined to a particular string and programmable to be latching or non-latching. If the alarm
module is used for the BDS-40, there are only six alarm contacts available. If it is a BDS-256,
then there are eight contacts available.

The Hardware section allows you to configure and generate alarms on hardware faults. At
the time of this BMDM software release, the only hardware fault monitored is a
communication fault between the BDS Controller and DCM’s.

It is required to have Latching enabled. Critical and Maintenance should only be checked if

the indicators on the front panel and alarm relay operation are required. Remote reporting is
not required for this alarm to function properly.
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18.6. Battery Setup: Discharge (BDS)

String View > Setup|Battery|Discharge
The following appear on the Discharge dialog box.

Programming Battery Setup for the BDS

Battery Setup

General | Parameters | Test Parameters | Float Alarms | Swstem

Dizcharge Selections

Deviation Storage Threshalds

- Digital Input | Digital Output | LGS |

ol Sishis Log Threshold for Cell Yoltage [ree] il
v L Log Threshald for OV 100 il
[w Critical Alarm P UL A A (100's mw] =
[~ Maintenance Alam Log Threshold for Current [amps) il

Problem Dizcharge Threzhaolds

Digcharge Detection Method

Lo CellYaltage

" VYoltage Mode o Current Mode

Level [amps] 250 i‘

Report Option
(¢ Report all dizcharges

" Report problem dizcharge anly
(" Dizabls

Low Overal Yoltage

M amirum Dizcharge Time

[valts) | 10.000 i‘
fwolts] | 400.0 i‘
[mirtes) 1 j‘

%]
Tire To Go
BOS-25E =412
Arp Hours i}
Peukert Mumber 0.000

j-'L LCloze |

=1 Send ‘

String Status: |Good

Communication Status: Polling System Status

Password: |OK

Figure 69. Battery Setup - Discharge (BDS)

Discharge Selections Area:

Enable - Select to let the monitor capture and store discharge data. If not selected, the

BDS does not log discharges.

Latch - When selected, the alarm contact stays energized until manually reset. If not
selected, the alarm contact de-energizes when the discharge condition clears.

Critical Alarm and Maintenance Alarm - Two alarm contacts are available. Select
Critical Alarm or Maintenance Alarm to define which contacts energize upon alarm. If
neither is selected, alarm reporting is disabled for discharge. These settings do not affect

bar graph colors.

Discharge Detection Method Area:
Select Voltage Mode or Current Mode, then set the threshold Level in volts or amps to
activate data logging during a discharge. When the voltage goes below the set level or the
current exceeds the set level, the monitor begins recording cell voltages, discharge
current, and overall voltage, based on the Deviation Storage Thresholds (described later).
Only one temperature sample is stored at the beginning of the discharge.
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Note: If using the Current Mode, the minimum threshold Level to detect discharges must
be at least 5% of the current transducer (CT) rating. For example, if the CT rating
is 600A, the minimum Level is 30A.

Voltage mode allows data recording during recharge, since data logging does not stop
until the voltage goes above the threshold. If measuring discharge current, use
Discharge Current Mode as a reliable source of trigger.

To enable current mode, you must define the Current Channel on Setup|Battery]|
Parameters in the DCM# column.

Report All Discharges - If selected, the monitor reports all discharges to the Central
computer. You must enable Remote Reporting on Setup|Battery|General.

Report Problem Discharge Only - If selected, the monitor reports only discharges that
exceed voltage or time values set in Problem Discharge Thresholds (described later) to the
Central computer.

Disable - If selected, stops the BDS from reporting a discharge.
Deviation Storage Thresholds Area - This feature does not apply to the BDS.
Problem Discharge Thresholds Area:

Low Cell Voltage, Low Overall Voltage, and Maximum Discharge Time - Select the
voltage or time levels that trigger discharge reporting. To enable these values, select
Report Problem Discharge Only on this screen. This setting also affects the bar graph
colors on the Cell Voltage String View screen. During a discharge, the bars change color:

NOrmal CoNAItION ........oviiiiiiieiie e Green
Problem Discharge Thresholds or Low Cell Voltage.................... Yellow

Time to Go Area:

The String View screen can display a Time to Go (TTG) number. When a BDS discharge
starts, the TTG box on String View indicates the estimated remaining time that the
battery can deliver power. To disable this feature, leave the Amp Hours and Peukert
Number boxes at zero.

IMPORTANT NOTE: The TTG Time to Go number is only an estimate.

Amp Hours - Type the amp hours of the battery at the 8 hour rating. To disable the
estimated time feature, set to 0.

Peukert Number - Type the Peukert number derived by using Peukert's equation. Refer
to Understanding the Time to Go Algorithm. To disable the estimated time feature, set
to 0.
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18.7. Battery Setup: Digital Input (BDS)

String View > Setup|Battery|Digital Input

The Digital Input dialog box is available only when connected to String 1 of the BDS-256
controller, as defined on Setup|System|String. The BDS has 16 digital inputs that may be
connected to external dry contacts. You may set up these inputs to report an alarm when the
external contacts are activated. An alarm can also activate the critical or maintenance relay on
the BDS. Not available for BDS-40.

Battery Setup @
General | Parameters | Test Parameters | Float hlarms] System] Discharge Drigital Dutput | LGS |
Input Mame NAC M0 Fieport Critical  Maintenance
Impuit 1: v I v v v
Inpuit 2: v I I N N
Input 3: v I v N N
Inpuit 4: v I I v N
Inpuit 5 v I I N N
Imput B [ I [ [ B
Input 7 [ I I B B
Ihput 2 [v |_ |_ B B
Input 9; v |_ v v v
Input 10 v I v v n
Input 11 v I v v v
Input 12: v I v v v
Input 13 v I v n v
Input 14: v I I v n
Input 15; [v I I n n
Input 16: [v I I n n
= Send ‘ j-'L Lloze ‘
String Status: |Good Communication Status: |Response OK Password: |OK

Figure 70. Battery Setup - Digital Input (BDS-256)

Input Name - Assign a name to the input connected to the external contacts and indicate if
the contacts are normally open or normally closed. To disable an input, clear the input name.

N/C or N/O - Select the N/C box if the external contacts are normally closed. Select the N/O
box if the external contacts are normally open.

Report - Selecting this check box lets the monitor report a digital input alarm. When not
selected, reporting is disabled for that input.

Critical and Maintenance - Two alarm contacts are available. Select Critical or Maintenance
to define which contacts energize upon digital input alarm. If neither is selected, the Report
check box clears and alarm reporting is disabled for that input. These settings do not affect
the bar graph colors.
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18.8. Battery Setup: Digital Output (BDS)

String View > Setup|Battery|Digital Output

The Digital Output dialog box is available only when connected to String 1 of the BDS
controller, as defined on Setup|System|String. Not available for BDS-40.

Note: Hardware failure — Latching should be enabled when using this trigger.

Battery Setup @

General | Parameters | Test Parameters | Float Alarms ] System ] Dizcharge | Digital Input t| LGS |
Output Mame Trigger Hame String # Enable Latch
Output 1: | |High Discharge Curent j hd r r
Cutput 2: | |High Dizcharge Current j hd r r
Output 3: | |High Dizcharge Current j t r r
Cutput 4: | |High Dizcharge Current j t r r
Dutput 5 | |High Discharge Current ﬂ h - -
Output 6 | |High Discharge Current ﬂ h r r
Output 7: | |High Digcharge Current ﬂ r r r
Output 8: | |High Discharge Curent ﬂ h r r
=1 Send ‘ j-'L LClose ‘
String Status: |Good Communication Status: |Requesting Cell Connection Password: | QK

Figure 71. Battery Setup - Digital Output (BDS-256)

The BDS has eight optional relay contact control outputs you can define to trigger on an
alarm event. After defining an Output Name and Trigger Name, the associated digital output
can change state on an alarm to control a user-selected device. If you select Latch, the output
latches. The relay is a Form C contact that de-energizes upon alarm condition reset.

Output Name - Type a name that describes the external device being controlled.

Trigger Name - From the drop-down list, select a parameter that energizes the
Control Output relay contact.

String # - The BDS Controller can have up to eight strings. In the String # box, select All or
the number that corresponds to the string number on System Setup|String.

Enable - Select Enable to energize a rear panel Control Output contact on a trigger event.
Latch - When selected, the Control Output contact energizes until manually reset. If not
selected, the Control Output de-energizes when the trigger event clears.

Note: For BDS setup, the system shows information based on string one only. If you have
more than one, they are defaulted from string one.
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18.9. Battery Setup: LGS (BDS)

String View > Setup|Battery|LGS

Leibert Global Services (LGS) offers a service in which its Customer Response Center (CRC)
remotely monitors your Alber BDS or MPM equipment and other facility devices around the
clock. The CRC evaluates alarms and provides immediate telephone and e-mail assistance
using a customer-defined response and escalation plan. For details about subscribing to the
service, phone (800) 748-3666 or (800) SITEMON or e-mail LGS.monitoring@vertivco.com.

If you have subscribed to an LGS monitoring plan, complete the Battery Setup|LGS dialog
box as follows.

Battery Setup _ @

General | Parameters | Test Parameters | Eloat.-’-\lalmsl S_I,lstem] Discharge | Digital Input | Digital O utput |—

System Type lunui (mx]
Site D |000CD (00000 - 93399

Manitor Device Number [000D00p (0000000 - 3333335

LGS Phare Mumber |

LGS Report Time |00:00 HH:bdkd

[ Enabled

=1 Send ‘ j-'LQIose |

String Status: |Geod Communication Status: Response OK Password: | QK

Figure 72. Battery Setup - LGS (BDS)

System Type - Type three characters to identify the device being monitored.
For MPM-100, type MPM; for BDS-256, type 256; for BDS-40, type 040.

Site ID - Type the five character ID for customer site identification.
Monitor Device Number - Type the seven digit number used for customer device tracking.

LGS Phone Number - Type the telephone number that connects to the LGS remote
monitoring service. This number is used for a daily communication test and alarm reporting.

LGS Report Time - Type the time the monitor calls in each day to confirm communication.
Use the 24 hour clock; e.g., 13:45.

Enabled - Check this box to enable remote monitoring by LGS. Monitoring is enabled only
after a monitoring plan has been purchased from LGS.
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19. Selecting the Database Range

String Status > Setup|Database Range

To select a database range before connecting to a location, select Setup|Database Range. The
Select Database Range dialog box appears.

== Select Database Range 2l x|
Fange
= Entire DB " Range Stark |12.-’2B.-"'| 949 "I End I 8A6/2002 YI ‘
+ Last Time Period ¢ Last 3 Manths " Last B Months " Other I3 3: taonths ‘
Save | Cancel |

Figure 73. Select Database Range
Entire DB - Select to view all available data in the string database.

Range - To view data within a range of dates, click Range then select Start and End dates. To
choose a date, click the date box drop-down button and click the calendar. To change months,
click the left or right arrows on the calendar or press the Page Up / Page Down keys. To change
years, hold the Ctrl key while pressing Page Up or Page Down.

Last Time Period - To select three or six months back from today's date, click Last Time Period
then select Last 3 Months or Last 6 Months. Select Other for other month periods and choose a
value. Close the dialog box to save the selections.

IMPORTANT NOTE: If no data appears on String View, select Entire DB to determine if data is
available.

Save - Clicking Save saves the selected range for all databases, not just the database currently
open. To close the dialog box without making any changes, click Cancel.
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20. Connecting to a Battery Location

This section describes how to connect the BMDM program to a location. At this point, the
computer and monitor should have been synchronized using Check Settings. You may connect to
an MPM or BDS battery location site via modem or network from a remote location or on-site
using the network or RS-232 Local port. These connection methods check all battery parameters.
If you cannot connect to a location, refer to Synchronizing Using Check Settings. If using a
Service computer, refer to the Service computer notes in the same section.

20.1. Connecting via Modem

[e=]]
Connection

Confirm Setup|System|Link is set for a modem connection. On the String Status screen, click
the string to which you want to connect, then click Connection to call the number specified
under Setup|System|Link. Upon connection, String View displays all real time data. If no data
appears, check the Setup|Database Range setting.

20.2. Modem Hang Up
Connection then Hang up El

When connecting via modem, sometimes you may want to disconnect before the BMDM
connects to the string. To stop modem dial out after clicking Connection, click the Hang Up
button on String Status or select Setup|Hang Up.

NOTE: If the BMDM connects and String View appears, closing the String View screen
disconnects the modem.

20.3. Connecting via Network

=
Connection

Confirm Setup|System|Link is set for a network connection. On String Status, click the string
to which you want to connect, then click Connection to connect to the IP address specified
under Setup|System|Link. Upon connection, String View displays all real time data. If no data
appears, check the Setup|Database Range setting.

20.4. Connecting via RS-232 Local Port

[e=]]
Connection

Confirm Setup|System|Link is set for a direct connection. On String Status, click the string to
which you want to connect, then click Connection. If the site has been set up, String View
displays all real time data. If the site was not set up, set up the new system.
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21. Viewing Battery and Monitor Status

At program start, the String Status screen lists all available monitor systems. The program can sound an
alarm, contact a pager, send a fax or email, or print alarm event details. When a monitor reports an alarm,
an alarm detail box appears until you acknowledge it. The String Status column on the String Status
screen lists the condition, and Update Date indicates alarm time. Historical Events displays the history
and details about the alarm. When there is a hew entry, click the flashing Historical Events button to
display the history. This chapter describes these screens.

F3 - Press the F3 key to toggle between the string, battery, location, and customer status screens.
There are two ways to view data from a battery: real-time and offline.

Viewing battery data in real time means having the computer connected to the monitor via modem,
LAN, or an RS-232 cable. After communication is established, String View displays the real time
readings.

Viewing data offline means viewing data removed from the monitor and stored in the computer database.
To view data offline, highlight the site on String Status, then select View|Offline. String View displays
data for the site. No voltages are displayed because the system is offline and not connected to the site.

IMPORTANT NOTE: If no bar graph data appears on String View, go to the menu bar on String Status,
click Setup|Database Range, then select Entire DB to determine if data is available.

21.1. Opening and Saving a Database

B2
String Status > Open El or File|Open

At start up, the BMDM opens the previously opened database. To open another database, select Open,
highlight the desired database, and click Open. You do not need to close the currently open database
before opening a new one.

String Status > File|Open Backup

The Open Backup selection works the same as Open. When the program opens an Access backup file,
it converts it from a ZIP to an MDB file.

String Status > File|Save As

String Status > Backup database —1 or File|Backup Database

To save an Access database as an MDB database file, select File|Save As. To save the database as a
backup, select File|Backup Database, which saves the MDB file as a ZIP file. Refer to Understanding
Polling, Extraction and Backup.

String Status > Close El or File|Close
String Status > File|New

To close a database, select File|Close. To create a new database, select File|New.
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21.2. String Status Screen

At start-up, the BMDM displays the String Status screen. The first time the program runs, no strings
are listed. The communication and status fields summarize the polling status, string and location
names, connection status, and errors.

?‘__'Battery Monitor Data Manager for Central Computer : sample-nw setup for 2vaz.MDB o IEllil

File Setup View Reports Sort Help

2| =| B Beelsl =w #g

Paszword Active Strlng Status
String 1D | Cush Name | Location Mame | Battery Name | String Name | String Status | Monitor Status | Update Date/Time |;|
| | 1 ALEERCORP BOCA RATOM LAR BATTERY <40 STRING 1 Unknown Metwork Error F/21/2004 12:38:03 PM _I
» 4LBERCORP BOCARATON LAE  |BATTERY %40 STRING 2 [Unknown  [Metwark Error 7/21/2004 25 PM
3 ALEERCORP BOCA RATOM L&R BATTERY &40 STRING 3 Unknown Metwoik Error T421/2004 12:05:43 PM LI
|P0\Iing Site |Cust0mer: | |L0cati0n: | |Battery: | |Str\ng: |

| Communication Status: |idle | Sort: |L|:|catic|r| Mame |Mudem Status: |

Figure 74. String Status

String Status has up to eight columns that indicate the status of each string: String 1D, Customer
Name, Location Name, Battery Name, String Name, String Status, Monitor Status, and Update
Date/Time. The columns are updated every time the monitor reports status, you manually call a
location, or during polling. You can hide the String ID, Customer Name, Location Name, and Battery
Name columns using Setup|Preferences.

String ID - The string ID is needed only if using a pager. When a page is issued, the numeric
message includes the string ID, which indicates the string in alarm condition.

String Status - The String Status column reports six conditions on the Historical Events screen, no
priority assigned, and eleven on the String Status screen, each assigned a priority. For example, if
conditions Alarm and Warning exist, when the monitor calls, it reports Alarm because Alarm has
higher priority than Warning. However, Warning is not lost. When you acknowledge and reset Alarm,
the Warning status appears on disconnect.

Priority Status Meaning
1 Acknowledge When acknowledge function is enabled, indicates an event has occurred
that must be acknowledged, either through the program or by pressing
the reset button.

2 Names do not match Location, battery or strings names do not match between the hardware
and database.

3 Names need to be set up Location, battery or strings names are not programmed into the
hardware.

4* DCM Com Error Communication error between DCM and BDS Controller.

5 Discharging The battery is in discharge.

6* Unknown The system has not yet been called. (New string entry.)

7 Discharge Occurred Battery discharge occurred.

8* Alarm A battery parameter violated an alarm threshold.

9* Warning A resistance reading violated a warning threshold.

10*  Alarm Disabled Alarm Disabled in Battery Setup.

11 Good System within normal parameters.

* also appears on Historical Events screen.
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Monitor Status - The Monitor Status column can report ten conditions, which do not have priority
ratings assigned.

Status Meaning
Invalid Data Data received from the monitor was corrupted.

Check Hardware Monitor reported a hardware failure. Items checked are described
in Diagnostics - Self Test.

Network Error ~ Cannot connect or cannot initialize.
No Dial Tone No dial tone detected when calling.
Monitor Busy Busy signal detected when calling.
Modem Error Modem cannot be initialized.

Inactive Monitor did not answer. This could be hiding a problem. With no response, assumes the
monitor is inoperative. For no dial tone or a busy line, attempts to poll a second time.

Active Monitor answered. No problems reported.

Data Corrupt After connecting to the monitor, you must click Clear Data Memory
on Diagnostics|Memory.

Comm Error During autopolling, if computer cannot establish communication after three tries, this
message appears.

Line Busy The phone number the modem dialed is busy.

No Answer The phone number the modem dialed did not respond.

All conditions except Active produce an Unknown in the String Status column.
Update Date/Time - The date and time the status was delivered.

String Status > Sort|column name

The String Status screen sorts on String ID. To sort on a different column, select Sort then the column
name, or click a column header. To move columns, click and drag a column header onto another
column header.

String Status > Right click a string name
or String Status > View|String in Alarm or String in Discharge or String in Inactive

Skrings in &larm
Skrings in Discharge
Strings in Inactive
Extrack Data

Right click on a string name on the String Status screen to
display a pop-up menu. Click Strings in Alarm, Strings in
Discharge or Strings in Inactive to display a list of the selected
category. The Strings in Alarm screen is shown below. The

3ek String Stakus . A . . . . ..
Strings in Inactive and Strings in Discharge screens are similar.

Acknowlege Alarm

Figure 75. String Status Viewing Selection

:-'-'-—‘T'Strings in Alarm

| | ___Stiing Name __| __Sting Status _|

STRING 3

Monitor Status Update Date

3419/2004 10:21:35 &

A

Alarm Active 3/19/2004 10:21:56 AM
Alarm Active 3418/2004 1:21:04 P LI
j-'L Cloze

Figure 76. Strings in Alarm
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String Status > Extract all data or String Status > Right click a string name | Extract data

The Extract All Data button and the Extract Data item on the pop-up menu are enabled if

Auto Extract Data is selected and Disable Auto Polling / Auto Answering is not selected on
Setup|Communication. The Extract All Data button polls all strings listed on the screen. Extract Data
polls only the string highlighted. In both cases, the BMDM gets the string status and alarm events and
extracts the voltage float data, resistance data, and discharge data.

String Status > Call all modem strings ﬁl or

String Status > Right click a string name | Get String Status

The Call All Modem Strings button and the Get String Status item on the pop-up menu are enabled
if any string is connected via modem and Auto Extract Data is selected and

Disable Auto Polling / Auto Answering is not selected on Setup|Communication. The

Call All Modem Strings button polls all strings listed on the screen. Get String Status polls only the
string highlighted. In both cases, the BMDM gets the present string status and alarm events, but does
not extract data.

String Status > Right click a string name | Acknowledge alarm

You may acknowledge alarms three ways. One way is to right click the mouse on the String Status
screen and click Acknowledge Alarm on the pop-up menu. Refer to Alarm Acknowledge for details.

21.3.Report Alarm Event Screens

String Status > Show all alarm events

There are four dialog boxes that appear on String Status when an alarm event occurs: Report Alarm
Event, Print Report Alarm Event, Fax Report Alarm Event, and Page Report Alarm Event. If there is
an alarm condition, the Report Alarm Event box appears during polling.

Report Alarm Event x|
I 2 o I 4 4 | 4 | Delete Delete All
String Mame: STRING 2

Battery M ame: BATTERY 240
Location Mame: BOCA RATOM LaB

Ewvent Type:

String Status: Unknown

b onitor Stabus: Metworl, Ermor
DateTime: 07421/04 120526

Figure 77. Report Alarm Event

The Print, Fax and Page Report Alarm Event boxes appear only if Print Alarm Event, Fax Alarm
Event or Page On Alarm are checked on Setup|System|Reporting and Disable Alarm Reporting on
Setup|Preferences is not checked. To stop the audible alarm if enabled, click Silence. Click Delete to
remove the currently displayed alarm. Delete All removes all displayed alarms. The print, fax, and
page event boxes close after the printer, fax machine or pager receives the alarm.

Clicking Show All Alarm Events displays the Report Alarm Event dialog box. You may view all
events by clicking the left or right arrows on the box.
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21.4. Summary Screen

String Status > Summary g or View|Summary

The Summary dialog box displays a status summary of the battery sites. Click the Summary button to
display this box.

= Summary ;lﬂl il

Total Stings: 10

rString Status
Good:
W arning:
Alarm:
Alarm Dizabled:
Dizcharging:
Digcharge Ooccuned:
LCH Comm. Ermar:
ko

oo oo o Mmoo L

— Monitar Status
Achive:
Inactive:
Check Hw!:
Urknown:

o o = 0w

Figure 78. Summary (Battery Sites)

21.5. Historical Events Screen

String Status > Historical events ﬁl or View|Historical Events

Note: View Alarm has a ringing clock ﬁl

When a new event is added, the Historical Events button flashes. Select Historical Events to display
the Historical Events screen, which lists reported events and the history of one or all strings. You may
click the column header to sort on the column. To move columns, click and drag a column header
onto another header.

String Status > View|Historical Events|View|Single String

To view a single string, select Single String on the Historical Events screen. On the Input Dialog box,
choose a string name from the drop-down list, then click OK. The screen displays all the historical
events for the selected string.

= Historical Events =10l x|

Edit  Wiew Sort

String 1D | Customer Name | Battery Name String Mame String Status Alarm Detail Monitor Status Date/Time
2 A4LBERCORP BATTERY 840  |5TRING 2 Alarm Low Temperature 1 Alaim 3/15/2004 5:33:00 P
ALBERCORF EATTERY 8<40  STRING 2 High Temperature 2 Alarm Active 3/10/2004 8:53:03 PM
ALBERCORP BATTERY 840  STRING 2 Alaim Low Cell Yoltage Alam at Cell 37 | Active 3/2/2004 51211 PM

ale L D

Wigw: |A\I Strings Sork; |Str\ng Mame (&)

Figure 79. Historical Events
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Alarm Detail - A computer polling or receiving an alarm call from a monitor receives and displays
this information if:

Remote Reporting options are enabled under Setup|Battery|Float Alarms,
Remote Reporting is enabled on Setup|Battery|General,

Report Option is not disabled on Setup|Battery|Discharge, and

Disable Alarm Reporting is not checked on Setup|Preferences.

The Alarm Detail column can report the following conditions, which do not have priority ratings
assigned.

High Cell Voltage at String n, Cell n High Intertier Resistance n
Low Cell Voltage at String n, Cell n Discharge

High Resistance at String n, Cell n Digital Input n

High Intercell Resistance at String n, Cell n UPS Low Voltage

High Overall Voltage UPS Line Fail

Low Overall VVoltage Pager Busy

High Float Current Pager Error

Warning at String n, Cell n Pager Fail

High Temperature n Unknown

Low Temperature n Inactive

21.6. String View Screens

=]
From String Status, click Connection to display the String View screen.

String View > Cell voltage or Cell resistance or Intercell resistance

From the String Status screen, highlight the location name, then click Connection. After
communication is established, the String View screen appears. The title bar displays S, B and L for
string, battery, and location names. This chapter describes features common among the Cell Voltage,
Cell Resistance, and Intercell Resistance screens, which are accessed by clicking the tabs. The
Intercell Resistance tab appears for a BDS only after you request a resistance test.

|S:STRING 3 BrBATTERY 13248 L:BOC | -q| >

To open a different string, choose a string name on the drop-down list or click the arrows on String
View. Only MPM and BDS strings with the same phone number appear in the list. MPM strings with
a MUX setting of zero do not appear.

String View > View|Undo Zoom

To view the level of an individual cell, refer to Cell Voltage Box. To perform a trend analysis, refer to
Trend Analysis. To zoom in on the bar graph, place the cursor over the bars and drag a rectangle over
the area of interest while holding the left mouse button. To restore to original size, click Undo Zoom.
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21.7. Cell Voltage (String View Screen)

String View > Cell voltage (default)

The String View Cell Voltage screen bar graph shows the voltage of each cell or module within the
battery. A readings summary appears at the bottom. The cells with the maximum and minimum
values are indicated as Max(n) and Min(n). If current channel and temperature transducers are
installed, these readings also appear. If you click a bar on the graph, the cell voltage value appears in
the box near the top left.

== Network Connection to 5:5tring 1B, B:UPS Mod1 - 400KYA, L:Boca Raton Lab =] x|
File View Setup Disgnostics
élalla:__;‘ gi| = [sstinutaEURs wort —anokva e <] | ResiStance gran| stop| Get
Cel Vottage (¥) | cellResistance |
l— Cell Woltage )
L e T T T TP
L e e e e P e e e e e P L R LR P T R E
134+
124+
11+
10+
= n o ow owom z » » nn wox o n w
e e e e e T e e e e ] 1
TTG= 0000524 Discharge Duration: [000:01:59
Cell Voltage () Cther Parameters
Temperature 1 (F): g4 Tempersture € (F). i}
Max (40): 13300 | | Overall Votagie (X 5337 Tomperstyre 2 I Temvercture T (F) 0
Min (4) 13,280 Discharge Current (A 185 tomperature 3 (F: 0 Temperature 8 (F) il
X Temperature 4 (F1: 0 Temperature 9 (F): 0
Srerager 13285 Temperature 5 (F1: 0 Temperature 10 (F) n
String Status: |Discharging Communication Status: \Rasponsa oK Password: |0K

Figure 80. String View - Cell Voltages (MPM shown)

Clicking certain text in the lower portion of the String View screen displays screens related to the
item clicked. For example, clicking Other Parameters - Overall VVoltage displays the Overall Voltage
Trend screen.

If the Peukert number is enabled for the MPM under Battery|Setup|Discharge, the screen displays
the TTG (Time to Go) and Discharge Duration boxes. During discharge, TTG gives an estimate of
the discharge time remaining, based on user-entered data. Discharge Duration indicates the time that
has elapsed since the start of the discharge.

IMPORTANT NOTE: The TTG Time to Go is only an estimate.

When in discharge mode, if a cell goes negative, the respective bar on the bar graph is displayed in
black.
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The String Status box on the bottom left of the String View screen can report nine conditions.

Priority Status

1 DCM Com Error
Discharging
R-Test in Progress
Calibration in Progress
Check Hardware

a1 B~ W DN

Discharge Occurred
Alarm

Warning

Good

©O© 0 N o

Meaning

Communication error between DCM and BDS Controller.
The battery entered a discharge.

Resistance test in progress.

Monitor reported a hardware failure. The items checked are
described in Diagnostics — Self Test.

A battery parameter violated an alarm threshold.
A resistance reading violated a warning threshold.
System is within normal parameters.

21.8. Cell Resistance and Intercell Resistance (String View Screens)

String View > Cell resistance or Intercell resistance

You may automatically read internal cell resistance and intercell resistance by setting a timer under
Setup|Battery|Test Parameters, or you may start the test from the Cell Resistance screen. The BMDM
reads cell and intercell resistance at the same time. The Intercell Resistance tab (BDS only) appears
after the BMDM performs a resistance test. An intercell reading option is required in the BDS.

The Cell Resistance and Intercell Resistance screens display bar graphs. Click the Cell Resistance tab
to transfer resistance readings from monitor to computer. It may take a few seconds for the bar graph
to appear. If readings are available, the BMDM displays the latest set and saves them to the database

with the date and time taken.

“FNetwork Connection to S:5TRING 9, B:BATTERY 1X244, LIBOCA RATON LAB i i [ |

Eile Wiew Setup Diagnostics

P ] 1| [s:sTRiNG 9 B:BATTER Y 1%248 LBOC v| wf| | Date [i2coos 1201250 Resistance oo stop| Get ‘

Cell Voltage (v) Cell Resistance |

—

Resistance (microhms)

2500

2250 -]

2000 {---|

1750 1---|

1500 {---|

Call # 1 2 3 a5 & 7

9 10 M Mz 138 14 15 e 17 18 19 20 & 2 2 24

Subset 1| 2931 137 37 43 1374 3016 2086 1397 I8 16T 1999 1695 1385 1149 2192 D360 19 1984 238 19 I3 aies e s

-string 1 Intertier Feesi (microhms)
M (4): ga || ntertier R4 (1, 12) .
hin (12) 1835
Average 2278

String Status: [Alarm Communication Status: [Response OK Password: Lnchecked

Figure 81. String View - Cell Resistance (MPM shown)
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Stop| Get

. . . . Start
String View > Start resistance test or Stop resistance test or Get test results

To start a resistance test and capture new readings, click Start. After the Test in Progress message
disappears, the monitor Resistance Test LED goes out and the Get button becomes active. Click Get
to display the readings and transfer them to the computer. The bottom of the screen summarizes

resistance and intertier values. Intertier cells are indicated in black. To stop the test before
completion, click Stop.

[ Network Connection to 5:tring F-1, B:UPS F, LIBOA Yilla Park

i o [a] B3]
File Wiew Setup Diagnostics

28| @ ﬁl [S:5ting P BUPS F LEDA Vil Pak v| of| o Dote prannor 120000 of| | 5508 10 s10p| Ger

CellValtage (V)| Cell Resistance  Intercell Resistance: |

Intercell Resistance {microhms)

- 44 Interler R 6 (Cell 192)
2(Cel52) 45 Interter R 7 (Cell 232) »
Min (178) 5 3(Cel 34) 34
Average || ntetieri 4 Eceu 129: 3

Intertier R 5 (Cell 150) 29

String Skatus: [Alarm Disabled

Comrnunication Status: [Respanse OK Passward: [Unchecked

Figure 82. String View - Intercell Resistances (BDS only)
To view the Intercell Resistance bar graph, click the Intercell Resistance tab.

Clicking Start when using a BDS selects all DCM's for testing. For troubleshooting, you may select

Diagnostics|R-Test in a DCM and choose which DCM's to resistance test. Refer to Resistance Testing
Multiple DCM Units.
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21.9. Historical Graphs

String View > Cell voltage or Cell resistance or Intercell resistance

When the BMDM is displaying a String View Cell Voltage, Cell Resistance or Intercell Resistance
screen, you may save or view historical graphs.

En
String View > Save history record ﬁ or File|Save history record

Save History Record - To save a history record of the graph and table values on the String View
screen, click Save History Record. This captures the readings, stamped with the date and time taken.

:"_‘f Network Connection to S:BDS-40 1X40X12V, B:30KVA UPS, L:Pompano Beach, FL

File View Setup Diagnostics

Save history record - - F—
Extract history BDS-40 1400 2% B.3DK\/Aﬂ o > Stop|| Get |

Open istance |

e Cell Voltage (V)
Extract All g

Ewort (i)

Resistance

Figure 83. History Options and Record Date/Time Box

B
String View > Open history record EI or File]|Open

Open - To display a historical graph and table on String View, click Open History Record, select a
date/time, and click OK. The graph and table appear, with the historical record date/time box at the
top right of the screen. You may step through historical records by clicking the left or right arrows.

String View > File|Close

Close - To close the history record and return to the active String View screen, click Close. (Do not
click the X on the upper right corner.) The historical graph, record date/time box, and left/right arrows
close.

String View > File|Extract History then (optional) File|Open|date then File|Close
Extract History - Click Extract History to have the computer extract historic float data for the string

the computer is polling. To view the extracted data, click File|Open and select the date. If a date is not
listed, no new data was extracted on that date.

String View > File|Extract All then (optional) File|Open|date then File|Close

Extract All - This function is similar to the Extract All Data button on String Status, except String
View is displaying an active connection. Click Extract All to extract historic float data, resistance
data, and discharge data for the string being polled. To view the extracted data, click File|Open and
select the date. If a date is not listed, no new data was extracted on that date.
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String View > File|Export (xIs) then History

The Export History (Voltage) function allows you to export resistance data by date and time. To
export history on resistance, from the main menu, click File, Export (xls) then History. The Select
Date/Time window appears to select the date and time of the data to be exported. The file will be
exported and saved to the following default folder: .. \Albe\MPM Manager\Export\History BDS-40
with the string configuration and the month, day, year and time. (for example; History_BDS-40
1X40X12V_02_06_12 08 _15 00_am.xls). Click OK to export the file.

String View > File|Export (xIs) then Resistance

The Export Resistance function allows you to export resistance data by date and time. To export
history on resistance, from the main menu, click File, Export (xls) then Resistance. The Select
Date/Time window appears to select the date and time of the data to be exported. The file will be
exported and saved to the following default folder: .. \Alber\MPM Manager\Export\Resistance_ BDS-
40 with the string configuration and the month, day, year and time. (for example; Resistance_BDS-40
1X40X12V_02_06_12 09 _45 00_am.xls). Click OK to export the file.

21.10. Cell Voltage Box

String View > Click a bar on the graph or Alt + Click a bar on the graph

To display the numerical value of an individual cell on the String View Cell VVoltage screen, click a
bar on the graph. The cell voltage value appears in the box near the top left. To display the Cell
Voltage box, hold the Alt key while clicking a bar. The Cell VVoltage box opens to the right of the bar
graph.

String| Cell | “oltage I

.................................... 1 9 2.246
1 14 2.349
------------------------------------ 1 1 2.357
1 4  2.357

[ T N O - - L
sva ima ime mm ame e 3w zm |y Close | Delete | Clear |

Figure 84. Cell Voltage Box

You may create a list of cells in the Cell VVoltage box and monitor the continually updated voltages.
This is convenient when monitoring a discharge. To add cells to the list, hold the Alt key and click a
cell bar. To sort the list, click the String, Cell or VVoltage column header. To remove a cell from the
list, click the cell listing to highlight it, then click Delete. To remove all cells from the list, click
Clear. To close the box, click Close.

21.11.  Trend Analysis

String View > Click a bar to make it gray; right click the bar; Trend|Cell or Average

To perform a voltage, resistance or intercell resistance trend analysis for a cell, click a bar of interest
on the graph to change it to gray, then right click the same bar to display a pop-up menu.
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i & § N 8§ & §
| I I

Zell Memo Average

araph or Table »
B Maximize

Unda Zoom

Figure 85. Trend Menu

On the pop-up menu, click Trend then Cell or Average to display the trend analysis graph. If the
trend analysis box has active Previous/Next Parameter arrows, you may click them to view other
cells. All trend analysis screens have a Print button.

Y =] 9
4 » I™ yeraad
Cell Valtage Trend (Cell 1)
Location: Pompano Beach, FL - Battery: BDS Test System 2 - String: BD3-40 1340X12V

T R i i il ..

L e EIGCRECEEEEELEP R PR
=)
L
=
L T T T T R T T
e
T R

L R EaGGRECEEEEEL LR PR e

e e = e e e e e e

| | | | | | | | |
Mar Apr May Jun Jul Aug Sep ot Moy Dec
2006 Date £ Time
Maximum (2/17/20062:50:26 PM]: 1359 [~ Graph Scale Control Enabled
Average: 1343 j'l_ Close | 2 Print | bl |_J— hin
Minirurm [10417/200610:01:00 &4M) : 1266

Figure 86. Trend - Cell VVoltage (Typical of all Trend screens)

To use the Graph Scale Control to vary the y-axis scale on the graph, click the Graph Scale Control
Enabled check box. This keeps the y-axis the same when viewing other cells. To determine a data
point numerical value (in volts or ohms) and date and time for an event on the graph, click a dot on
the graph. The value appears on the upper left. Right click a graph to change display features, such as
font size, shadows, numeric precision or grid. The Average check box averages the readings.

21.12. Alarm Data

String View > View alarm ﬁl or View|Alarm

The MPM or BDS monitor constantly checks threshold values set under Battery Setup. As long as
alarms are enabled, the monitor creates a record of thresholds violated. Click View Alarm to display

alarm screens.
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String View > View alarm ﬁl or View|Alarm then, if not displayed, Get current alarms &I or
View|Current Alarm

The Current Alarms screen indicates Active or Latched for the alarm contacts. Active indicates a
parameter is presently violating a threshold. The screen displays the alarm name and start time.
Latched indicates the parameter returned to normal, but the alarm relay must be reset. The end time
indicates when the alarm event changed to a latched state. Peak Value lists the highest or lowest value
reached during the event. For latch to function, enable the latch under Battery Setup for each
parameter. If latch is not selected, the alarm contact de-energizes when the parameter returns to
normal. A record of a present alarm is saved as a Current Historical Alarm.

= Current Alarm =10l x|

File  Wiew
E ﬂ ﬂ H E Tatal Alarm Mumber: 44

Alarm Name

u Dizcharge
l High Resistance 1 14 Active
l High Resistance 1 2 Active TA2/2004 12:01:25 Ak 2200

String Status: [Alarm Communication Status: |Respnnse oK Sort: |

sl L D

Figure 87. Current Alarm List

String View > View alarm ﬁl or View|Alarm then Reset alarm EI or View|Reset Alarm

When you select Alarm, active or latched alarms in the monitor are retrieved. These alarms stay
active until the condition clears or you click Reset Alarm. However, if you click Reset Alarm and the
violation still exists, the alarm reappears in the Current Alarm list.

String View > View alarm ﬁl or View|Alarm then Get current historical alarms El or
View|Current historical alarm

The Current Historical Alarm screen displays alarms that reset or cleared on their own and were not
set to latch. Select Current Historical Alarm to retrieve the alarms still in monitor memory. Normal
indicates the alarm returned to a valid value on its own. No reset date or time is displayed. If an alarm
exists and it is reset, an entry is created in Current Historical Alarms at the reset time, and a new
alarm is created because the alarm condition still exists. Reset indicates a latched alarm was reset.
The reset date and time column indicates when the reset occurred. Peak Value lists the highest or
lowest value the parameter reached during the event. When you select Current Historical Alarm, data
is transferred from the monitor to the database and saved under Historical Alarms. If you select
Current Historical Alarm using a Central computer, the current history data is permanently removed
from the monitor.

String View > View alarm ﬁl or View|Alarm then View historical alarms ﬂ or
View|Historical alarm

The Historical Alarm screen shows a history of alarms transferred to the computer database using
Current Historical Alarm. Select Historical Alarm to display a list of alarm events that pertain to the
battery and are saved in the database.
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= Historical Alarm =10l x|
File  Wiew
| @l Gl Hl ﬂ.;—': nl Total Alarm Mumber: 107
Alarm Name String| Cell Status Start Date/Time End Date/Time Reset Date/Time Alarm Level | Peak Yalue ;I
charge £21/2003 11:04:10 P11/ 3 3:51:53 AM 03 9:51:53 AM

l Discharge Mormal B/2/2003 8:47:54 Ah —I
l High Cell Voltage 1 4 Marmal 242004 12:31:46 Al 741272004 1:55:11 &M 2350 2433 LI
String Status: |Alarm Communication Status: [Response OK Sort: [alarm Mame (&) i

Figure 88. Historical Alarm List

. -
String View > View alarm ﬁl or View|Alarm then Select historical alarms ﬁ or View|Selection

If any alarm records exist, select Selection to display the Historical Alarm Selection dialog box, then
choose alarm filters, such as All Dates or Selected Types, so only alarms of interest appear.

String View > View alarm ﬁl or View|Alarm then File|Delete or File|Delete All

To delete an alarm from the database, highlight the alarm line, then select File|Delete. To delete all
alarms for the string, select File|Delete All. If the Historical Alarm list is filtered using the Historical
Alarm Selection box, selecting Delete All will delete all alarms in the database, not just those listed
on the screen.

== Historical Alarm Selection 10 x|
 Alamn Date ——————————————— 1 ~ aAlam Type
= Al Dates Al Types

{* Selected Types

¥ High Owerall Yalkage
Starting D ate W Low Owerall Yoltage
Iwi’ ¥ High Cell Valtage
W Low CellVoltage
Ending Date ¥ High Temperature

. W Low Temperature
I /472004 ﬁ W High Resistance
v High Intertier R esistance
W Digital Input
¥ High Float Current
¥ High Intercell Resistance
W Dizcharge
v UPS Low Yaltage
W UPS Line Fail

f* Selected Dates

j'LQK | x Cancel |

Figure 89. Historical Alarm Selection
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21.13. Alarm Acknowledge

String View > View alarm ﬁl or View|Alarm then Acknowledge alarm il

If the alarm acknowledge options are selected on Setup|System|Reporting and Setup|Battery|General,
the Acknowledge Alarm button appears on the Current Alarm screen, and, to indicate an alarm event,
the String Status screen displays Acknowledge in the String Status column. You may acknowledge
alarms three ways:

1. Press the alarm reset button on the MPM or BDS monitor, or
2. On the Current Alarm screen, click the Acknowledge Alarm button, or

3. On the String Status screen, right click the mouse and click Acknowledge Alarm on the pop-up
menu.

21.14. Discharge Data

String View > View load test or View|Load test

String View > View discharge EI or View|Discharge

Click Load Test (MPM only) or Discharge to display the All Load Tests or All Discharges screens,
which list records of load tests or discharges for the connected string. View Load Test lists discharges
detected by user-programmed tests. View Discharge lists automatically detected discharges. If String
Status on the bottom left of the String View screen indicates Discharging, Logging Discharge Data or
R-test in Progress, View Discharge and View Load Test cannot be selected.
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Low Cell Threshald I 1.343 Voltage ::E;’2D.-’2:D:D2D i ; :::::: i
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Figure 90. All Discharges (MPM shown)
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The BDS and MPM All Discharges screens are similar, except the MPM screen has the
MPM Current to Include in Report selection. The View|Load Test and View|Discharge screens are
the same, except View|Load Test has the Start, Stop and Get buttons available.

Report Interval area - Click Time or OV Deviation and type a value in the box. The Report Interval
determines the frequency of report sampling. If Time is selected, replay time advances in increments
measured against real-time. For example, if 00:10 is entered, playback advances 10 seconds every
second. If Overall Voltage is selected, playback advances each time the voltage changes. For
example, if 0.1 is entered, playback advances each time a 100mv deviation in overall voltage occurs.
Specify time in hours, minutes, and seconds (10 second minimum) or OV (overall voltage) deviation
in volts (0.2 volt minimum).

Click Use Preset Thresholds to use values set in the BMDM program when the test was run.

Click Override Preset Thresholds to ignore BMDM thresholds, then type values in the Low Cell
Threshold and Low OV Threshold boxes to identify cells that exceed critical levels. Any
measurement below these values will be in violation.

Graph Scaling area - Click Auto to default to automatic graph scaling, or click Manual and type
the Max and Min graph scale values. Use Manual scaling when you want to maintain scaling to make
it easier to compare several graphs.

Select Auto Select to automatically select cells listed on the right side that violate the thresholds. If
you change the cell or OV thresholds, cells that meet the new criteria are selected. You may add cells
to the report by selecting additional check boxes in the list.

Select String Memos and Cell Memos to include string and cell memos.

Select Include Power to list power in reports, in addition to voltage and current.

Select Standard to create a standard report. Cells are listed by string, and strings are listed by time in
a Cell = Value format.

Select Tabular to create a tabular report, which is the same as a standard report, but in a spreadsheet
format, with Cells vs. Time.

Click Cell Graph to create a report that includes a cell graph.
Click Cell Detail to create a report that includes cell detail.
Click OV/I Graph to create a report that includes Overall Voltage and Load Current graphs.

MPM Current to Include in Report (MPM only) - Choose up to four current channels Current 1 to
Current 4 to view simultaneously if they are connected.

The Discharge Dates columns list the Start Date/Time, Duration, Lowest OV, OV@30 and
ACV@30 of all discharges. The Lowest OV column lists the lowest value reached during discharge.
OV@30 lists the overall voltage 30 seconds into discharge, and ACV@30 lists the average cell
voltage 30 seconds into discharge. Click the discharge for which the report will be generated. Only
one discharge date may be selected for a report.
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Cell Detail area - To manually select cells to include in the report, click the cells in the list or click
All to select all items. If Auto Select is selected, cells that violate thresholds are already selected. To
clear all selected items, click None. If more than one subdirectory of cell data is available, tabs for
each subdirectory appear above the list of cell names.

After all options are selected, click the Preview button to create a report and display it on the Preview
screen. Refer to Using the Preview Screens.

Adjust the Replay Speed slider to have a replay run faster or slower. You may do this while the
replay is in process.

Get

. . . . Stop
String View > Start resistance test or Stop resistance test or Get test results |

If View|Load Test was selected, to start a load test and capture new readings, click Start. After the
Test in Progress message disappears, the Get button becomes active. Click Get to retrieve the
readings and transfer them to the computer. To stop the test before completion, click Stop.

If View|Discharge was selected, to retrieve new discharge readings, click Get to display the readings
and transfer them to the computer. You cannot start a discharge test from this screen.

Options selected on the All Discharge screen are saved by the battery name.
After selecting a discharge from the list by clicking it, you can perform two types of analysis. Click

Discharge Replay to play back the discharge. Click Discharge Curve to display line graphs of up to
three specified parameters.
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21.14.1. Discharge Replay

String View > View|Load test or Discharge then Discharge replay El

or View|Discharge Replay

Click the Discharge Replay button to display the Discharge Replay screen, which shows the
variations of cell levels over time.
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Figure 91. Discharge Replay

Play Buttons: Show First, Show Previous, Show Next, Show Last, Replay Backward,

Replay Forward and Stop

The play buttons are at the top of the screen. Click Replay Forward to play the discharge. The
display advances either by time or voltage at the rate selected. Move the Replay Speed slider at
the upper right to increase or decrease replay speed.

You can click a point on the lower graph or move the Change Elapsed Time slider at the lower

right to cause the bar graph to display the cell voltages for the time selected. The Duration, Time
Interval, Overall VVoltage, and Current are indicated above the slider.
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Discharge Curve

Viewing Battery and Monitor Status

String View > View|Load test or Discharge then Discharge curve El or View|Discharge Curve

Click Discharge Curve to display the Discharge Curve screen, which shows the relationship of
the Overall VVoltage, Discharge Current, and Cell VVoltages on a graph.
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Figure 92. Discharge Curve

Play Buttons: Show First, Show Previous, Show Next, Show Last, Replay Backward,

Replay Forward and Stop

The play buttons are at the top of the screen. Click Replay Forward to play the discharge. The
display advances either by time or voltage at the rate selected. Move the Replay Speed slider at

the upper right to increase or

decrease replay speed.

You can click a point on the graph or move the Change Time slider on the bottom to display
readings for the time selected. The Overall VVoltage, Cell Voltage and Discharge Current values

are to the right of the graph.

String View > View|Load test or Discharge then View|Discharge Curve|Option|Curve Option
On the Discharge Curve screen, select Option|Curve Option to display the Curve Option dialog

box, which lets you select up

to three parameters for viewing.
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Figure 93. Curve Option

In Curve 1, 2 or 3, select Overall VVoltage, Discharge Current or Cell VVoltage curves. If you select
Discharge Current, choose a Current (for string) 1, 2, 3 or 4 from the drop-down list. The MPM
has strings 1 to 4 available; the BDS has only string 1.

If you select Cell Voltage, choose a string and cell number. If an invalid current, string or cell

number is selected, the area appears on the Discharge Curve screen, but no curve is displayed. If
you select None in Subset 2 or 3, the area does not appear.

21-20



Viewing Battery and Monitor Status

21.14.3. Summary

String View > View|Load test or Discharge then Summary g or View|Summary
Select Summary to display the Summary screen.

= Summary 10| x|
File Wiew Option
ﬁ‘tl El gl zl Get |'/| /| |\| N| E‘| E“ E‘l Replay Speed
String Mame: STRING 9
Starting D ate: E/1./2004 Cells Below Threshald
Starting Time; 08:32:02
Ending D ate: 64172004 - -
-
Ending Time: 0Ra0e Mo. | StingMo. | CellMao Time j
Druration: 00:00:06 1 1 00:00:00
Lowest 0% [Valks] : 497 z 1 2 00:00:00
3 1 3 00:00:00
4 1 4 00:00:00
5 1 5 00:00:00
B 1 [ 00:00:00
7 1 7 00:00:00
8 1 3 00:00:00
=]
String Status: Communication Status: |Unknuwn v

Figure 94. Summary (Discharges)

This screen summarizes the following information.

The String Name selected on the String Status screen.

The Starting Date and Starting Time the discharge or load test began.
The Ending Date and Ending Time the discharge or load test stopped.
The Duration of the test.

The Lowest OV (Volts) reached during the discharge or load test.

If any cells went below the threshold level during the test, Cells Below Threshold displays a
table that lists the String Number, Cell Number, and Time the cell went below threshold.
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21.15.  Cell Memo / String Memo

Cell Memo or String Memo saves notes for a cell or string to the database using a Local, Central or
Service computer. A Service computer can store a string memo in the monitor, but not a cell memo.
The Service computer saves the string memo in the database and monitor memory; the memo is
removed from monitor memory if manually imported or the Central computer performs an automatic
data extraction.

String View > Click a bar to make it gray, then right click the bar | Cell Memo or View|Cell Memo

To create a cell memo, click a bar on the graph to change it to gray, then right click the bar. On the
pop-up menu, click Cell Memo. On the Cell Memo dialog box, click the New button and type the data
and memo. To have the installation date, model, and serial number apply to all cells in the string,
select Entire String. To save the memo, click Save. If Entire String was checked, when you select Cell
Memo and click New for another cell, the installation date, model number, and serial number appear.

To determine which cells have cell memos assigned, press the F5 key. Cell bars with memos assigned
display in blue.

String View > View|String Memo

To create a string memo, click String Memo. On the String Memo dialog box, type a global memo
that applies to the entire string. To save the memo, click Save. To import a string memo into the
Central computer database that was entered into the monitor using a Service computer, on the String
Memo dialog box, select File[Import. This removes the memo from monitor memory.

3% Cell Memo (String 1, Cell 6} _ O] x| == string Memo (String name: STRING 9} _ O] x|
File Edit File Edit
ol 5 ol B
Author Author
§/15/2004 Jdack 10/5/2003 [Jack
104742003
10/9/2003
Installation Date 3172004
742642004
[ar5¢2004
todel Murnmber
[1343
Serial Mumber
1226
[¥ Entire String
ttemo Memo
This i a memo d this iz & test 3 :I
Communication Status: [Unknown v Communication Status: [Unknown 4

Figure 95. Cell Memo and String Memo
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22. Using the Report Generator

The BMDM Report Generator uses BMDM data files to create reports. After a BMDM-controlled
system reads voltage or resistance, the data is saved, and it is this data, presented in report format,
that battery monitoring personnel use to analyze battery system performance. The Report
Generator displays and prints text and graphs and saves customized reports in an archive ZRF
format that protects against changes. You may also view and print ZRF files using the Archive
Reader program.

String View > View|Reports|item
View|Reports accesses eleven Report Generator setup boxes. Use these boxes to create Detail and

Trend reports. Choose a Detail report to generate a report on an entire string by date. Choose
Trend to report on an individual cell or cells, temperature or overall voltage over a range of dates.

Some report dialog boxes let you select data sets. A data set is a set of historical float voltages,
resistance readings, alarm readings and/or discharge data for a string. A data set is for a single
date and time, and all data is displayed in one report.

After you select all the options on a Setup dialog box, click the Preview button to create a report
and display it on the Preview screen. Refer to Using the Preview Screens.

22.1. Detail Cell Voltage Report

String View > View|Reports|Detail|Cell Voltage

To create a Detail Cell Voltage report, click Cell Voltage. The Detail Cell Voltage Setup box
appears.

Detail Cell Yoltage Setup 2l

Setup Preview I Data Sets al | More | Delete |

™ Use Preset Thresholds
{* Owveride Preset Threshalds

Hi Threshald I 3000
Sting 1 34012V |

Lo Threshold | 1.000 [12/17/2006 02:20.06 p B
™ Show Averags Trend [ 2/17/2008 02 25:06 p
[2417/2005 03 30:06 p
I- Aot Inchude all Data Sets |7 2/17/2006 03:35:06 P
¥ Include Sting Memos [ 2A17./2006 02:40:06 p
[ 241742005 03:45,06
i el ST [¥]2/17/2005 02:50:06 E
rGraph Scaling————————————— r
241742006 02 55:06 p
Max [ 1000
" Auto &l 1000 [2/17/2006 04:00.06 p —
& Manual Min | 0.500 V] 241742006 04:05:06 p
[#12/17/2008 04:10:06 p
rReport Dutput————————"1 | M3 1 7,/2005 04:15:05 p
€ Ted € Giaph & Boh [2/17/2006 04:20:06 p
[5/3/2008 02:41:37 p -l

Figure 96. Detail Cell VVoltage Setup
Click Use Preset Thresholds to use values set in the BMDM program when the test was run.

To ignore BMDM thresholds, click Override Preset Thresholds, then type values in
the Hi Threshold and Lo Threshold boxes.
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Select Show Average Trend to generate a graph that shows the average voltage of all the
cells in the string for each date selected.

Select Auto Include All Data Sets to automatically select string data sets listed on the right
side that violate high or low thresholds. If you change threshold values, data sets that meet
the new criteria are selected. You may add data sets to the report by selecting additional
check boxes in the list.

Select Include String Memos or Include Cell Memos to include string or cell memos.

Graph Scaling area - Click Auto to default to automatic graph scaling, or click Manual and
type the Max and Min graph scale values. Use Manual scaling when you want to maintain
scaling to make it easier to compare several graphs.

Report Output area - Click Text to create a report with text only; click Graph for graphs
only. Click Both to include both text and graphs in the report.

Data Sets area - To manually select string data sets to include in the report, click the data sets
in the list or click All to select all items. If Auto Include All Data Sets is selected, strings that
violate thresholds are already selected. To clear all selected items, click None. To delete all
selected items from the database, click Delete. If the selected range contains no data, no dates
appear under Data Sets.
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22.2. Detail Cell Resistance Report

String View > View|Reports|Detail|Cell Resistance

To create a Detail Cell Resistance report, click Cell Resistance. The Detail Cell Resistance
Setup box appears.

Detail Cell Resistance Setup : 4 B

Setup Previgw | Data Sets Al | Nore | Delete |

™ Use Preset Threshaolds
{* Owerride Preset Threshalds

Bazeling I il
Stiirg 1 13401 2v |

% Above Baselne | 0,000 [15/3/2006 04:20.00 p

I Show Awerage Trend []5/5/2005 02:41:40 p
[W] 72742006 033626 p
[ Auto Include all Data Sets [17/27/2008 04:41-11 p
¥ Inchude Sting Memos 177272005 04:57:57 p

W Include Cell Memos
rGraph Scaling

™ Auto Maxl i
& Manual Min I—U
rReport Qutpy——————————————

 Test " Graph  Both

Figure 97. Detail Cell Resistance Setup

The items on the Detail Cell Resistance Setup box are the same as those on the Detail Cell
Voltage Setup box (refer to Detail Cell Voltage Report), with the following exceptions.

To ignore BMDM thresholds, click Override Preset Thresholds. In the Baseline box, type
the resistance in microhms. In the % Above Baseline box, type the percentage above which a
measurement will be in violation. For example, if the baseline resistance is 300 microhms and
the percentage is 10%, any data above 330 microhms violates threshold.

Select Show Average Trend to generate a graph that shows the average resistance of all the
cells in the string for each date selected.
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22.3. Detail Intercell Resistance Report

String View > View|Reports|Detail|Intercell Resistance
To create a Detail Intercell Resistance report, click Intercell Resistance. The Detail Intercell
Resistance Setup box appears.

Detail Intercell Resistance Setup 2

Setup Freview | Data Sets sl | Mone | Delete |

" Use Preset Threshalds
& Overide Preset Thiesholds

High | 40,000
Stiirg 1 13240124 |

54372008 04:20:00 p

[ Show Averags Trend [15/5/2006 02-41:40 p
FA27/2006 03:36:26 p

v Auta Include all Data Sets [17/27/200 04:41:11 p

W Include Shing M ermoz [C17/27/2006 04:57.57 p

W Include Cell Memos
—Graph Scaling————————————

" Auto Max [~ 43000
* Maral Min I 19.000

rReport Qutput————————————

f* Tewt " Graph ¢ Both

Figure 98. Detail Intercell Resistance Setup

The items on the Detail Intercell Resistance Setup box are the same as those on the Detail
Cell Voltage Setup box (refer to Detail Cell Voltage Report), with the following exceptions.

To ignore BMDM thresholds, click Override Preset Thresholds, then type a high intercell
resistance value in the High box.

22-4



22.4. Trend Cell Voltage Report

String View > View|Reports|Trend|Cell Voltage
To create a Trend Cell Voltage report, click Cell Voltage. The Trend Cell Voltage Setup box

appears.

Trend Cell Yoltage Setup

Setup Previes |

" Use Preset Thresholds
& Owerride Preset Thresholds

Hi Threshold I 0.000

Data Sets

STRING 9 |

All | Nnnel

Using the Report Generator

2]

Lo Threshold I 0.0na
¥ Show Average Trend
¥ Auto Select Cells
™ Include Cell Memos

¥ Include String Memos
—raph Secaling

= Auto Maxl 0.000

@ ffanual  Min | 0000
rReport Qutput
" Text " Graph & Both

[l String 1
[ String 1
IVl String 1
[l Sitring 1
[ String 1
¥l String 1
[l Sitring 1
¥ String 1
¥l String 1
¥l String 1
[ String 1
[ String 1
¥l String 1
[l Sitring 1

cell 1
cell 2
cell 3
cell 4
cell5
cellB
cell 7
cell 8
cell 3
cell 10
cell 11
cell 12
cell 13
cell 14

Figure 99. Trend Cell Voltage Setup

Click Use Preset Thresholds to use values set in the database.

Click Override Preset Thresholds to ignore BMDM thresholds, then type values in
the Hi Threshold and Lo Threshold boxes.

Select Show Average Trend to generate a graph that shows the average cell voltage over the

range of dates.

Select Auto Select Cells to automatically select cells listed on the right side that violate high
or low thresholds. If you change threshold values, cells that meet the new criteria are
selected. You may add cells to the report by selecting additional check boxes in the list.

Select Include Cell Memos and Include String Memos to include cell and string memos.

Graph Scaling area - Click Auto to default to automatic graph scaling, or click Manual and
type the Max and Min graph scale values. Use Manual scaling when you want to maintain
scaling to make it easier to compare several graphs.

Report Output area - Click Text to create a report with text only; click Graph for graphs
only. Click Both to include both text and graphs in the report.
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Data Sets area - To manually select cells to include in the report, click the cells in the list or
click All to select all items. If Auto Select Cells is selected, cells that violate thresholds are
already selected. To clear all selected items, click None. If the BMDM was used with an
MPM, the list shows string and cell. If a BDS was used, the list shows cell only. If the
selected range contains no data, no cells appear under Data Sets.

22.5. Trend Cell Resistance Report

String View > View|Reports|Trend|Cell Resistance

To create a Trend Cell Resistance report, click Cell Resistance. The Trend Cell Resistance
Setup box appears.

Trend Cell Resistance Setup 2 x|

Setup F'review| Data Sets All | Nune|

= Use Preset Threshalds
" Override Preset Thresholds

Baszeline I—D STRING 9 |

% Above Baseline I o [String 1 cell 1 =]
¥ Show Avarage Trend Fg:::g 1 EE::%
[~ Auto Select Cells [CString 1 cell 4
[V String 1 cell &
Include Cell M
B sy Col e [String 1 cell B
¥ Include String Memos [CString 1 cell 7
~Graph Sealing [ String 1 cell 8

" Auto Max | 0 Mstring 1 cell 9 .

& Manual ~ Min | 0 [CString 1 cell 10
¥ String 1 cell 11
~Report Qutput———————— | [String 1 cell 12

[CString 1 cell 13
o o o
Text Graph & Both EString1 call 14 Ll

Figure 100. Trend Cell Resistance Setup

The items on the Trend Cell Resistance Setup box are the same as those in Trend Cell
Voltage Report, with the following exceptions.

To ignore BMDM thresholds, click Override Preset Thresholds. In the Baseline box, type
the resistance in microhms. In the % Above Baseline box, type the percentage above which a
measurement will be in violation. For example, if the baseline resistance is 300 microhms and
the percentage is 10%, any data above 330 microhms violates threshold.

Select Show Average Trend to generate a graph that shows the average cell resistance over
the range of dates.
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22.6.Trend Intercell Report

Using the Report Generator

String View > View|Reports|Trend|Intercell
To create a Trend Intercell report, click Intercell. The Trend Intercell Resistance Setup box

appears.

Trend Intercell Resistance Setup

Setup Freviem |

 Uze Preset Threshaolds
* Overide Preset Threshalds

Hi Threzhold I 0.000

I~ Show Average Trend
[~ Auto Select Cells
I~ Include String Memas

rGraph Scaling——————————

£ Auto Max | 0.000
& Manual Min | 0.000

Data Sets All | Nnnel

BDS-256 134061 2 |

—Report Outpu——————————————
% Test  Graph  Both

el -
el 2
cell 3
el 4
cell 5
cell B
el 7
cell &
el 3
el 10
el 11
el 12
el 13

el 14 =

Figure 101. Trend Intercell Resistance Setup

The items on the Trend Intercell Resistance Setup box are the same as those in Trend Cell
Voltage Report, except that Trend Intercell Resistance Setup does not have check boxes for
Low Threshold or for Include Cell Memos.
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22.7. Trend Overall Voltage Report

String View > View|Reports|Trend|Overall Voltage

To create a Trend Overall VVoltage report, click Overall Voltage. The Trend Overall Voltage
Setup box appears.

Trend Dverall Yoltage Setup 2]
Setup Preview| —Report Output
" Use Preset Threshalds © Text ¢ Graph & Bath

& Cwerride Preset Threshalds

Hi Threshold 0.0  Graph Scaling

Ao Ma}{l 0.000
& Manual  Min [ 0.000

Lo Threshold o0
¥ Include String Memos

Figure 102. Trend Overall Voltage Setup
Click Use Preset Thresholds to use values set in the database.

Click Override Preset Thresholds to ignore BMDM thresholds, then type values in
the Hi Threshold and Lo Threshold boxes.

Select Include String Memos to include string memos.

Report Output area - Click Text to create a report with text only; click Graph for graphs
only. Click Both to include both text and graphs in the report.

Graph Scaling area - Click Auto to default to automatic graph scaling, or click Manual and

type the Max and Min graph scale values. Use Manual scaling when you want to maintain
scaling to make it easier to compare several graphs.
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22.8. Trend Temperature Report

String View > View|Reports|Trend|Temperature

To create a Trend Temperature report, click Temperature. The Trend Temperature Setup box
appears.

Trend Temperature Setup

Setup F're\fiewl —Report Output

" Use Preset Threshalds © Text € Graph & Both
& Cwerride Preset Thresholds

Hi Threshald an ~Graph Scaling

Lo Threshald 00 o Auto Max [ 0.0
& Manual  Min [ 00

21|

¥ Include String Memos

Figure 103. Trend Temperature Setup
The items on the Trend Temperature Setup box are the same as those in Trend Overall
Voltage Report.
22.9. Trend Intertier Report

String View > View|Reports|Trend|Intertier
To create a Trend Intertier report, click Intertier. The Trend Intertier Setup box appears.

Trend Intertier Setup 21x]

Setup F'reviewl

& t " Graph (© Bath

"Repun Output

¥ Include String Mermos

Figure 104. Trend Intertier Setup

Report Output area - Click Text to create a report with text only; click Graph for graphs
only. Click Both to include both text and graphs in the report.

Select Include String Memos to include string memos.
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22.10. Discharge Report

String View > View|Reports|Discharge

To create a Discharge report, click Discharge. The Discharge Setup box appears. Options
selected on Discharge Setup are saved by the battery name.

Discharge Setup ﬂll
rReport Interval Preview
Ehline DO:00:01T  (HH:MM:SS) | Discharge Date
OV Deviation IT Voltage Start DatesTime Duration  Lowest 0% O%@E@30 ACViE@30

B/11/2004 01:39:16 p - 00:00:52 |
Low Threshaold Yalue

" Use Preset Thresholds

,,,,,,,,,,,,,,,,,,,,,,,,

________________________

& Oweride Preset Thresholds | | o i oo oo T

B/1/2004 04:20:27 p

SEISEETY Shedthedl 1L e

Low Cell Threshold I 1.943  Maoltage | ([Tt i 22 Ao A8 R

Low O% Threshaold 0.0 Yaltage Sitring 1 |
. ~Cell Detail
~Graph Scaling All Maone |
& Auto Wax [ 0000
£ Manual Min [OmOT || Sting1 |
~Repaort Option Mcell 1 ﬂ
¥ Auto Select [~ Tabular ECE’”%
e
¥ String Memos [T Cell Graph el 4
W Cell Memos v Cell Detail Fce” g
ce
I Include Power v O Graph Meell 7
¥ Standard [eell 8 =

Figure 105. Discharge Setup

Report Interval area - Click Time or OV (Overall Voltage) Deviation and type a value in
the respective box. Report Interval determines the frequency of report sampling. Specify time
in hours, minutes, and seconds (10 second minimum) or OV deviation in volts (0.2 volt
minimum).

Low Threshold Values area - Click Use Preset Thresholds to use values set in the BMDM
program when the test was run. Click Override Preset Thresholds to ignore BMDM
thresholds, then type values in the Low Cell Threshold and Low OV Threshold boxes. Any
measurement below these values will be in violation.

Graph Scaling area - Click Auto to default to automatic graph scaling, or click Manual and
type the Max and Min graph scale values. Use Manual scaling when you want to maintain
scaling to make it easier to compare several graphs.

Select Auto Select to automatically select cells listed on the right side that violate thresholds.
If you change cell or OV threshold values, cells that meet the new criteria are selected. You
may add cells to the report by selecting additional check boxes in the list.

Select String Memos and Cell Memos to include string memos and cell memos.

Select Include Power to list power in reports, in addition to voltage and current.

Select Standard to create a Standard report. Cells are listed by string, and strings are listed
by time in a Cell = Value format.
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Select Tabular to create a Tabular report, which is the same as a standard report, but in a
spreadsheet format, with Cells vs. Time.

Click Cell Graph to create a report that includes a cell graph.
Click Cell Detail to create a report that includes cell detail.
Click OV/I Graph to create a report that includes Overall Voltage and Load Current graphs.

The Discharge Dates columns list the Start Date/Time, Duration, Lowest OV, OV@30 and
ACV@30 of all discharges. The Lowest OV column lists the lowest value reached during
discharge. OV@30 lists the overall voltage 30 seconds into discharge, and ACV@30 lists the
average cell voltage 30 seconds into discharge. Click the discharge for which the report will
be generated. Only one discharge date may be selected for a report.

Cell Detail area - To manually select cells to include in the report, click the cells in the list or
click All to select all items. If Auto Select is selected, cells that violate thresholds are already
selected. To clear all selected items, click None. If more than one subdirectory of cell data is

available, tabs for each subdirectory appear above the list of cell names.

22.11. Alarm Report

String View > View|Reports|Alarm

To create an Alarm report, click Alarm. The Alarms Setup box appears. Options selected on
Alarms Setup are saved by the battery name.

% Alarms Setup e |
™ Include String Memos Preview |
Alarm Types

¥ High Cwerall Vaoltage W High Cell Vaoltage T :
I* Low Overall Voltage I Low Cellvoltage W Low Temperature
¥ High Intertier Resistance ™ High Cell Resistance

Al | Nonel W Digital IO

Figure 106. Alarms Setup
Select Include String Memos to include string memos in the report.

Alarm Types area - Alarm types that you may include in the report are high and low overall
voltage, high intertier resistance, high and low cell voltage, high cell resistance, and high and
low temperature. Select these items to include full details of each alarm, not just a summary.
If Digital 1/0 is selected, the system generates an alarm if a digital input is selected on the
battery setup digital output screen.
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22.12. Summary Report

String Status > Summary report or String View > View|Reports|Summary [see text]

To create a Summary report that includes data only for the string to which the system is
connected, click View|Reports|Summary (String View screen). To create a Summary report
for all strings in the system, click the Summary Report button (String Status screen). The
Summary Setup box appears. A report generated using the Summary Report button may be
more than 100 printed pages long.

:-'—‘-"r‘Summary Setup i llil
rSetup Name Preview I
W INew Report Setup Ll ~Discharge Setup———————
R Deletel ¥ Include Discharge Report

. Mew | Delete| Sort |
¥ Include Customer Info ¥ Include Monitor Status

¥ Include Location Info W Include Status Parameters y Lischartelime j

rThreshold Deviation
V¥ Include & Show Percent

[~ Start New Page ¢ Show Value

Maintance Recommendation
¥ Include ¥ Include Probable Cause Motes

[V Start Mew Page [ Include Corrective Action Notes

Status Parameter
¥ Cverall Woltage B Include Detail Owerall Woltage

¥ Cell voltage ™ Include Detail Cell Yoltage

¥ Cell Resistance [T Include Detail Cell Resistance

¥ IT Resistance [ Include Detail IT Resistance - |

v Temperature ™ Include Detail Temperature

Figure 107. Summary Setup

Setup Name area - You can save the options and discharge times as a template, so you do not
have to choose them each time you generate a report. After choosing the options, type a name
in the Setup Name box and click New to save the template. To view existing templates, click
the arrows. To delete a template, display it and click Delete. Although the same name can be
used for different templates, you may want to use a unique name for each template.

Select Include Customer Info and Include Location Info to include the customer and
location names, addresses, and contact information in the report.

Select Include Monitor Status to print Last Known Status, which lists string name, monitor
status string status, and the date and time of the last known status.

Select Include Status Parameters to print Parameter Status as of Last Reading, which lists

the following if they are checked under Status Parameters: overall voltage, low and high cell
voltage and cell resistance, highest intertier resistance, and average temperature.
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Threshold Deviation area - Select Include to include the threshold deviation report. Select
Start New Page to insert a page break before the report. Select Show Percent or Show
Value to have deviations shown as percent change or actual values. Only cells that exceed
threshold values are listed.

Maintenance Recommendation area - Select Include to include the maintenance
recommendation report. Select Start New Page to insert a page break before the report.
Select Include Probable Cause Notes and Include Corrective Action Notes to include text
that attempts to resolve the types of violations found, such as high resistance. Only cells with
violations are listed.

Status Parameters area - Select Overall Voltage, Cell Voltage, Cell Resistance, IT
(Intertier) Resistance or Temperature to list these items in Parameter Status as of Last
Reading. You must also select the Include Status Parameters check box.

Select Include Detail Overall VVoltage, Include Detail Cell VVoltage, Include Detail Cell
Resistance, Include Detail IT Resistance or Include Detail Temperature to print these
sections, which have graphs of each item in violation. Items with Normal status do not print.

Discharge Setup area - Select the Include Discharge Report check box to print a discharge
report. To add a discharge duration time to the list, Click New then type a new time in the
highlighted 00:00:00 in the Discharge Time list. To sort the times, click Sort. To remove a
time from the Discharge Time list, click the time to highlight it, then click Delete.

For a description of the items in Discharges in the report, refer to Using the Web Report
Generator.
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23. Using the Preview Screens

[Previously described Setup screen] > Preview

After all report parameters are selected, to view the report on a report preview screen,
click Preview. To change the size of the page display, click Page, Width or Full. To view
different pages, click the first, previous, next or last page arrows on the toolbar.

=S Detail Cell ¥oltage Report

Print J!J j_l |1_ Ll L” Savedrchive | Page|width| Full | Open Archive |

| Detail Cell Voltage Report

Customer Information

Customer: ALBERCORP

Address:

Contact Name:  patlabiendo |
Dept.: Engineering

Phone Number: Ext.:

Fax Number: 997-5538

Email:  pat_lab@alber.com

Location Information

Location: BOCA RATONLAB

Addraccs

hstart || 1] @ 5 [ || Futied - paint [@eMpatamar ¥ Symantec Antiius Corpo .| A Y Y Jr =] ’ﬁvl
Figure 108. Preview (Typical Screen)
The Discharge Report preview screen is different from the other preview screens. This screen has

tabs along the top that let you select different sections of the report. These tabs are labeled Battery
Info, Cell Summary, Standard, Cell Detail, Tabular, Cell Graph, and OV/I Graph.

= Discharge Report o 2 x|
RO Print Current J!JJJ 1 LlL" Save Archlve| F'agE|W\dth| FuII| Open Archive |

Battery Info | Cell Summary | Standard | Cell Detail | Tabular | Cell Graph | 0vA Graph |
-]

| Discharge Report |

Customer Information

Customer: ALBERCORP

Address:

Figure 109. Preview (Discharge Report)

To view a section of the report, click a tab. To view different pages in one section, click the first,
previous, next or last page arrows on the toolbar.
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23.1. Saving a Report in Archive (ZRF) Format

Preview screen > Save Archive

The Report Generator can save a report as an archive ZRF file, which cannot be changed after
it is saved. Archive format lets you distribute the report file while ensuring the integrity of the
data. The file can be opened by the Report Generator or the Archive Reader and viewed or
printed. To save a report in archive format, click Save Archive. In the Save Archive dialog
box, select the subdirectory, type the file name, then click Save. Reports are saved in the
folder last opened, unless a different folder is selected.

23.2. Printing a Report

Preview screen > Print

To print the report displayed, click Print; in reports with more than one section, to print only
the currently selected tab, click Print Current or, to print the entire report, click Print. When
the Print dialog box appears, select the pages to print, the number of copies, and the printer
setup. To print a single page, do not select Current Page. Instead, select Pages and type the
page number in the box.

23.3. Opening an Archive File

Preview screen > Open Archive

You can open an archive ZRF file to compare data before saving a currently open report. To
open and display an archive file, click Open Archive, select the subdirectory and file name,
then click Open. Use the toolbar buttons to change the page size and view different pages. To
print the report, click Print. To close the file, click the Close button. Archive files cannot be
changed.

23.4. Archive Reader Program

The Archive Reader, distributed with the Report Generator, is used to view and print ZRF
files when the Report Generator program is unavailable. It is typically sent with archive files
when these files are sent to locations that do not have the Report Generator. You may freely
copy and distribute the Archive Reader when required. The Report Generator is a licensed
product and may not be duplicated for multiple site use. You may download the Archive
Reader from the Vertiv Corporation Web site at www.vertivco.com and copy it to a CD for
distribution with ZRF files.
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24. Using the Web Report Generator

Every 24 hours, the Web Report Generator automatically creates and saves an executive summary
report as a PDF file at Program Files\Alber\MPM Manager\Web\SystemSummary. New reports
overwrite previous reports automatically or when you manually generate a report. You may view
the executive summary report by connecting via the Web to albermonitor.com.

24.1. Setting Up the Web Report

String Status > highlight a name then Reports|Setup

To enable automatic Web report generation, select the Detail Executive Report Enable check
box on Setup|Preferences. To set up report format, highlight a string name on String Status,
then click Reports|Setup to open the Technician Detail Summary Report Setup dialog box.

== Technician Detail Summary Reporkt Setup ﬂll
Preview |
rDischarge Setup
¥ Include Customer Info ¥ Include Monitor Status ¥ Include Discharge Report
¥ Include Location Info W Include Status Parameters Mew | Delete| Sort |
rThreshold Deviation DlesiEmEine N
¥ Include " Show Percent

[T Start Mew Page & Show Yalue

rMaintance Recommendation
¥ Include I" Include Probable Cause Motes

[~ Start Mew Page I Include Corrective Action Motes

rStatus Parameter
¥ Overall Woltage W Include Detail Overall Yoltage

vV Cell Woltage ¥ Include Detail Cell Voltage
¥ Cell Resistance [ Include Detail Cell Resistance

V¥ IT Resistance v Include Detail IT Resistance

¥ Temperature ¥ Include Detail Temperature =]

Figure 110. Technician Detail Summary Report Setup

Select Include Customer Info and Include Location Info to include the customer and
location names, addresses, and contact information in the report.

Select Include Monitor Status to print Last Known Status, which lists string name, monitor
status, string status, and the date and time of the last known status.

Select Include Status Parameters to print Parameter Status as of Last Reading, which lists
the following if they are checked under Status Parameters: overall voltage, low and high cell
voltage and cell resistance, highest intertier resistance, and average temperature.

Threshold Deviation area - Select Include to include the threshold deviation report. Select
Start New Page to insert a page break before the report. Select Show Percent or

Show Value to have deviations shown as percent change or actual values. Only cells that
exceed threshold values are listed.
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Maintenance Recommendation area - Select Include to include the maintenance
recommendation report. Select Start New Page to insert a page break before the report.
Select Include Probable Cause Notes and Include Corrective Action Notes to include text
that offers solutions for the types of violations found, such as high resistance. Only cells with
violations are listed.

Status Parameters area - Select Overall Voltage, Cell Voltage, Cell Resistance, IT
(Intertier) Resistance or Temperature to list these items in Parameter Status as of Last
Reading. You must also select the Include Status Parameters check box.

Select Include Detail Overall Voltage, Include Detail Cell Voltage, Include Detail Cell
Resistance, Include Detail IT Resistance or Include Detail Temperature to print these
sections, which have graphs of each item in violation. Items with Normal status do not print.

Discharge Setup area - Select the Include Discharge Report check box to print a discharge
report. To add a discharge duration time to the list, Click New then type a new time in the
highlighted 00:00:00 in the Discharge Time list. To sort the times, click Sort. To remove a
time from the Discharge Time list, click the time to highlight it, then click Delete.

o Percent of Accuraulatve Dizcharge Times
Time Interval Hits Cumulative Time
00:00:00 - 00:00:30 2 00:00:38 =
00:00:31 - 00:01:00 3 00:02:02
Unlmown 4 00:00:00
Total Hits: 9 Total Time: 00:02:40

oooo3o maiao Uik iown
The

Figure 111. Technician Report - Discharges Area

The Discharges area on the report has a table and graph. The Time Interval column lists
discharge duration limits. For example, if the time listed is 00:00:00 - 00:00:30 and the Hits
column shows 2, then there were two discharges that lasted somewhere between 0 and 30
seconds. In the preceding figure, the cumulative (total) time of the two discharges was 38
seconds.

The graph in the Percent of Accumulative Discharge Times classifies the various discharge
durations. In the above figure, 24% of the total discharge time were discharges of zero to 30
seconds, and 76% were discharges 31 seconds to one minute.

After selecting all options, click the Preview button to create and display a report. If you
click Save Archive on the Preview screen, you can save to the Reports subdirectory as a ZRF
file and not overwrite the automatically generated report in the SystemSummary
subdirectory. For more on the Preview screen buttons, refer to Using the Preview Screens.
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24.2. Generating an Executive Summary Report

String Status > Reports|Generate

If enabled on Setup|Preferences, the Web Report Generator automatically generates the
executive summary report every night after autopolling is done. To manually generate a
report, highlight a name on the String Status screen, then click Reports|Generate. At the
Generate Executive Reports box, click Yes. The Auto Generating Technician Detail
Summary Report dialog box appears while the reports are being generated.

Auto Generating Technician Detail Summary Repork{s)

Custamer Mame:  ALBERCORP
Location Name: BOCA RATON LAE
Battery Name: BATTERY 1x24A
String Mame: STRING 9

|Building Threshold Deviation Report BATTERY 1X24BSTRING 10

Figure 112. Auto Generating Technician Detail Summary Report

The report is saved in the SystemSummary subdirectory, which is created when the BMDM
program is installed. To view the new report, use a program such as Adobe Acrobat® Reader
and navigate to Program Files\Alber\MPM Manager\Web\ SystemSummary. Click on the
PDF file name to open the report.

New executive summary reports automatically overwrite previous reports every 24 hours or
when you manually generate reports by selecting Reports|Generate.
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25. Calibration

String View > Setup|Calibration

To ensure reliability of readings, Vertiv Corporation recommends that a qualified technician
check MPM or BDS monitor calibration annually. Perform calibration using a computer directly
connected via the RS-232 port. The Calibration dialog box displays all the parameters the unit
monitors. To display this screen, select Setup|Calibration from the String View screen.

2

Measurement Point Measured Value | AJD Counts | Calibration Factor |
CellVahage (Sting [ 2 . cel] 1 2] [ 0000 2=} vors 2088 [ oooriasez
Oweral Valtage m%’ﬂ%’ wolks Im
Test Curent [ Load _1%‘ 1 IW%’H%I amps Im
Discharge Current _% I—D 2 mvalts Im
Iniertiervol (Sting | =] . cel] T 2P| 00 2k mvaks [ otaneeEzs
Temperatureﬁﬁ I—D: = F lm
Temperature 2 I—%HH F Im
Float Current I—D%lﬂélmamps Im
Intercell Volt [ Cell I—il] I—%,%lelmvnlts Im

=1 Send | Scan | j-'L Cloge |

Commurication Status: [Response 0K

Figure 113. Calibration Setup (MPM)

The BDS Calibration dialog box differs slightly. It has arrows to select other DCM's and does not
have a Test Current cell selector. Overall Voltage and Intercell Volt are not available for the

BDS-40.

21
DCM #: 2 1' Ll

I easurement Paint teasured Value | 440 Counts | Calibration Factar |
Cellvokags (Stina [ 2], cel[ 723 21 [ 0000 222 vors 1559 EEEEEE
OverallValtage 2=l v | I
Test Curent 1= 0000 =}t amps [~ o.oooon0n0
Discharge Curent | = el [~ o.oooogo00
Intertien ol [ Swing [ =] . cal] 2 2leled s [~ o.oooog000
Temperature 1 ey s | 0.00000000
Temperature 2 2lelele [~ o.oooogo00
Float Current =Lt tmamnps I 000000000
Intercell ol [Cell [ 43 ) 00 22 muchs [~ o.0o00000

=1 Send Edit | l-'L Close
Communication Status: [Command ACK

Figure 114. Calibration Setup (BDS)
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There are four columns on the Calibration dialog box: Measurement Point, Measured Value,
A/D Counts, and Calibration Factor.

Measurement Point — Allows selection of input channels when calibrating. Usually, the
parameters selected never need to be changed. The Measurement Point also serves as a diagnostic
tool that can lock in on a channel for troubleshooting.

Measured Value — Type measured values in this column. The MPM uses only Temperature 1;
the BDS uses two temperature channels per DCM.

A/D Counts — The value from the A/D (Analog to Digital) converter before any calibration
(Calibration Factor) is applied. Also referred to as Raw Counts.

Calibration Factor — The correction factor required to obtain a value that can be displayed on
the String View screen.

Scan / Edit is a toggle action button. Clicking Edit allows editing of the Calibration Factors.
Clicking Scan disables editing. Clicking a Measured Value field displays A/D counts.

Required Test Equipment:
4-1/2 digit DVM — Fluke 87 or equivalent.
100 millivolt and 10 millivolt source.
Clamp-on current meter. A 0.1% shunt is recommended.
Temperature probe.

The calibration procedures are available to qualified personnel trained by Vertiv Corporation in
the calibration of this equipment.
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26. MPM Diagnostics

String View > Diagnostics|ltem

The diagnostics are used for production testing, but may help troubleshoot a hardware failure in
the field. Select Diagnostics from String View. The computer must be connected to an MPM and
Communication Status at screen bottom must show Response OK.

26.1. Rebooting and Power Up Diagnostics (MPM)

String View > Setup|Reboot Firmware

To reboot the MPM from the Data Manager, select Reboot Firmware. This does a "warm
reset”" of the MPM. At power-up, the unit performs diagnostics for about two minutes. If the
unit fails any test other than failure to detect a dial tone, the Error LED blinks. Identify the
failing parameters by using the Self Test diagnostic.
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26.2. Self Test (MPM)

String View > Diagnostics|Self Test

Self Test reads an MPM status register and displays the parameter status on the Diagnostics
dialog box. These parameters are tested only at MPM power-up. If an update is needed, cycle
the power to the MPM or reboot by selecting Setup|Reboot Firmware. To open Self Test
Diagnostics, select Diagnostics|Self Test.

Diagnostics i 2| x|

tl Load Modulel nIP I Indicator | Digital Eortl MED‘I}II Contgctsl Intergierl

ITEMS STATUS
Processor
External RaM
PROM
AdD
Modem

Dial Tone

Running Firmware

Firmware Yersion

Cormrmunication Status: |Unkn0wn

Figure 115. Diagnostics - Self Test (MPM)
Items on the Self Test Diagnostics dialog box are described below.

Processor - Checks processor internal registers and timers.

External RAM - Writes and reads to each RAM location to verify accessibility.
PROM - Calculates and verifies the program checksum in the PROM.

AJ/D - Reads and confirms the A/D converter reference voltage is within specification.
Modem - Verifies the modem echoes commands.

Dial Tone - Confirms the telephone is connected.

Running Firmware - Displays the memory type from which the firmware is running.
Typically, this is the PROM, but the system can upload a new version to Flash memory.

Firmware Version - Displays the version of firmware running.
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26.3. Load Module (MPM)

String View > Diagnostics|Load Module

The Load Module diagnostic tests each load connection to the battery. This diagnostic tests
the connections, load cable fuses, load relays and load module, and can confirm actual load
current. Refer to the left side of the load connections drawing in the installation manual to
determine the load steps used for each configuration.

The Load Module also has a diagnostic that can confirm the direction of the current
transducer.

To test each load connection, open Load Module Diagnostics, select Load Module, then click
the Test Current tab on the dialog box. Identify the configuration that applies to the
installation. You can turn on each load step and confirm the current for that step. Each load
step must be from 17 to 23 amps when energized.

WARNING: When testing, do not leave the load module on for a long time. The load
module can overheat and damage hardware if not allowed to cool between tests. The load
module automatically turns off after 10 seconds.

2lx

Self Test | DIF I Indicator | Digital Eortl Memoryl Eontgc:tsl Inter;ierl

 Select Load Module —
& Load Module 1

" Load Madule 2

" Load Module 3

" Load Maodule 4

" Load Module 5

" Load Module B

" Load Module 7

¢ Load Module 8 Test Curient | CT Polarty |
¢ Load Module 3
" Load Module 10
 Load Module 11 oo
" Load Module 12
" Load Module 13
" Load Module 14

~ Load Module 15
¢ Load Moduls 16 § LoadOn |

Load Current [amps]:

Comrunication Status: |Resp0nse QK

Figure 116. Diagnostics - Load Module - Test Current (MPM)

Under Select Load Module, select a load module, then click Load On. To stop the test,
click Load Off.
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26.4. DIP Switch (MPM)

String View > Diagnostics|DIP Switch

The DIP Switch diagnostic confirms each position of the DIP switch inside the MPM.
Although not all switch positions are used, every position is checked. This diagnostic allows
remote checking of switch settings. To open the diagnostic, select DIP Switch. The screen
indicates each switch position as it is changed.

CAUTION: Exit this diagnostic with the switch in the same positions it was in when the
diagnostic was entered.

21|

Self Test | Load Module | lndicatorl DigitaIEortI Memor}ll Eontgc:tsl Inter;ierl

ITEMS STATUS
Bit 1

Bit 2 aM

Bit 3 aM

Bit 4 aM

Eit 5 aFF

Bit & QFF

Bit 7 aM

Bit 3 QFF

Communication Status: [Response OK

Figure 117. Diagnostics - DIP Switch (MPM)
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Indicator (MPM)

String View > Diagnostics|Indicator

This diagnostic tests front panel LED operation. To open Indicator Diagnostics, select
Indicator. To activate an LED, click an LED name then On.

26.6.

Self Test | Load Module | DIP

Select Indicator

& Scan
& Alarm

~ Resistance Test

{ Alarm Disable
¢ Enoe

gitaIEortl Memoryl Contgclsl Interyerl

21|

Communication Status: |F‘D||ing System Status

Figure 118. Diagnostics - Indicator (MPM)

Digital Port (MPM)

String View > Diagnostics|Digital Port
The Digital Port diagnostic checks the status of the digital inputs. If the system is connected

to external contacts, this diagnostic can check each contact. To open Digital Port Diagnostics,
select Digital Port. The screen displays the status of the inputs. An ON status means a contact

is closed.

Diagnostics

Self Testl Load Mndulel il | Indicator  Digital Part §| Memary

ITEMS
Digital Input 1

Digital Input 2

OM

Digital Input 3

O

Digital Input 4

aM

Digital Input &

OM

Digital Input &

OM

Digital Input 7

aM

Digital Input 8

oM

Digital Input 9

OM

Digital Input 10

aM

Digital Input 11

aM

Digital Input 12

OM

Digital Input 13

aM

Digital Input 14

aM

Digital Input 15

OM

Digital Input 16

O

STATUS

Alarm Reset Button:  OFF

ontacts | Intertier I

2l

Communication Status: |F'Dlling Digitial Input

Figure 119. Diagnostics - Digital Port (MPM)
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26.7. Memory (MPM)

String View > Diagnostics|Memory
To open Memory Diagnostics, select Memory.

21x|

Diagnostics

Self Test | Load Modulel DIP I lndicatorl Digital Part Contgctsl Intergierl

temary Tyupe
& EEPROM

= Flash Memary

Diagnostics Fesult: Mot Feady

G Start | gf Clear Data Memory

Communication Status: |F\esponse ok

Figure 120. Diagnostics - Memory (MPM)

The Memory diagnostic checks nonvolatile monitor memory: E2 (EEPROM) and Flash.

E? memory stores calibration and setup information and data, such as Discharge, Alarm and
Resistance test data. Flash memory stores MPM firmware uploads. Firmware can be
upgraded on-site or remotely via modem.

To test memory, select EEPROM or Flash Memory, then click Start. During EEPROM
testing, communication is briefly lost, then a status result indicates pass or fail. During Flash
Memory testing, the integrity of the upgraded firmware file is checked; after clicking Start,
select a file to compare to the contents in Flash memory. Flash testing takes several minutes.

To clear all measured data stored in E2 memory, click Clear Data Memory.
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26.8. Contacts (MPM)

String View > Diagnostics|Contacts

This diagnostic checks the external alarm contacts, charger contacts, and optional contacts for
proper connection. To open Alarm Contacts Diagnostics, select Contacts. Under Select
Contact, click Parameter Alarm, Charger Control or Contact 1, 2 or 3, then click On. You can
confirm contact operation by verifying a device connected to the contacts turns on and off.

CAUTION: The charger contact turns the charger off until it is re-energized or until the
diagnostic is exited.

Diagnostics ﬂil

Self Test | Load ModulelQIP |1ndicat0r Digital Port | Memary

~ Select Contact
& Contact 1

¢ Contact 2
" Contact 3
= Parameter Alarm

{~ Charger Control

Communication Status: |Respunse 0K

Figure 121. Diagnostics - Alarm Contacts (MPM)
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26.9. Intertier (MPM)

String View > Diagnostics|Intertier

The Intertier diagnostic monitors the signal on each intertier input. Use this diagnostic for
verifying the calibration of these input channels or troubleshooting. To open Intertier
Diagnostics, select Intertier.

21|

Diagnostics .
Self Test | Load Modulel DIP | lnd\catorl Digital Eortl Memoryl Contacts |m9l!|5f|

Intertier # Intertier Waltage [mvolts)
Intertier 1 [Cell 12)

Communication Status: |Response QK

Figure 122. Diagnostics - Intertier (MPM)

You may define up to eight intertiers for the MPM on the Battery Setup|Parameters dialog
box, but Intertiers 2 through 4 are active only when expansion ports J3, J4, J6 and J7 are
installed on the MPM.

Intertier Voltage (mvolts) - This column indicates the voltages being sent. This screen
displays up to eight intertiers for the MPM and is used to confirm calibration accuracy. The
cell number is the lower of the two cell numbers across which the intertier is connected
(selected on MPM Setup|Battery|Parameters).
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27. BDS Diagnostics

String View > Diagnostics|ltem

The diagnostics are used for production testing, but may help troubleshoot a hardware failure in
the field. Select Diagnostics from String View. The computer must be connected to a BDS and
Communication Status at screen bottom must show Response OK.

27.1. Rebooting and Power Up Diagnostics (BDS)

String View > Setup|Reboot Firmware

To reboot the BDS from the Data Manager, select Reboot Firmware. This does a "warm
reset”" of the BDS. At power-up, the unit performs diagnostics for about two minutes. If a
failure occurs, identify the failing parameters by using the Self Test diagnostic.

27.2. Self Test (BDS)

String View > Diagnostics|Self Test

Self Test reads BDS and DCM status registers and displays the parameter status on the
Diagnostics dialog box. These parameters are tested only at BDS power-up. If an update is
needed, cycle the power to the BDS or reboot by selecting Setup|Reboot Firmware. To open
Self Test Diagnostics, select Diagnostics|Self Test.

Diagnostics 2l x|
SEETEStl Load Module | DIp I Indicator | Digital Port I Mermary I Contacts I Intertier I Comm Error
Contraller DCH #: 1
ITEMS STATUS ITEMS STATUS
Proceszor Proceszor
External Rék ok External R 1]
PROM oK PROM oK
Flash Memary oK FIO Ok
Modem ok AD 1]
Dial Tore FalL Firmware Version  |3.32
Firrnweare Wergion | 3.3 Hf Reset Counter | 241
P/ Feset Counter |0
Code Space Flazh
{f Clear Counters |
Communication Status: |POIIing Self Diagnostics DCM

Figure 123. Diagnostics - Self Test (BDS)

Items in the Self Test Diagnostics box are described below alphabetically. If available, click
the left or right arrows to view settings for other DCM units.

A/D (DCM) - Reads and confirms the A/D converter reference voltage is within
specification.

Code Space (DCM) - Displays the memory type from which the firmware is running.
Typically, this is the PROM, but the system can upload a new version to Flash memory.
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Dial Tone (BDS Controller) - Confirms the telephone is connected. If connected via a
multiplexer, this field indicates Failed as a normal condition.

External RAM (BDS Controller and DCM) - Writes and reads to each RAM location to
verify accessibility.

Firmware Version (BDS Controller and DCM) - Displays the version of firmware running.

Flash Memory (BDS Controller) - Calculates and verifies the program checksum in Flash
memory.

FW Reset Counter (DCM) - At boot up, the DCM runs diagnostics. If an error is found, the
DCM reboots to retest. When this happens, this counter is incremented.

HW Reset Counter (DCM) - Indicates how many times power is cycled or the DCM
performs a hardware self-reset.

Modem (BDS Controller) - Verifies the modem echoes commands.
P10 (DCM) - Checks the read/write functions of the parallel input/output device.
Processor (BDS Controller and DCM) - Checks processor internal registers and timers.

PROM (BDS Controller and DCM) - Calculates and verifies the program checksum in the
PROM.

The Clear Counters button resets the HW (hardware) and FW (firmware) counters to zero.
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27.3. Load Module (BDS)

String View > Diagnostics|Load Module

The Load Module diagnostic tests each load connection to the battery. This diagnostic tests
the connections, load cable fuses, load relays and load module, and can confirm actual load
current. Depending how the system is set up, only the load module for the selected DCM is
enabled. Typically, all ten load steps are used and are distributed across multiple DCM units.

The Load Module also has a diagnostic that can confirm the direction of the current
transducer.

To test each load connection, open Load Module Diagnostics, select Load Module, then click
the Test Current tab on the dialog box. Select the DCM for the desired load module. You can
turn on each load step and confirm the current for that step.

IMPORTANT NOTE: If the screen displays only Load Module buttons 1 to 5, this indicates
the DIP switch in the DCM is set so the internal load bank is selected. This is an incorrect
state on newer DCM units. On older multiboard DCM units, this condition is normal if the
unit actually has an internal load bank. Confirm the setting before proceeding. View the
Diagnostics DIP screen. If Bank 2, Bit 1 Status is ON, this is incorrect for newer hardware.
The ON status is valid only for older hardware with internal load banks.

WARNING: When testing, do not leave the load module on for a long time. The load
module can overheat and damage hardware if not allowed to cool between tests. The load
module automatically turns off after about 10 seconds.

2]

Self Test Load Module |QIF’ I lndicatorl Drigital Eortl Jul or_l,ll Contacts | Comm Errorl

r Select Load Module — DOM A

& Load Module 1
" Load Module 2
" Load Module 3
" Load Module 4
" Load Module 5
" Load Module &
" Load Module 7 Load Current [amps]:
" Load Module 8
¢ Load Module 9 0.0
¢ Load Module 10

Test Current | CT Polarityl

Comrmunication Status: |Resp0nse QK

Figure 124. Diagnostics - Load Module - Test Current (BDS)

Under Select Load Module, select a load module, then click Load On. To stop the test,
click Load Off. Click the arrows to select other DCM units.
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To run the diagnostic that can confirm the direction of the current transducer (CT), click the

CT Polarity tab on the dialog box. Select the DCM for the desired load module.

Self Test  Load Module |QIF’ I Indicator | Digital Eortl Memoryl Contacts | Comm Errorl

r Select Load Module —

& Load Module 1
¢ Load Module 2
¢ Load Module 3
¢ Load Module 4
" Load Module 5
" Load Moduls &
" Load Module 7
" Load Module 8
" Load Module 9
" Load Module 10

DCM #: 1

Test Cument  CT Polarity

Positive

21|

Communication Status: |PUIIing System Status

Figure 125. Diagnostics - Load Module - CT Polarity (BDS)

Under Select Load Module, select a load module, then click Load On. When the test finishes,
the dialog box indicates Correct if the CT is oriented in the proper direction. If Incorrect is
displayed, reverse the direction of the CT and perform the test again to confirm proper

orientation.
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27.4. DIP Switch (BDS)

String View > Diagnostics|DIP Switch

The DIP Switch diagnostic confirms each position of the DIP switches inside the BDS and
DCM. This diagnostic allows remote checking of switch settings. To open the diagnostic,
select DIP Switch. The diagnostic indicates each switch position. Click the left or right
arrows to select other DCM units.

NOTE: The DIP switches are factory set and are not usually changed by the user.

2|

Self Test| Load Maodule Indicatar DigitaIEortI Memoryl Caontacts Eommﬁnorl

DCM #: 1 il LI

Corntroller DCMASW 1 DCMASW 2
ITEMS STATUS ITEMS STATUS ITEMS STATUS
Eit1 Bit 1 Eit 1
Bit2 M Bit 2 ON Bit 2 ON
Bit3 M Bit 3 ON Bit 3 ON
Bit 4 OFF Bit 4 ON Bit 4 ON
Bit5 OM Bit& OFF Bit 5 ON
EitE M Bit & OFF Bit & ON
Eit7 M Bit 7 OFF Bit 7 ON
Bitd OFF Bit 8 ON Bit 3 ON

Communication Status: |F'0IIing DCH Diagrostics

Figure 126. Diagnostics - DIP Switch (BDS)
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27.5. Indicator (BDS)

String View > Diagnostics|Indicator

This diagnostic tests front panel LED operation. To open Indicator Diagnostics, select
Indicator. To activate an LED, click an LED name then On.

Diagnostics 2 x|

Self Test| Load Module | DIP

igital Port | Memowl Contacts | Irtertier | Comm Error

Select Indicator

& Scan

¢~ Maintenance &lam

" Critical &lam

" Resistance Test

Communication Status: |Pn\|ing System Status

Figure 127. Diagnostics - Indicator (BDS)

27.6. Digital Port (BDS)

String View > Diagnostics|Digital Port

The Digital Port diagnostic checks the status of the digital inputs. If the system is connected
to external contacts, this diagnostic can check each contact. To open Digital Port Diagnostics,
select Digital Port. The screen displays the status of the inputs. An ON status means a contact
is closed.

21x

'lI Mamolyl CDntgcts' Imteryell Camm Error

Diagnostics
Self Test | Load Module | DIP | Indicator | Digital

ITEMS STATUS

Digital Input 1

Digital Input 2 oM
Digital Input 3 oM
Digital Input 4 oM
Digital Input 5 oM
Digital Input & oM
Digital Input 7 aM
Digital Input 8 aM
Digital Input 3 aM
Digital Input 10 |ON
Digital Input 11 [OMN
Digital Input 12 [OMN
Digital Input 13 [OMN
Digital Input 14 [OMN
Digital Input 15 [OMN
Digital Input 16 [OMN

Alarm Reset Buttorn:  OFF

Communication Status: |RespDr|sE QK

Figure 128. Diagnostics - Digital Port (BDS)
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27.7. Memory (BDS)

String View > Diagnostics|Memory
To open Memory Diagnostics, select Memory.

21|

Self Test | Load Modulel DIP I lnd\catorl Digital Port Contgclsl Interyerl Comm Error

Flash Memory Diagnostics

Diaghostics Result: Mot Ready

@ Start | "f Clear D ata Mermary |

;? Clear All Strings Config |

Communication Status: |Respunse o4

Figure 129. Diagnostics - Memory (BDS)

The Memory diagnostic checks Flash memory for the integrity of the upgraded firmware file.
Flash memory stores BDS firmware uploads. Firmware can be upgraded on-site or remotely
via modem. To run this test, click Start and select a file to compare to the contents in Flash
memory. This test takes several minutes.

SRAM memory stores calibration and setup information and data, such as Discharge, Alarm
and Resistance test data. To clear all measured data stored in nonvolatile SRAM memory,
click Clear Data Memory. To clear configuration settings for all strings in the BDS
Controller hardware, click Clear All Strings Config.
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27.8. Contacts (BDS)

String View > Diagnostics|Contacts

This diagnostic checks the external critical and maintenance alarm contacts and the optional
contacts for proper connection. To open Alarm Contacts Diagnostics, select Contacts. Under
Select Contact, click a contact or alarm button, then click On. You can confirm contact
operation by verifying a device connected to the contacts turns on and off.

2l
Self TESII Load MDduIEI DIF I lndil:alnll Digital Port | Memory Inlar_tiarl Comm Eror

r Select Contact
& Cortact 1
& Contact 2
 Cortact 3
" Cortact 4
 Cortact §
" Contact §
" Cortact 7
" Cortact 8
€ Critical Alarm

" Maintenance Alam

g On

Communicakion Skatus: ‘Rasponse oK

Figure 130. Diagnostics - Alarm Contacts (BDS)

27.9. Intertier (BDS)

String View > Diagnostics|Intertier

The Intertier diagnostic monitors the signal on each intertier input. Use this diagnostic for
verifying the calibration of these input channels or troubleshooting. To open Intertier
Diagnostics, select Intertier.

el .4

=" | Cornm Errar

Self Test | Load Mudu\el P | lndlcator' Digital Eorl' MEmory' Contacts

Intertier # Intertier Yoltage [myvolts]
Intertier 1 (Cell 10)

Intertier 2 [Cell 20 7.292

Intertier 3 (Cell 30) 7.500

Communication Status: |Respunse oK

Figure 131. Diagnostics - Intertier (BDS)
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BDS Diagnostics

Intertier Voltage (mvolts) - This column indicates the voltages being sent. This screen
displays up to 15 intertiers for the BDS and is used to confirm calibration accuracy. The cell
number is the lower of the two cell numbers across which the intertier is connected (selected
on BDS Setup|Battery|Parameters).

27.10. Communication Error (BDS)

String View > Diagnostics|DCM Comm Error

When communication integrity between the BDS and DCM fails, the Error Counts for the
associated DCM increments, and String Status on the String View screen indicates
"DCM-Comm Error." Error Counts can reach 255 before rolling back to zero.

Check DCM Address area - Click Start to check the DCM address. Using groups of flashes,
the DCM Status LED indicates the string and DCM address for that DCM. The first series of
flashes indicates the string ID. (For example, one flash means string 1, five flashes string 5.)
After a pause, a second series of flashes indicates the DCM ID within that string. After
another pause, two rapid flashes indicate the end of the cycle, which then starts over.

Diagnostics 3 il
Self Testl Load Modulal DIP I hﬁdicator' DigitalEDrt' Mamowl Contacts | Intertier ED E"D'

DCM Communication Ermor:
DCM # Eror Counts
DCM 1

Clear Comm. Error Caunts:

gé Clear

Check DCM Address:

¢ Start

Communication Status: |PU\|\r|g System Status

Figure 132. Diagnostics - Communication Error (BDS)

Clear Comm Error Counts area - Click Clear to reset the Error Counts values to zero.
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BDS Diagnostics

27.11. Resistance Testing Multiple DCM Units

String View > Cell Resistance or Intercell Resistance tab > Diagnostics|R-Test in a DCM

A BDS resistance test checks all the DCM units connected to the BDS. To test a specific
DCM, click the Cell Resistance or Intercell Resistance tab then select R-Test in a DCM. On
the Select DCM box, click the button for the DCM you want to test. To capture new readings,
click OK.

¢ DCM 2(Cells 43-96)

" DCM 3[Cells 97 - 144)

W OK I X Cancel |

Figure 133. Select DCM
If you clicked OK from Cell Resistance, the screen heading changes to Resistance in DCM n
(Cells n - n) (microhms) and the resistance test starts.

If you clicked OK from Intercell Resistance, the heading changes to Intercell in DCM n
(Cells n - n) (microhms) and the resistance test starts.

After a few minutes, 'test in progress' disappears, and the Get button becomes active. Click
Get to display the readings. The bottom of the screen displays a summary of the resistances
and intertier values measured. To stop the test before completion, click Stop.

Diagnostics does not transfer resistance readings to the permanent database. Be certain to
record the needed results before closing these screens.
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28. Upgrades

String View > Setup|Upgrade Firmware or Upgrade DCM Firmware

E2 (electrically erasable) memory on the MPM and SRAM memory on the BDS Controller store
calibration, setup information, and actual test data. On both units, flash memory is for uploads of
firmware, which can be upgraded on-site or remotely via modem. Refer to the MPM or BDS
Diagnostics-Memory section for a complete description.

The latest upgrades and upgrade instructions are on the Web at www.vertivco.com.

NOTE: On the BDS, the Setup|Upgrade Firmware item is enabled only when the BDS Controller
is connected to String 1.

== Network Connection to S:5tring 1A,
Filz  Wiew | Setup  Diagnostics

R Batkery
= | Iﬁl . Calibration

Cell Voltage  Check Settings

| Reboot Firmware
16 Lo Upgrade Firmware
Upgrade DCM Firmware

Figure 134. Setup Menu Showing Upgrade Options (BDS)
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Commissioning Assistant

29. Commissioning Assistant

View|Reports|Commissioning Report

The Commissioning Assistant creates a report that is extremely helpful if technical support must
be provided for your system. Similar to a setup wizard, the assistant helps you commission a
string by instructing you to perform certain functions and record the results. You may also use the
assistant to exchange equipment and recommission the string. Some assistant screens appear only
if certain equipment or options are selected.

NOTE: Each commissioning assistant screen has complete instructions at the top of the screen.
The instructions in this chapter are only meant to supplement the instructions on the screens. Be
certain to follow the instructions on each screen.

After completing the commissioning assistant, send the saved report with a file name .CMS
extension as an email attachment. Emailing the report to startup@vertivco.com is mandatory, as
the report is an integral part of the product warranty.

29.1. Starting the Assistant for a New String
Connecting to a string for the first time opens the commissioning assistant Welcome screen.

=% commissioning Assistant =10l x|
g Assistant

Welcome to the Commissio

'The Commissioning Assistant will guide you through the process of commissioning the hattery
monitoring equipment.

Upon successful completion of the startup, the Assistant will provide a packaged data set that
must be sent to startupi@alber.com to register for the full equipment warranty.
Failure to send this report to Alber will result in a maximum twelve month warranty.

ok | Cancel |

Figure 135. Commissioning Assistant Welcome

To commission the string, click OK on the Welcome screen to display the MPM or BDS
Monitor Pre-Power Check List. If you click Cancel, the Welcome screen displays until you
acknowledge the Pre-Power Check List or you click the Existing System Ignore button.
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29.2. Monitor Pre-Power Check List

=Monitor pre-power check list

Commissioning Assistant

b

i 3

isually verify the computer, monitoring equipment (including controller, if mounted separately), monitar cabinet and
computer cabinet are installed and interconnected as specified in their respective installation manuals. BDS40 base
and Plus units may be mounted individually on standoffs at the top of the battery cabinet, WARNIMG: Da not energize
the equipment with battery or mains outlet voltage until the installation is complete and verified per the specifications
Mote: Click the guery button to the right of each checklist itern for more detailed instructions and information.

[~ Werify all components are securely mounted

[~ Werify 24¥AC connections are made per the installation manual

[~ Werify fiher optic connections do not exceed maxmurm length

[~ Werify sense lead connections are made per the installation manual

[~ Werify load cahle connections are made perthe installation manual

[~ Werify discharge current sensing device is connected per the installation manual [ +- 15 if CT]
[Shunt =1 amps # T

[~ Werify float current sensor is connected perthe installation manual

[ werify ternperature probe connections are made per the installation manual

o i o L

[~ Power Unit OM

w7 Save and connect |

q/ Save and try later | * Euigting System-\gmolel

X Cancel |

Figure 136. Monitor Pre-Power Screen (typical)

The text at the top of the Monitor Pre-Power Check List depends upon the Help (question
mark) button clicked. The screen is similar for the MPM and BDS monitors. As you complete
each item, check the box before the item. When all boxes are checked, connect to the string
by clicking the Save and Connect button. To save a partially completed check list and

connect later, click Save and Try Later.

If the string was previously commissioned, click Existing System - Ignore to connect to the
string. The remaining commissioning assistant screens will not appear.

== Monitor pre-power check list

=1olx|

Werify that the load current wires are connected per the site drawings and installation instructions. WARNING:
Incorrect placement of the load wires at the battery or the load module may result in catastrophic system failure when
the load module is energized

Load Cable Voltage Measurement Approximate
Value (unit DC Volts)

1x104x1

69

92

Config. 1-2 13 14 15 16 17 1-8 19 110 | 1-11
1x88x1 36 72 108 144 182 220
23 46 17 142

B

[V Verify all components are securely mounted

¥ erify 24¥AC connections are made per the installation manual

¥ Verify fiber optic connections do not exceed maximum length

[¥ Verify sense lead connections are made per the installation manual

I~ Verify load cable connections are made per the installation manual

I~ Verify discharge current sensing device is connected per the installation manual [+ 15V ifCT]

2 |

Figure 137. Monitor Pre-Power Load Cable Help Screen

To display a table that shows the voltages between the load cables for configurations, click
the question mark on the "Verify load cable connections are made..." line.
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Commissioning Assistant

29.3. Starting the Assistant for an Existing String

View|Reports|Commissioning Report

This section describes how to start the assistant for a string that is partially or fully
commissioned or for which you want to exchange equipment. To open the assistant, first

connect to the string. On the String View screen, select View|Reports|Commissioning Report

to display one of the Open Commissioning Assistant screens. These screens appear for a

commissioned string or a partially commissioned string if Continue Later was clicked during

a commissioning session.

Open Commissioning Assistant

¢ Open existing Commissioning session

Date Commissioned © date
{* Exchange an existing piece of eguipment

¥ iController or CH-+LE

[~ Esternal Load module or RTM-XLR
[~ DCM-480 or DCM-#L48/D
SelectDCM: [~ 1

oK | Cancel |

=] 7BDS 40 Base

Open Commissioning Assistant

@& Open existing/new commissioning session

Exchange an existing piece of equipment

" Entire BDS-40 Base unit
" Contraller tray only

= DCM tray only

Cancel

Open Commissioning Assistant

@ Open existing/new commissioning session

" Exchange MPM-100 and re-commission

Cancel |

One of three MPM or BDS Open
Commissioning Assistant screens
appears. Options on these screens let you
open an existing commissioning session or
exchange a piece of equipment in the
system. Exchanging equipment requires
that the string be commissioned again.

Figure 138. Open Commissioning Assistant

To continue with a session, click the Open Existing/New Commissioning Session option
button then click OK. If replacing hardware on a previously commissioned string, click the
Exchange Equipment option button, then check a box for the equipment being exchanged.
For units with multiple DCM's, select the appropriate DCM check box. After making

selections, click OK.

29-3




29.4. Completing the Commissioning Assistant

Commissioning Assistant

After opening the commissioning assistant, complete the remaining screens as described in

the following sections.

29.4.1.

Commissioning Agent Screen

Commiissioning
I ST Enter the information for the commissioning agent. Fields with an astefisk * are
required.
oLlpme Rt Crey A copy of the commissioning report MUST BE sent to: alber.startup@alber com [&] Continue Later
Send Batiery Setup FAILURE TO SEND REPORT WILL RESULT IN A MAXIMUM OF TWELVE ) Hotes
MONTHS WARRANTY FROM DATE OF ORIGINAL SHIPMENT!
Cherk Setiings
Serial Humbers
Check Cell Valtags Commigsioning Agent
Techtician Name™ [Arthors:
Check verall Voltage o
Company Mame |A\be|
Base Data - Cell Woltage Ref/PO#t/Ticke!™ |12345
Check Temperature steld |
Equipment Tag |
Check Discharge Current Address” [F903 North Andrews A Ext
Check Test Gurrent Phene Number™ [354-0000000
Emai Address™ |
Base Data- Cell R )
Report
By Load Agent
B Save Agent
String Status: bischarge Occurred Communication Status: [Respanse OK

Figure 139. Commissioning Agent (Comm Asst)

Click the Commissioning Agent button. Complete the following fields: Technician Name,
Company Name, Reference/PO No./Ticket No., Site ID, Equipment Tag, Address,

Phone Number, and Email Address. Note that fields for which information is mandatory are
marked with an ( *) asterisk.

To save the technician name, company name, address, telephone number, and email address
for future commissioning reports, click Save Agent. To place previously saved agent data into
these fields, click Load Agent. You may save only one set of agent data.

To add a note to the report, click the Notes button, type the text into the Agent Notes dialog
box, then close the box. The text will appear in the Agent Notes section in the report. The
Notes button on the other screens accesses this same Agent Notes dialog box.
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Commissioning Assistant

29.4.2. Equipment Owner Screen

Commissioning

7| e agert || [Enters Tor squipment swmer Al fields indicated by an asterisk * are
reguired.

| Eauipment ouner "Load Customer Info" fills fields rom the string's customer fields: 8] Cortinue Leter

/| sendBattary setun “Laad Location Infa” fils fields fram the string's location fields Notes

Check Settings

Serial Numbers

Chetk Cell voliage (Equlmed G

Cornpany Name™ [Customer 1
Check Overall Voltage

Site Cortact” [Wima

Address IET 03 Andrews Ave Ext . Pompano Beach . FL

Check Temperature Phone Number [554-000-0000

Check Discharge Current Emai Address™ [roger@alber.com

Check Test Current
Load Custome: Info
Base Data- CellR Load Location Info

Report

v
v
v
v
+"| BaseData- CellVoltage
v
v
v
v

String Status: Discharge Occurred Communication Status: [Responise 0K

Figure 140. Equipment Owner (Comm Asst)

Click the Equipment Owner button. Complete the following fields: Company Name,

Site Contact, Address, Phone Number, and Email Address. Note that fields for which
information is mandatory are marked with an ( * ) asterisk. Optionally, to load the data saved
under Setup|System|Customer or under Setup|System|Location into the fields, click the

Load Customer Info or Load Location Info buttons.

29-5



Commissioning Assistant

29.4.3. Post Power Check Screen

.

Commissioning BD5-256 1X40X12V  Hardware String Number(slave id) = 1

Commissioning Agent
Equipment Owner

Post Power Check

Report

String Status: Good

Verify all the hardware is properly addressed correctly and the data memory has been cleared.
Both the “Run DCM Addr Check™ and “Clear Data Memory™ must be performed.

[n] Cortinue Later
Motes

[~ DCM addresses verified Run DCH Addr Check [~ Memory Cleared Clear Memnany

String # DIP SW5 DIP SWe DIP SW7 DIP swg
1 ON ON ON ON
2 OFF ON ON ON
3 ON OFF ON OMN
4 OFF OFF ON ON
5 ON ON QOFF ON
6 OFF ON OFF ON

smmunication Status: |Response OK

Figure 141. Post Power Check Screen (BDS-256 only) (Comm Asst)

Click the Post Power Check button. Verify the DCM addresses by clicking “Run DCM
Addr Check” button then, at the “Running DCM Address Check” message click Yes to check
all DCM addresses. Also, clear the data memory by clicking the “Clear Memory” button then,
at the "Clear Monitor Memory" message click Yes and the memory is cleared. After
verification, the DCM Addresses Verified box is automatically checked.

Note: The MPM does not have dip switch settings.
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29.4.4. Send Battery Setup Screen

Commissioning

Commissioning Assistant

| Check, ballery selup parameters prior (o sending. Delault selup values may be loaded into batiery selup
| Gommissioning Agent by clicking the ‘Set BDS Defaul Values’ bulton, NOTE: At this point, scheduled lest. historical log
parameters. fioat alarms and discharge alams will be enabled bt nol aofive. For cusiom soiup. thess
et setpints must be entered manual. These festures ey be reviswed and amended after the
V| Eaun commissiaring procedure is complete. Verly that General and Parameter selup is correct per the BMDM —IEI .
User Manual and site drawings and cick ‘Send.
+/'| send Battery Getup [ Motes
| GCheck setings
| Serial Numbers
| Ccheckcell voitage Gereral IEalamatevsI Test Parameters | Float Alams | Discharge | Digital Input | Digital Output | LGS |
Losation Name [[ocatin | Station Phone Number
| Check Overall Voltage
Battery Name [Faten 1 Tetal Cell Mumber 22
+/| Base Data- Cell Valtage
String Name [Stina | Shunt Value (amps/my) B=|
Check Temperature R
bl i vt [0 Float Crer Mkt T4
/| Check Discharge Current Time [TT.13AM Fiemote Fieporiing | (* Ensble (% Disable
| CheckTest Gurrent TelcoMUX |  Ensble € Dinable
/| BaseData-CellR Hetvwork Setup Rassnerd
1P Address: 125551 44 e
Report Netmask: 265 256 2860 7 AuloSend Time
Gateway -
Time Diference [Hours) =
Send Nework Configuration
AlamButton | & Acknowledge © Resst
= Send
String Status: Discharge Occurred Communication Status: Response OK

Figure 142. Send Battery Setup (Comm Asst)

Click the Send Battery Setup button. Verify the values displayed on the screen, make
changes if necessary, then click Send to transfer the settings to the monitor. Note that event
recording is ignored and the system doesn't alarm during commissioning. Alarms are disabled
until the base resistance thresholds are sent. If using string current for discharge detection, the
minimum value that can be entered is 5 percent of the shunt value.

29.45. Check Sett

ings Screen

Commissioning
Calibralion faclors must be uploadsd from the moriltor o the delabase before paremeter calibration &
/| commissioning Agent \veriied, Vierify that the IN MONITOR column is populated under the calibration tab then click Yes to
upload the manitar's calibration inta the database.

| Equipment Owner [ Continue Later
+"| Send Battery Setup Motes
| check Seftings
| Serial Numbers
| cheskcevaitage General | Parameters | Test Parameters | Float Alams | Discharge | Digtal Input | Dighal Qutput - Caliration | LGS Setup |
V| Check Overall valtage
/| Base Data - Cell Valtage
/| Check Temperature ITEMS INDATABASE | INMONITOR

Cell Valiage Calibralion Factor 000110467 (00070
V| Check Discharge Current Overall Voliage Calbration Factar | 0.02100372 002096550
e vm— Test Curert Calbralion Factor 0.01497550 0.01509034

Discharge Curert Calibration Factor | 011454773 011500931
| sasepata-cenr Intetier Calbration Factor 013888331 010526276

Temperature 1 Caliralion Factor | 1121735 1113780

Report Temperature 2 Calbralion Factor | 1250 26426 0674700

Temperature 3 Calbralion Factor | 000014386 0000 2621.4

Temperature & Calbralion Factor | 000014386 0000 2621.4

Temperature & Calbralion Factor | 000014386 0000 2621.4

Temperature & Calbralion Factor | 000014386 65505 2621.4

SendTime | " Recheck Upload calibration factors?
String Status: Discharge Occurred Communication Status: |RESDDHSE 0K

Figure 143. Check Settings (Comm Asst)

Click the Check Settings button. Confirm the values, then click Yes to upload the
calibration constants from the monitor to the database. If you click Recheck, the screen
refreshes. NOTE: Only the calibration constants are uploaded.

29-7



29.4.6.

Serial Numbers Screen

Retrieve serial numbers from the manitor

Gommissianing Agent

Equipment Owner

Send Battery Setup

Check Settings

Serial Mumbers

Commissioning Assistant

[ Continue Later
[) Hotes

Hardware Madel Number

Check Cell Voltage

Serial Number  Firmware Yersion

HPH-100 214

[ENET

Monitor
Check Overall Vollage

Chek Intertier

Base Data- Cell ¥altage

Cherk Float Gurrent

Check Ternperature

Check Discharge Current

Check Test Current

24 KN KN KN KN KN KN KN ES BN EN RN RN ES

Base Data- CellR

Report
Upload serial numbers

Chany

4 Upload

e

String Status: Blarm Communicat tion Status: Respanse OF

Figure 144. Serial Numbers (Comm Asst)

Click the Serial Numbers button. To upload the serial numbers and firmware revisions
from the connected hardware, click the Upload button. If the data is incorrect, click in the
field to type the correct data and click the Change button to send the data to the hardware.
The RTM and ELM serial numbers must be typed in manually.

29.4.7.

Check Cell Voltage Screen

Commiissioning

| commissioning agent 1. In the Cell Msasurement Foint isld. select the cellnumber you wish to measure. This oell must be
comneoted to the MPM unit you are calibrating
2. Measue this oel wilh the DM
Equipmeant Owner 3. Clck the Measured Value field
| Eai 4 Type the DM tasding and press Enter [ Ceifarlet
5. The Commissioring fissistant wil caloulate nhether the measured value is wilkin specficalion for accuracy
| send Battery Setup and /D counts. | found to be oul of specified limits. recaiibralion is achieved by cicking the Cal buton net o -
the Measured Velus field
/| check Settings
| serial Numbers Parameter: CellVoltage Status:  Enter Cell Voltage - 1
7| e — Fatameter | Measuedvaue | Monitortiaue | A/ Couts | Spectication | status
— DCM 1 Cell 1 |_cal [l 2158|2159 1991 |+2-1%.003my |Passed
| check overall valtage
+/| BaseData- Cellvoltage
/| checkTemperature
/| Check Discharge Current
Cell Number 1
/| ChetkTestCurrent
+"| BaseData-CellR
Report
String Status: Discharge Occurred Communication Status: [Paling Cel 1 voltage

Figure 145. Check Cell VVoltage (Comm Asst)

Click the Check Cell VVoltage button. Measure the voltage across the cell indicated, type the
value in the Measured Value field, then press <Enter>. If the measured value agrees with the
calculated value in the monitor, the Status area indicates Passed. If it fails, calibrate the
monitor to the measured value by clicking the Cal button. Note that, if there is a more
convenient cell to measure, you may change the Cell Number to any cell within the DCM.

29-8



Commissioning Assistant

29.4.8. Check Overall Voltage Screen

Commissioning
iy 1. Click the Dveral Voltage Measured Yalue field
v B 2 Measure the overall batiery voltage with the DMM by measuring om the most positive cell o the most
regative cell. Type the DMM reading and press Enter.
Equipment Owner 3 The Commissioning Assistant will calculate whether the measured value is within specification for accuracy —I
| Eaue and A/D counts. If found to be ot of specified mis, recaibration is achisved by clicking the ‘Cal button et to | Gertrreleten
the Measured Value fie
| send Batery Setup Nates
| Check Setiings
| gerial Numbers Parameter: Overall Voltace Status:  Enter Overall Voltage
7 [ — Parameter | Messuredvaive | Montorvabie | A/ Counts | speciication | Stats
Overall Voltage cal[[ 55 | 51.5 |25mz |,Iz + [+1-25W) IPa:sed
I»/ Check Overall Voltage
+/| Base Data- Cell Voltage
+| Check Temperature
+/| CheckDischarge Gurrent
+"| CheckTest Current
+/| BaseData- CallR
Report
String Status: Discharge Gccurred Commurication Status: [Polling OV

Figure 146. Check Overall Voltage (Comm Asst)

Click the Check Overall Voltage button. (Not used with BDS-40.) Measure the overall
voltage, type the value in the Measured Value field, then press <Enter>. If the measured
value agrees with the calculated value in the monitor, the Status area indicates Passed. If the
measured value fails, calibrate the monitor to the measured value by clicking the Cal button.

29.4.9. Check Intertier Screen

[Commissioning

| commissioning Agent 1. Calbrate one intetter for each MPH that has one or more: assigned inferters.
2 Disconnect the intertier sense leads fiom the it
3 Connect the millvolt source output to the intertir sense leads.
Equipment Gwner 4 Connect the DMM to the millivolt source output, and adust the source for & DMM reading of 10.0n. —I
/| Eauin 5. Click the Inketisr Volts Measurement Point fied. and sefect the stiing number and cell number of the L] [Conirwe ele
intetter to be caibrated.
| send Battery setup €. Click the Itetier Vol Measured Yalue field 4‘
NOTE: For 10, the Actual Reading Cohmn displaps 90 counts #10. [ Motes
7. Type the DMM reading and press Enter
+"| CheckSettings 8 Reconnect the leads after the test
V| serial Numbers Parameter: Intertier 1 <1 - 1= Status:  Enter IT Voltage
7 | [P —— Parameter | Measured Value | Maritor Value |A/D Counts | Specification | Staus
Intertier 1 < DCM 1 - 1> | Cal ] | |2 |+,Ln 2my Iunthecked
+" | Check Overall Valtage
| Check Intertier
+/| BaseData- Gell Voltage
| CheckFloat Gurrent
/| CheckTemperature
+"| CheckDischarge Current
+/| CheckTest Current
+/| BaseData-CellR
Report
String Status: Alarm Communication Status: [Response 0K

Figure 147. Check Intertier (Comm Asst)

Click the Check Intertier button. Measure the intertier voltage, type the value in the
Measured Value field, then press <Enter>. If the measured value agrees with the calculated
value in the monitor, the Status area indicates Passed. The list dynamically changes to show
all intertiers and charger cables. You only have to verify one intertier per DCM. If the
measured value fails, calibrate the monitor to the measured value by clicking the Cal button.

299



29.4.10. Base Data -

Commissioning

Comrmissioning Agent

Eqguipment Cwner

Send Batiery Setup

Check Setlings

Serial Numbers

Cell Voltage Screen

Base Dala - Cell Voltage

[m] Continue Later
Hotes

Commissioning Assistant

Check Cell Voltage

Check Overall Voltage

Cell Voltage

Basze Data - Cell Voltage

Check T

Check Discharge Gurrent

Check Test Current

Base Data - Cell R

Report

Cell

LES 2434 Min 2107 Average 2268

By SaveVokages

String Status:

[Discharge Occurred Commurication Status: Poling System Status

Figure 148. Base Data - Cell Voltage (Comm Asst)

Click the Base Data - Cell VVoltage button. Data on this screen readily identifies wiring
problems. To save the data, click the Save Voltages button. The voltage data is saved as the
baseline float voltage readings, and the baseline voltages appear in the commissioning report.

29.4.11. Check Float Current Screen

Commissioning
Sommissioning Agent 1. Disconnect the fost cunent cable from the loat curtent ssnsor
By 2 Connect the millvolt source to the float curent cable [Positive to float curment + and negative ta float  cunent
3 Adust the milivol source to 25 0.
e —— 1 Clck the Floal Curtent Messured Valus field B Contre i |
b 5 Type the value 25.0, and press Enter. (8 Contine Later
. The Commissioning Assistant wil calculale whelher the messured valus is within speciication for accuracy
Send Batery Setup and 47D counts. I found to be out of specified lmis. reoalivation s achisved by clicking the Cal bullon nest to -
the Mescured Value field
7. Reconnect the leads
Check Saltings
Serial Numbers Parameter: Float Cunenl Status: _ Enter Float Current
T Parameter | Measuedvabe | Moriervatse | 4 Counts | Specifcaion | stas
Float Current call  oo] |2 | +2-20ma | unchecked
Check Overall Voliage
| check Intertier
| Check Float Current
Base Data - Call Vaitage
Check Temperature
Check Discharge Current
Check Test Current
Base Data- Cell R
Report
String Status: [ischarge occurred Commurication Status: [Response 0K

Figure 149. Check Float Current (Comm Asst)

Click the Check Float Current button. Type the float current value in the Measured Value
field, then press <Enter>. If the measured value agrees with the calculated value in the
monitor, the Status area indicates Passed. If the measured value fails, calibrate the monitor to

the measured value by clic

king the Cal button.
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29.4.12. Check Temperature Screen

Commissioning

Commissioning Assistant

. ith the temperature probe [Fluke or equivalent]. measure the temperature of the temperature
Commissioning Agent 1. With th be [Fluke 80T-IR I e fth
sensor connected s Temperature 1 of the MPM being calbrate
2. Click the Temperalure 1 Measured Value fisk
R G 3. Type the reading iam the temperature probe and press Enter,
V| Eauip § Ifthere are addiionsl temperature sensors connected to the MPM, use the probe to measure the 8] Contine Later
\emperature sensor connected as Temperatue 2, 3, 4. tc of the MPM being calirated
| send patery sewp 5. Click that Temperature Sensor Measured value fik
£ Type the reading hom the temperaturs probe and press Enter [ Motes
7. Continue testing for the remaining temperature sensors.
+| Check Settings
| serial Numbers Parameter: Temperature 1 Status: _ Enter Temperature
A e Paramster | Measued vaive | Moritr e | A/D ounts | Speciicaon | Staws
T 1¢1-1> | Cal 75 | 80 |11ns I&Ir1deglee IPassed
+" | Check Overall Voltage
| Base Data- Gell Valtage
| Check Temperature
/| Chetk Discharge Current
| Check Test Current
+"| BaseData-CellR
Report
String Stakus: Calibrating Communication Status: Respanse OK

Figure 150. Check Temperature (Comm Asst)

Click the Check Temperature button. Type the ambient temperature value in the
Measured Value field. If the measured value agrees with the calculated value in the monitor,
the Status area indicates Passed. If the measured value fails, calibrate the monitor to the
measured value by clicking the Cal button.

29.4.13. Check Discharge Current Screen

ning String 1

Hardware String Number(slave id;

+"'| commissioning Agent Calibrating Using a Curtent Transducer CT -
1. Discannect lhe -+/Gireen and |-/ White fork terminals fram the teminal stip on the CT. m
e —— 2 Using the CT drawing. verify supply voltages at the CT comector +15/Red, -15/Black VDT
i CAUTION: The cumert hansducer may be damaged i the supply voltage connestions are incorect (8] Conline Later
3 Connect the millvok source to the +| and the -| Grd connectar pins of the cuent bansducer hamess _
[Connect pasitive to + and negative ta - |
Post Power Check
4. Comnect the DMM to the millvolt source output —
5. Acfust the millvolt source unil the: DMM reads 100.0r.
/| send Battery Setup 6. Clck the Dischaige Curient Measured Value field
7. Tupe the DM reading, (100) and press Enter.
| Chesksetings 8 mimissioning Assistant will calculate whetl relates with the deplaved vabe |
T Discharge Current Enter Discharge Current
| Serial Numbers
Parameter | Measured Value | Monitar Value | A/D Counts | Specification | Status
| Check Cell voltage Discharge Current cal || o] |4 |42 1y | unehecked
| Check Overall Voltage
| checkinerier
Sting Cunent [amps]
| Base Data- Cell Voltage
~ | Check Temperature
Iw/ Check Discharge Gurrent
~ | CheckTest Current
| Verity CT Polarity
Base Data- Cell R

Report

String Status: [alarm

Commurication Status: Response OK

Figure 151. Check Discharge Current (Comm Asst)
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Click the Check Discharge Current button. Verify the £15VDC voltage supply is
connected to the current transducer. Type the discharge current value in the Measured Value
field. The String Current (amps) field displays the millivolt value times the shunt value as
amps. If the measured value agrees with the calculated value in the monitor, the Status area
indicates Passed. If the measured value fails, calibrate the monitor to the measured value by
clicking the Cal button.

29.4.14. Check Test Current Screen

Commissioning

1 Petfom o test curnt calbration for each MPM

Commissioning Agent 2 Connect the banana jacks of the calbration shunt assembly to the DM

3 Carinect the shunt assermbly i series with the load cable conespending b the losd step that wil be calibrated
Equinment owner 4. Inthe Caliration window, clck i Ihe Measued ¥ ahie field adjacent lo the Lad Step or Test Current fiskd (] Cortinue Later

5" Frass the apace b (o scivats the Inad step ] o Lo |
Ty thes DM saring in ks in the b snerd o el ane pross Erter

Send Battery Setup 7. After ten seconds, the test stops. Confitm the test has stapped by veiying the DMM indicates 0.0m. ) Notes

8. The Cq ssistant will calculate whether the measured value is within specification for accuracy

and /D caurts, [Ffaund to be ouk of specified limit, recalbration is achievd by clicking the Caf button nert o

Check Settings the Measuied Valse fiokd.

3. After the test, remove the: shunt and recannest the load cable leads
Serial Numbers Parameter: Test Curent Status:  Tumnload on
e ——— Parameter | Messueqvaiue | montorvae | A/ Counts | speciicaton | status |

ITest Current <DCH 15 Cal| 23 | 22 |1545 |mn 2amps IPassed
Check Overall Yaliage .
B Load step [ 1 2 Load OFF [

Base Data - Cell Voltage

Check Temperature

Check Dischatge Current

I Check Test Current
Base Data- CellR
Report
Space Bar toggles load on/off
Enter measured value after load is off
String Status: Calibrating Communication Status: Response OK

Figure 152. Check Test Current (Comm Asst)

Click the Check Test Current button. Before running this test, verify that all the voltages
across the load wires are correct. Failure to do this may result in severe damage to the load
module.

Select a load step from the Load Step spin box. Press the <Space Bar> to turn on the load,
and measure the load current. Type the value in the Measured Value field, then press
<Enter>. If the measured value agrees with the calculated value in the monitor, the Status
area indicates Passed. If the measured value fails, calibrate the monitor to the measured value
by clicking the Cal button.
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29.4.15. Check Intercell Screen (BDS Only)

Commissioning

Commissioning Assistant

V| commissioning Agent 1. Calibrate one Intercell voltagefor each DEM
2. Select a cell bo measure.
3. Disconnect the intercell sense leads from the cell in the DCM.
E R EmE 4. Cornect the milfval source output to the intercel serve eads (8] Continue Loter
5. Connect the DMM ta the milivlol source oulpu, and adist Ihe souce for & DMM reading of 3.0 m.
| PostPower Check E. Type the DMM reading in milivalt in the measured value field and press enter,
7. Riepeat for each DM 2 Hotes
| send Battery Setup
| Check Settings
T InterCell Status:  Waiting AD
| serial Nurmbers
Parameler | Messuredvahe | Moritorvae | A/ Couts | Spoctication | status
/| _oneskcel vatage DCM 1 Cel 1 | cal 0o | | [ 1% przmi | urchecked
| Check overall Voltage
| Checkintertier
| Base Data- Cell voltage
| Check Temperature
| Check Discharge Current =7 1
V| check Test Current
V| checkintercel
V| verycT Palarity
| BaseData-cellR
Report
String Status; Alarm Communication Status: ‘Reuuestmg Cell Connection

Figure 153. Check Intercell (Comm Asst)

Click the Check Intercell button. In the Cell Number box, type the cell number for the cell
you wish to measure. This is only for dual reading systems, such as the BDS-256XL.

29.4.16. Base Data - Cell Resistance Screen

[Commissioning

Commissioning Agent

Equipment Gwner

Send Battery Setup

Check Settings

Serial Numbers

1. After all the parameters are within tolerance, perform a resistance test for 2ach string on the system.

2 Click the Start button, The resistance test may take up to an hour, depending on battery configuration and
test parameter seffing

3. When the resistance test is finished, the Get button becomes active.

4. Click the Get button to upload the results of the test,

5. Verify all readings of cel resistances and inteitier values are comect for the cell o module tested

B If ary readings are excessively high or low, verify the connections to those cells o modules.

[i] Contirue Later
) Motes

Check Cell Voltage

Check Overall Yollage

Base Data- Cell Valtage

Check Ternperature

Check Discharge Current

Check Test Current

N ES KN RS KN ES RS KN RS ES RS ES

String Status:

Base Data- CellR

Report

[X12730/1299 12:00:00 &

1273011299 12.00:00 8

[C1273011 899 12:00:00 &

Cell Resistance
[C1273011899 12:00:00 &

Intertier
Resistance

[C12730/1 899 12:00:00 &
[C12730/1899 12:00:00 &

1273001899 12:00:00 &
1213011899 12:00:00 &
1213011899 12:00:00 &

120152006 02:12:08 p

[C4n2/2007 0219:53 p —

27am

250m0

225m0

Man: 31250 Min 31260

Awerage

By Send/Save Thi/Base ‘

Discharge Occurred Communication Status: [Responss OK

Figure 154. Base Data - Cell Resistance (Comm Asst)

Click the Base Data Cell R button. If necessary, click the Start button to perform a
resistance test. Then, check a box in the left column to select a test that will be used to
establish alarm levels and be stored as baseline data. Click the Send/Save/Thr/Base button.
On the next screen, accept the defaults or make changes if required, then click OK.
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== Save base line and send thresholds

Cell Resistatice T hreshal
|_(" Glabal % |ndividual

~[a/

Commissioning Assistant

Bagzed on a 12 %ol cell mode individual thresholds has been selected. Thresholds wil
be set to a default of 25 % over the base line.

{+ Percertage Shove

I 25
I 25
Manitar Average -

{* Percentage Ahove
" Absolute Abave

Apply |

" Absolute Above

Intertier 1
rlrter-Cell Resistance—————————— :n:er:!er g 50
= 55 ntertier 0
{* Percentage Ahove I ind] 0
" Absolute Above I 25 Intertier 5 0
Intertier B i}
Intertier 7 i}

oK Cancel I

Cell Resistance—————— | " Intertier Resistance———————————

=
=

Figure 155. Save Base Line and Send Thresholds Data — Cell/Intertier/Inter-Cell Resistance (Comm

Asst)

Based on a 12 volt cell mode, individual threshholds have been selected.
Note: Thresholds will be set to a default of 25 percent over the base line.
When making changes to the Intertiers, click Apply to save the updated values.

29.4.17. Report Screen

Commissioning String 1 1X40X12¥ _Hardware String Number(slave id) = 1

<

Comrmissioning Agent

Equipment Owner

Post Power Check

Send Battery Setup

Check Settings

Serial Mumbers

K 1o ]

Save repart - Saves report fles ta commissiorning folder
Emal 1eport - Saves repart files to commissioning folder and emails them as sttachements to

“startup@alber.com’ using outlock.

NOTE: Click ok/yes to any wamning generated by Outiock.

Save report

(=3 Ewail ieport

Feport Location

C:hProgram FilesalberyMPM ManagerCommissioning

[] Coninue Later
Netes

Check Cell Voltage

Check Overall Yoltage

Check Intertier

Base Data - Cell Voltage

Check Float Current

Check Discharge Current

Check Test Current

Check Intercell

Werity CT Paolarity

N LN EN ENENEN ENENENENENESENENES

Base Data- Cell R

Report

String Status : Mot Commissioned

Customer : Alber

Location : Fompana Beach, FL

Commissioning Report

Report Versio 00

F103 N. Andraws Awve. Extension

il
33064

Battery : BDS Test System 1
Sting : Sting 1 1X40X12Y

Equipment Dwner

Company Name :
Site Contact(s) :

Address -
Phone Humber

Email Address -

Commissioning Agent

String Status: Alarm

Communication Status: [Response 0K

Figure 156. Report (Comm Asst)
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Click the Report button. Text on the screen displays the path and folder where the report is
saved. To view pages in the report, click the left or right arrows. To save the report as a CMS
file in the Commissioning folder, click Save Report. To save and email the report to Alber,
click the Email Report button. The CMS file is password protected and cannot be opened.

29.4.18. Preventive Maintenance Report Form

Preventive Maintenance BDS-40 1X40X12V  Hardware String Humber{slave id) = 1

| PuMAgent
4 pl
v ST e Save report - Saves repart files to PM folder [ Cortinue Later |
E-tail repart - S aves repart files ta PM falder and E-Mailz them as attachements using outlook.
v 4 PM Check List MOTE: Click ok/ves to any warning generated by Outlook.
hiates |
/| Cneck Settings Pht E-bail destination
Save report I =3 E-Mail report | IPMEmaiIAddress
Send Battery Setup X i
Fieport Location : C:\Program Files [x86]%AlbersMPM Manager P
| senalNumbers
\/ Check Cell Voltage
Preventive Maintenance Report
| Gheckintertier e sl . e ) L Report Version 2.00
) 2| x|p2. 10
7| 10 oo voraae N~ HE
L
| Ccheck Temperature Report Name
IAIber Pompano Beach FL String 1]
V| checkFioat current
\/ Check Discharge Current ok | Cancel
| CheckTestCurent 1
E
| PyData-celR S
Site Contact(s) :
Report Address :
Phone Number -
Email Address :
PM t |
String Status: Alarm ‘Communication Status: |Poi'|g System Status

Figure 157. Report (Preventive Maintenance) Form

The Preventive Maintenance Report saves customer data by default in the following fields:
e Equipment Owner name
e SitelD
Ref PO # Ticket
e Equipment Tag
The field names can be modified on the form. The modified field names from the form will
show the new names in the report name.
Once the new field names are entered, click Save Report.
Click OK to save the new preventive maintenance report.
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29.5. Emailing a Report

The completed Commissioning Agent report must be sent to Alber as an email attachment for
warranty and customer service purposes. To send the report, open your email editor and
attach the report CMS file to the email. The CMS file resides in the Program Files\
Alber\MPM Manager\Commissioning folder. In the subject line, type "BMDM
commissioning report™ or similar text. In the email, note your company name and contact
information. Send the email with the CMS file to startup@vertivco.com.

29.6. Retrieving a Commissioning Report

View|Reports|Commissioning Report

To view a report, connect to the string then click View|Reports|Commissioning Report on the
Main Menu. Do not edit completed report screens unless the string is being commissioned
again.

29.7. Printing a Commissioning Report

The completed CMS report file cannot be printed. However, there are two printing options.

A PDF file stored in the same Commissioning folder as the CMS file can be printed as a one
page document. This summary report is immediately accessible upon partial or full
commissioning of a string. The file name starts with CAR and ends with PDF. The printed
page can serve as confirmation that the string was commissioned.

After Alber receives a complete CMS commissioning file, Alber generates a PDF file of the

report and emails it back to the originator. This PDF file, which may be printed, is a
multipage document that details the commissioning of the system.
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30. Error Codes

The following error messages may appear when running the BMDM program.

Error Codes

CODE MESSAGE SITUATION
1 The database cannot be saved. Hard drive could be When copying a database to
full. a working database
2 Empty database not found. When backing up a database
5 Database Not Found. <Database File Name> When opening a database
6 Data import error (DDetail Table). Please try again. When importing discharge
data
7 Data import error (DSummary Table). Please try When importing discharge
again. data
100 The name chosen has already been used. It must be The user set up two locations
unique. using the same name or ID
101 There are more than 1000 strings. In the local computer, there
are more than 16 locations
set up.
102 Location name, battery name and string name do not In direct connection,
match. compare location ID in
Actual location name is <LocationName>. Actual monitor and in database
battery name is <BatteryName>.
Actual string name is <StringName>
103 SERVICE cannot be deleted. The user tries to delete
Service location
104 Invalid name. Input invalid location name
in location setup
105 String not found in <Database table name>. Search location
106 String 1D not found in <Database table name>. Search location
107 The telephone number of string <StringName> is not
set.
108 The pager number of string <StringName>is not set.
109 Number of strings or configuration is not set properly.
110 You have to setup customer info before setup location
info.
111 You have to setup location info before setup battery
info.
112 You have to setup battery info before setup string
info.
113 Location name, battery name and string name do not
exist. Location name is <LocationName>. Battery
name is <BatteryName>. String name is
<StringName>.
114 Invalid input.
115 The number of data set is <SetNum>. More than one
data set must exist before a trending analysis can be
performed.
116 Invalid IP address.
117 Invalid netmask address.
118 Invalid gateway address.
200 No response on Polling/Answer Port Modem. When initializing modem
201 No response on Answer Port Modem. When initializing modem
202 The currently selected COM Port, COM When initializing COM port
<ComPortNum>, does not exist. Press OK and choose
a different port.
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Error Codes

CODE MESSAGE SITUATION

203 The currently selected COM Port, COM When initializing COM port
<ComPortNum>, is already in use by another
program. Press OK and choose a different port.

204 The currently selected Com Port, Com When initializing COM port
<ComPortNum>, is not available. Press OK and
choose a different port.

205 No response from Modem/Cable Multiplexer. When connecting

modem/cable multiplexer

206 Comm Error: No response for sending "Stop Scan"
command 3 times.

207 Comm Error: No response for sending "Start Scan™
command 3 times.

208 Comm Error: No response for sending "Load Off"
command 3 times.

209 Comm Error: No response for sending "Send DCM #"
command 3 times.

300 Upgrade failed: No response for sending code 3 times. | When sending frames

301 Upgrade failed: Not responding. Check firmware location

(PROM or flush memory) in
the beginning of firmware
upgrade

302 Upgrade failed: Code confirm failed.

400 Resistance test failed: 60 minute time-out. Manual R-test is not

completed in 60 minutes

401 Data format error. The data may be saved for a When reading resistance or
different MPM configuration. historical data

402 The raw count equals 0. Please check hardware. During calibration

403 Data import error (Encode date/time). Please try When importing alarm data
again.

404 Wrong overall voltage data. Got invalid overall voltage in

discharge data

405 Subset <SubsetNum> does not have an initial value. When viewing discharge

curves, found invalid subset

406 Subset <SubsetNum> does not have a final value. When viewing discharge

curves, found invalid subset

407 Discharge data cannot be shown due to invalid
Date/Time.

500 Subset 3 is selected, but Subset 2 is not selected. If Wrong selection in Curve
you want to show two curves, the second curve Option of Discharge View
should be in Subset 2. screen

501 Two password entries are not identical. Please enter
again.

502 Password must have five characters.

1000 The string name exists. It must be unique.

1001 The battery name exists. It must be unique.

1002 The location name exists. It must be unique.

1003 The customer name exists. It must be unigue.
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